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Preface

What is ACTIVE-CAD?
ACTIVE-CAD is an advanced design framework for Windows 95, Win-
dows NT and the older Windows 3.1. Being a complete design solution,
ACTIVE-CAD provides for front-to-end design solution:

r Design Entry tools
1. Schematic editor

2. State (machine) editor

3. HDL editor

4. Symbol editor

r Design Verification tools
1. Gate and system-level functional simulators

2. Gate and system-level timing simulators

3. Fault simulator

4. Timing analyzer

5. State machine graphical animator (*)

6. Behavioral 1076-IEEE VHDL simulator(*)

7. Virtual HardwareTM

r Logic Synthesis
1. ABEL input files - CPLD ad FPGA output files

2. VHDL input files - ASIC, CPLD and FPGA output files

r Framework Support tools
1. Design Manager

2. Project Manager

3. Library Manager

(*) these tools are currently under development



How ACTIVE-CAD differs from other tools?
ACTIVE-CAD is based on a patented incremental design technology
which allows real time animation of designs. Its key features are:

r Real-time response to design changes; software simulates and animates
the latest design changes without any compilation

r ACTIVE-CAD instantly simulates and animates design responses to
new stimulus signals

r Schematics, state machines and HDL designs can directly interact with
each other and with real hardware on an event-by-event basis

r Design paths and design sections can be instantly simulated or ani-
mated under selected set of signal conditions

r Any design section or signal path can be activated or deactivated from
simulation with a click of a button to speed the design analysis process.

r ACTIVE-CAD shows how how the current design changes have af-
fected the past design behavior (reworks past simulation cycles)

r All tools have been developed by the same engineering company
and they have consistent user interface. Reliable tool integration is a
natural byproduct of the corporate-wide engineering effort.

What is ACTIVE-Schematic?
ACTIVE-CAD’s schematic editor is called ACTIVE-Schematic. I t is a
real-time interactive design tool that is comprised of a schematic editor
and a background simulator. Any device you draw instantly behaves
like the real part, down to the last detail.

1
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Background Simulator

Active Schematic
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Figure 1. SUSIE Real-time Operation.
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ACTIVE-CAD is based on the patented incremental design compilation
technology that was first employed in Standard Universal Simulator for Im-
proved Engineering (SUSIE). Because of the tradition, ALDEC still sup-
ports SUSIE-CAD product line which is a lower cost version of
ACTIVE-CAD. Both products are identical except for the number of
simulation cycles, selective simulation, test vector editor, and breakpoint
editor. This manual can be used for learning both SUSIE-CAD and AC-
TIVE-CAD products.

r The schematic editor allows entry of ideas and designs. It has many
powerful features that simplify the design process and gives instant
access to other projects, files and tools that make your work easier and
more effective.

r Finite state machine (FSM) editor allows to enter designs in a graphical
form. The machine states and transitions may be described by ABEL
and VHDL statements. The software automatically generates ABEL
and VHDL code from the FSM graphs.

r HDL editor has provisions for entering designs in ABEL and VHDL
design languages. The VHDL design source code is checked by a 1076
IEEE compatible VHDL compiler. The code generated by the FSM
editor is automatically displayed in the HDL editor.

r The simulator screen allows creating test vectors, settings an optimal
design analysis environment and effectively managing your design
resources. Based on an incremental compiler, the simulator allows
real-time editing of devices and test vectors while simulation is in
progress.

r ACTIVE-CAD comes with Design Manager which automatically
finds other EDA tools and dynamically creates a design flowchart
with buttons that activate each application. Thus data transfer be-
tween all EDA applications is simple and easy.

ACTIVE-CAD is a true Windows application and forms a very powerful
EDA framework. You can open and concurrently operate on multiple de-
sign views such as schematic sheets, IC models, waveform windows, etc.

ACTIVE-CAD Features

High Resolution Design Verification

ACTIVE-CAD analyzes each design with a 10 picosecond resolution and
automatically reports all timing violations that occur on and off screen.
Powerful error reporting facilities help locating all design problems
quickly and effectively.
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Real-Time Interactive Design Troubleshooting

Since ACTIVE-CAD is a real-time design development system, you can
correct most design problems while simulation is in progress. For exam-
ple, the Milestone feature allows performing “what-if” analysis by chang-
ing the design and test vectors and instantly comparing the new and the
old design behavior.

Works Directly With Your Existing CAE Tools

ACTIVE-CAD directly interfaces with your existing CAE tools and ac-
cepts such output files as netlists, JEDEC fuse maps, hex files, ABEL and
VHDL designs, etc.. It imports these files into its own internal design
data tables. ACTIVE-CAD also outputs netlist for all popular p.c.b. lay-
out software and accepts their back annotation files. Special effort has
been made to assure that all these CAE tools and files work directly with
ACTIVE-CAD without any extra effort on your part.

Device Level Design Tools

ACTIVE-CAD is very popular with PLD, CPLD and FPGA designers, be-
cause it offers a complete design entry and verification at a very low cost.
The device level products are called ACTIVE-(IC VENDOR), e.g. AC-
TIVE-XLX (for XILINX), ACTIVE-LAT (for LATTICE), etc. These tools in-
clude in addition a complete set of simulation libraries for specific device
design and a proprietary Design Manager that automatically locates all
software tools for the specific IC device and displays them as design flow
buttons. Activating these buttons automatically transfers design data be-
tween applications and simplifies the interfaces to different design tools.

ACTIVE-CAD is for Board Level Designs

ACTIVE-CAD is particularly useful when troubleshooting designs with
multiple PLDs, PALs, FPGAs and other forms of ASIC technology. Such
designs can be analyzed both at the chip and system level. System level
designs, such as communication and industrial controllers with multiple
processors, memories, etc., can also be analyzed with ACTIVE-CAD.

Extensive System Level Libraries

ACTIVE-CAD is supported by extensive IC libraries for board-level de-
sign simulation. The TTL library comes with the system level ACTIVE-
CAD package. Additional libraries such as CMOS, ECL, PLDs, memories
and microprocessors can be purchased separately, as needed.

Supports All Popular Logic Synthesis Tools

ACTIVE-CAD has direct interfaces to Mentor Graphics (Exemplar), IST,
and other logic synthesis tools. They are tightly integrated with ACTIVE-
CAD for ease of use and error free operation. ALDEC provides turn-key
FPGA design tools which include some of these logic synthesis tools.
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Chapter 2

ACTIVE-CAD Schematic Editor

Introduction
The ACTIVE-CAD schematic editor is a PC-based design entry tool. It
has many features not found in other similar products.

r As a true Windows application, ACTIVE-CAD has user interface that
is very intuitive to anyone who has used any Windows application. The
learning curve is short because of easy-to-use menus and toolbars,
context sensitive help, and drag-and-drop operations.

r ACTIVE-CAD provides hierarchical design support for mixed
Boolean, VHDL, and schematic designs.

r Both analog and digital schematic entry are allowed.
r ACTIVE-CAD allows PLD, CPLD, FPGA, MPU, DSP and PCB designs.
r Automatically connects device pins, which speeds schematic entry.
r An on-line simulator allows design testing on the schematic screen.
r Generates schematics directly from netlist files.
r Combines design blocks from different CAE tools on the same sheet. .
r EDIF support opens access to many UNIX EDA tools such as Men-

tor, Cadence and ViewDraw.

Schematic Fundamentals

Circuit definition

A schematic editor is typically used to create an electrical schematic
drawing, which depicts the used components and their connections. The
schematic drawing can be used in the hard copy form as documentation
on how to assemble the circuit.



The schematic design can also be converted into electronic forms for use
with other CAE tools such as PCB or FPGA layout programs or logic
simulators. The file that contains information about parts and connec-
tions in the design is called the netlist. This file does not contain any
graphical information about the design, but it is sufficient to create a
physical board or an FPGA design. There are several netlist formats used
by different tools. The ACTIVE-CAD schematic editor supports over 15
of the most popular ones.

Symbols and Libraries

The components used in the circuit design need to have graphical sym-
bol representation. The ACTIVE-CAD schematic editor comes with a set
of graphical symbol libraries with over 6,000 elements. In addition
ACTIVE-CAD has a Symbol Editor program for creating new symbols
and modifying the existing ones.

A schematic symbol consists of the symbol body and pins. The symbol
body is a graphical drawing that may be used to describe the logical func-
tion of the component. The pin is a graphical line that represents the de-
vice connection point, used to connect to other devices. The pin can be
used for a single connection or for an array of wires (bus pin).

Physical and logical connections

There are two (2) ways you connect devices on a schematic:

r A physical connection is a graphical line (called wire) drawn on the
schematic between two or more pins.

r A logical connection is a connection made between two or more
pins without drawing the connecting wire line. This type of connec-
tion is typically made by assigning identical names to two or more
wires connected to device pins. Another example of logical connec-
tions is a bus line.

Support for large designs

The designs that do not fit on one schematic page can be easily managed
by using multiple schematic pages or as a hierarchical design structure.
The multi-page schematic is no different from a single page, except you
cannot make physical connections between pins on two different sheets.
Instead, you must use the logical connections such as net names or bus
names.

NOTE: To connect circuits placed on multi-sheet designs, you must use
the logical connections. You cannot use direct wiring or I/O terminals.
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Hierarchical designs are based on dividing a design into smaller sections
(macros). These sections are single-page schematics converted by the
schematic editor into schematic symbols and saved in the project library.
These macro symbols can then be used in other schematics and con-
nected to other symbols.

The same schematic macro symbol can be used several times. The higher
level schematic takes less space and is usually more clear to the user, be-
cause it uses higher level blocks to build complex designs. The connec-
tions between the hierarchical blocks can only be made through the I/O
pins; i.e. in order to connect two symbols on different hierarchical levels,
you have to create I/O pins in the hierarchical symbol and then connect
these pins on the higher level schematic.

NOTE: Hierarchical macros (schematic sheets) can be connected at the
higher hierarchical level only through their I/O terminals. The logical con-
nections through net names are not permitted in hierarchical designs.

The schematic editor can generate designs of virtually any size, limited
only by the available memory and disk space in your system.

ACTIVE-CAD handles sheet sizes A, B, C, D and E (metric sizes A4-A0).
Custom and unlimited page sizes are also allowed.

Design verification

One of the major problems with most schematic editors is the number of
steps to verify even the simplest design. The verification process consists
of running a netlist generation program, checking that all connections
made on the schematic are electrically correct, and then testing the circuit
behavior with the help of the logic simulator. If any mistakes are found,
the schematic must be corrected and the entire process must be repeated.

The ACTIVE-CAD schematic editor resolves this problem by integrating
it with an on-line logic simulator. Since all schematic entries are dynami-
cally passed to the simulator, they are automatically verified as they are
placed on the schematic.

The the simulation data is also available in the schematic editor. You can
select test points on the schematic, run simulation and watch how the de-
vice pins are changing their logical states. Any change to the schematic
design instantly produces new logical signals in the simulator and on
schematic sheet.
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Reports

The schematic editor can create several types of design reports:

r Bill of Materials reports which parts are used in the design. It is
very useful for prototyping and manufacturing because it helps in or-
dering parts and calculating costs. The Bill of Material helps to esti-
mate the FPGA design size and if it will fit into a specific device.

r Report files can be converted into files compatible with spreadsheet
and database applications. For example, you can use the Report in
conjunction with Excel spreadsheet or Access database. This allows
the use of company standard software tools to produce customized
reports, with additional manufacturing information and comments.

Interfaces

Schematic Editor provides flawless interfaces to many design tools:

r FPGA interfaces include: design entry with a specific macro library,
layout control by means of layout parameters assigned to symbols
and nets, import and export of FPGA netlists, control of custom mac-
ros developed in VHDL or state machine languages, schematic gen-
eration for HDL macros, automatic update of schematics when their
HDL sources change, and back annotation of layout data to the sche-
matic (e.g. post-layout pin assignment).

r PCB interfaces include: symbol libraries for variety of active and pas-
sive components, PCB footprint control on the schematic, control of
power connections, layout parameters like placement groups and net
widths, PCB netlist generation, back annotation of changes made in
PCB programs through ECO (Engineering Change Order) files, and
forward annotation of changes made on the schematic after the PCB
layout has been created.

r Analog designs support includes: a SPICE library of analog symbols
and models, analog design rules checker that verifies if the design
can be simulated, SPICE netlist output, selection of test points and
means for design modification and viewing its operation.

Starting the Schematic Editor
The Schematic Editor can be invoked by clicking on the Schematic Edi-
tor button in the project flow section of the Project Manager or by select-
ing Schematic Editor option from the Applications menu. If the
Schematic Editor is started directly from the File Manager or Windows
95 Explorer, the last project will be automatically loaded. If you start the
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Project Manager first, then you will be able to select either an existing
project or start a new one.

How To Quickly Start A New Project
The fastest way to start a new schematic is by following these rules:

1. Start the Project Manager by double clicking on the ACTIVE-CAD

icon in the ACTIVE-CAD group of icons.

2. When the Project Manager window appears, click on the New Project

icon to invoke the New Project window.

3. Enter the project name, its directory and type into the New Project win-
dow. Some design types will additionally allow to select device fam-
ily, part number and device speed.

4. Select the libraries by clicking on the Project Libraries icon .

5. When the ACTIVE-CAD Libraries window appears, select the librar-
ies to be used in the project. Select from the Attached Libraries field
the necessary libraries and click the Add>> button to copy them to
the right-hand side field. For description of the system libraries see
the Appendix A - ACTIVE-CAD Libraries. To save on memory space
and to improve the device search time, select only the necessary li-
braries. You can add more libraries to the current project at any time.

6. Close the ACTIVE-CAD Libraries window.

6. Start the schematic editor by clicking on the Schematic Editor button
in the Project Manager window.

7. The schematic editor window will open a new schematic sheet (.sch).
Its name will be the same as the current project’s name. However,
the number ‘1’ will be appended to the project’s name. For example,
project TEST will open a new schematic sheet called TEST1.sch.

Before starting schematic entry, read the following section:.

Basic Design Entry Operations
After setting up a new project, perform the following tasks:

r Set up the schematic page size, orientation and border type with the
Page Setup option in the schematic File menu.

r Set the drawing table by clicking on the File|Table Setup option.

Starting the Schematic Editor 2-5



r Select the Symbol Entry mode by clicking on the icon in the
schematic vertical toolbar or pressing the F2 keyboard key. Start enter-
ing devices by dragging them from the SC Symbols toolbox.

r Select the Draw wires mode by clicking on the icon and draw
connections

r To make any changes to schematic design, click on the Select and Drag

icon.
r Since ACTIVE-CAD operation is based on an incremental compiler,

you can simulate devices as you place them on the schematic sheet. To

activate the on-line simulator, click on the Simulator icon.

r Activate the Select Test Points icon and click on the desired test
points on the schematic sheet. The selected test points are instantly
displayed in the simulator and schematic windows.

r Use the simulator test vector editors to generate test vectors.
r Apply the test vectors to the desired schematic test points and click

on the Single Step or Long Step simulation buttons in the Simulator
toolbox.

What happens when you start the schematic editor
When you start the schematic editor, the following operations are per-
formed automatically:

r The list of symbols is loaded into the memory. The list contains all the
symbols from all libraries that have been selected for the project. The
list contains only symbol names and not the actual symbols.

r The project contents file (*.PRJ) is opened to load the list of schematic
sheets that belong to the current project.

r The previously used schematics will be open. They will look exactly
as they were displayed on the screen, including window positions,
zoom, and other settings that were saved during the last session.

NOTE: If you do not want to load the last project, select another one in
the Project Manager before starting the schematic editor.

Screen Layout
Figure 2-1 shows the main Schematic window. Its arrangement has been
designed to simplify design entry. Note that multiple schematic win-
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dows can be opened within the main editor window to allow for simulta-
neous editing of multiple schematic sheets.

Standard Windows Top Bar
The standard Windows top bar includes the Maximize button (3) for ex-
panding the schematic window, the Minimize button (4) for reducing
the schematic to an icon, Title bar (1) and System button (2). Their func-
tions and behavior are the same as in all other Windows applications.

The equivalent Windows 95 buttons are described in the Appendix Win-
dows 95 User Interface Summary.

ACTIVE-CAD Proprietary Toolbars
The ACTIVE-CAD operations are controlled by activating icons or but-
tons in vertical and horizontal toolbars. The horizontal toolbar is com-
prised of five (5) groups of icons. Since each of these groups handles
different set of operations, they will be described separately.

2 1 34

Figure 2-1. Schematic Editor Main Window.
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Schematic Sheet Management Icons
The icons in Figure 2-2 are used for project management.

- New Schematic icon allows to start a new schematic sheet.

- Open a Schematic icon allows to open one of the existing sche-
matic sheets.

- Save icon allows saving current schematic designs. The icon is ac-
tive only when some changes have been made to the schematic sheet
since it was last saved. Otherwise, it will remain gray or inactive.

- Projects icon displays the Project Manager screen. Refer to Design
Process Management chapter for details.

- Print a Schematic icon allows typical Windows print operation.

Cut And Paste Operations

The cut, copy and paste operations require setting ACTIVE-CAD into the

Select mode by clicking on the Select and Drag icon. The icons in
Figure 2-3 allow for typical cut and paste operations.

Cut icon allows to cut a selected schematic section into the Clip-

board. First, activate the Select mode by clicking on the Select icon.
Next, drag a rectangle around the selected items, or select them by hold-
ing down the Shift key and clicking on each item. Clicking on the Cut
icon will remove the selected items from the schematic sheet and place

Figure 2-2. Project Management Icons.

Figure 2-3. Cut And Paste Icons.
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them in the Clipboard. All wires remaining entirely within the cut area,
will also be copied into the Clipboard.

Copy icon allows to copy sections of the schematic to the Clipboard.
Choose the items to be copied, and then click on the Copy icon.

Paste icon places the contents of the Clipboard at the selected screen
location. First activation of the Paste icon displays a dotted outline of the
Clipboard contents. The second click on the Paste icon places the con-
tents of the Clipboard at the selected location.

Zoom Operations

The group of icons in Figure 2-4 allows quick zoom operations.

Zoom buttons

There are two Zoom buttons. The button marked with plus (+) rep-
resents the Zoom In option, the one marked with minus (-) represents
the Zoom Out option. The Zoom In and Zoom Out options allow quick
selection of the next larger or smaller predefined viewing scale.

Zoom Area icon allows selection of the schematic area to be dis-
played over the entire screen. The first click on the Zoom Area icon acti-
vates the zooming cursor. Place that cursor at the first corner of the area
to be enlarged. Press the mouse button and drag it to the opposite corner
of the selected area. Upon release of the mouse button, the selected area
will expand to cover the full computer screen.

Full Page Zoom icon displays the entire schematic sheet.

Editing Operations
The editing operations are controlled by the icons in Figure 2-5.

Figure 2-4. Zoom Operations.
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Undo icon eliminates the last schematic change and restores the
schematic to its state prior to that change.

Properties icon allows to assign parameters to wires and symbols.
Activating the Select schematic mode and clicking on a wire or symbol,
followed by clicking on the Properties icon, will display the Net Attrib-
utes or Edit Symbol window, and will allow editing the wire or symbol
parameters, respectively. For more details read sections Wire Parameters
and Symbol Parameters.

Connect Symbol icon connects the symbol pins with the overlap-
ping end-wire symbols (crossed circles or crossed squares). This opera-
tion is used to replace parts and reconnect wiring.

Disconnect Symbol icon disconnects all wires from the selected
symbol and places wire-end symbols (crossed circles or crossed squares).

End icon is used to end wires and buses at the current screen loca-
tion. The wires will be marked with wire-end symbols.

Cancel icon is used to cancel the wire and bus being drawn.

Design Verification
The design verification is comprised of connectivity checking and simula-
tion. The icons in Figure 2-6 allow for simulation control and schematic
connectivity query.

Figure 2-5. Editing Options Icons.

Figure 2-6. Schematic Design
Verification Icons.
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Simulation toolbox icon activates a toolbox with icons for placing
test points on schematic, replacement of functionally equivalent parts,
and execution of simulation steps. The selected test points can be used to
apply stimulus signals (test vectors) or to monitor the design behavior.

Simulator icon generates schematic netlist and activates simulator.
If the simulator was already active, it will pass control to the simulator.

Query Window icon lists connectivity for the selected items.

Schematic Entry Operations
The design entry operations are controlled by the icons in Figure 2-7.
They are located vertically on the left-hand side of the screen. However,
they can be dragged to other screen locations.

Symbols toolbox icon activates a toolbox with device symbols. The
toolbox also includes icons for selecting desired types of symbols and al-
lows searching for the selected parts or types of parts.

Draw wires icon activates the wire drawing mode. Clicking on a pin
starts a wire. Clicking on another pin automatically draws a wire. Dou-
ble clicking on an empty space starts a wire with wire-end symbol.

Draw buses icon allows drawing buses by clicking at any screen lo-
cation. To end a bus, click the right mouse button or activate the OK
icon.

Figure 2-7. Schematic Entry Options Icons.
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Draw Bus Taps icon activates drawing connections between buses
and pins - bus taps. Clicking on a bus and then clicking on symbol pins,
will automatically connect these pins with buses and sequentially
number the bus taps.

Add Net or Bus name icon is used for naming nets and buses. Click-
ing on a net or bus in the Select mode will turn the selected item red. Ac-
tivating the Add Net or Bus Name icon will display a window for
naming the selected item.

I/O Terminal icon allows naming I/O terminals and specifying
their direction. This icon is active only when the Draw Wires icon is also
activated.

Power Symbol icon allows for direct placement of power symbols
on the schematic sheet. This icon is active only when the Draw Wires
icon is also activated.

Graphics toolbox icon allows drawing graphical elements. All items
drawn in this mode will have no electrical properties. This mode should
only be used for non-electrical drawings or for adding additional infor-
mation that does not need to be saved in the electrical database.

General Operations

The Select and Drag icon is the most often used operation. It allows
selecting objects in the schematic for further processing. The Select op-
tion is set by default by several schematic editor operations.

Hierarchy Push/Pop icon activates the hierarchical H cursor. Click-
ing with this cursor over a macro will display its internal schematic.
Clicking on a primitive cell will display an advisory message that no
schematic for the selected part is available. Clicking in an empty space,
will display the higher hierarchical level.

Figure 2-8. General Operations
Icons.
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The Select and Hierarchy Push/Pop icons do not produce any design
changes. They only facilitate other operations on the schematics.

Menu
The menu bar includes the main schematic editor options. Each of these
options is described in detail in the Schematic Menu Reference chapter.

Coordinates
The status line in the bottom left-hand corner displays the cursor coordi-
nates as it moves over the schematic. The coordinate values are dis-
played in inches, millimeters or zone references. To select one of these
ruler types, use the Page Setup option in the File menu.

Ruler
The ruler display is controlled by the View|Ruler option. The ruler is
displayed on the left (vertical ruler) and top (horizontal ruler) of each
schematic window.

The ruler can be marked in inches (English), millimeters (Metric) or
Drawing Zones. The ruler type is selected from the Page Setup option in
the File menu.

Scroll bar
The scroll bars are located on the right and at the bottom of each sche-
matic window. The operation of the scroll bars is identical to all Win-
dows applications, and allows for smooth scrolling of the schematic in
vertical and horizontal directions.

Schematic Page Setup
A schematic can be comprised of multiple sheets or pages, which can be
created with the New Sheet command in the File menu. You can draw a
schematic on a new sheet immediately after it has been created. The new
schematic sheet will have the default size and frame, and the same name
as the current project.

You can change the default page settings by using the Page Setup option
(Figure 2-9) in the File menu. Using the Frame, Sheet Format and Ruler
fields in Figure 2-9, you can specify:
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r Frame on/off and the number of page zones
r Sheet size (A-E, A0-A4, any desired size)
r Sheet orientation (Portrait or Landscape)
r Ruler setting (None, Metric, English, References-Zones)
r Y-axis origin

ACTIVE-CAD allows to customize the design table that is displayed and
printed in the bottom-right corner of the schematic sheet. To customize
this table, use the Table Setup option in the File menu.

The Table Setup window (Figure 2-10)allows selecting the desired logo
graphics file (metafile) to be displayed in the design table.

NOTE: The logo file has to be in the Windows Metafile format without
the header . A Windows Metafile can be created with programs like
CorelDraw.

Figure 2-9. Page Setup Options.
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Table Setup

Saving The Page Layout
The settings selected with the Table Setup option are saved in the pro-
ject description file (*.PDF). These settings are in effect for all project
sheets. However the sheet or page numbering is automatically control-
led. All, settings in the Page Setup window (Figure 2-9) are saved in
each schematic file (*.SCH), and can be different for each schematic sheet.

Building a Schematic
Each schematic consists of the following items:

r Page Frame and Table
r Symbols/Components
r Connections (wires or buses)
r Terminals and net names
r Graphics and Text

The page Frame settings are controlled using the Page Setup option (Fig-
ure 2-9), in the File menu.

Figure 2-10. Table Setup window.
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Each symbol item consists of a graphical symbol, component name, com-
ponent type and attributes. For example, the NAND gate item in Figure -
2-1 consists of the graphical NAND symbol, the name U1A, the type
(part number) 7400, and specific graphical attributes like rotation and
mirror, which will be explained in detail later on.

Wire connections can be drawn:

r from pin to pin
r from pin to I/O terminal
r from pin to an existing wire connection
r from an existing wire connection to a pin

You can end a wire at any schematic location by double clicking. This
will produce a dummy terminal, also called wire-end, which looks like a
circle or little square with a red cross inside.

All connections are validated while they are drawn, and the editor does
not allow starting or finishing a wire that does not represent a valid elec-
trical connection. This restriction is due to the on-line simulation capabil-
ity of the ACTIVE-CAD system. If the ACTIVE-CAD background
simulator is active while you draw a schematic, then each schematic
change is instantly (incrementally) passed to the simulator, and the de-
sign can be analyzed for electrical behavior as it is drawn.

Inactive Schematics
If the opened schematic does not belong to the current project, you will

only be able to view it. However, you will not be able to edit it until you
add it to the project with the help of the Add Sheets To Project option in
the Hierarchy menu. The prompt message continuously warns you that
the schematic does not belong to the current project and cannot be edited.

Accessing Schematic Areas ( Zooming)
To view a specific schematic area, use the following options:

r zoom in on a selected area

r zoom on entire schematic sheet by clicking the Full Page Zoom ( )
icon

r swap current page with a full page display (PgUp, PgDn keys)
r center the selected area on the schematic display
r use auto panning to access the desired schematic areas
r scan the window
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Zooming in on a selected area

Select the Zoom Area ( ) icon in the top bar and drag it from one cor-
ner to the opposite corner over the selected area. Upon release of the
mouse button the marked area will be expanded to the full screen.

To zoom in on a selected area, click at one of the corners of the area to be
expanded and press both the Ctrl key and the left mouse button. Hold-
ing the mouse button down, drag the cursor towards the opposite corner
of the desired area. A dotted rectangle is displayed during this operation
to mark the selected area. When the desired area is within the rectangle,
release the mouse button. The selected area will expand over the entire
display.

Centering the selected area on the schematic display
Activate the F9 keyboard key or select the Center option from the Dis-
play menu. In response, ACTIVE-CAD displays a bulls eye cursor. As
you move this cursor to the display borders, auto panning (shifting) of
the display area takes place. If you click the left mouse button, the area
under the cursor will be displayed in the center of the screen.

Using autopanning to access the desired schematic areas
You can move to the desired schematic areas by dragging an element,
wire or bulls eye produced by selecting the Center option. Auto panning
is one of the most natural and most often used options to access the hid-
den schematic sheet areas.

Scanning window
You can concurrently view the same schematic area in two windows
with totally different magnifications. To open the scanner window for
global schematic viewing, click on the Scanner option in the View menu.
When the scanner window appears, slide its top bar to set the drawing
magnification ration.

Next, click on the Move Scanner option in the View menu. A dotted rec-
tangle starts following the cursor. Place it over the selected area and click
the mouse button. The selected schematic area will appear in the scanner
window.

Using the top bar button, adjust the scanner display magnification; Mov-
ing the top button to the left reduces the schematic magnification. Mov-
ing it to the right increases the scanner magnification.
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All new wires, terminals and components are instantly displayed in the
scanner window. This window looks identical to the main editing win-
dow but it does not allow for any editing or option selections. The scan-
ner is primarily used for viewing the sheet layout while the design is in
progress.

Placing Symbols
To place a new component on a schematic sheet, switch to the Symbol
mode by either pressing the F2 key or clicking on the Symbols Toolbox

icon in Figure 2-1. A symbol library window similar to Figure 2-11
is automatically displayed on the right side of the screen.

Selecting symbols

To find the desired component , click on any symbol listed in Figure 2-11
to invoke the highlighted cursor. Next, scroll the symbol list with the cur-
sor keys or the scroll bar. If you type the symbol name at the bottom of
Figure 2-11, it will be automatically searched for and highlighted in the
list.

The currently selected symbol is highlighted in color. If you move the
mouse cursor to the schematic window (do not drag!), the graphical sym-
bol of the selected component will follow the cursor.

FTIP: You can view the symbols without placing them on the schematic
by moving the cursor with the currently selected symbol over the sche-

Figure 2-11. SC Symbols Toolbox.
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matic area and then scrolling through the list of symbols with the ar-
row keyboard keys. The symbol for a current name on the list will ap-
pear at the cursor position.

Quick Symbol Finder

If you know the symbol name you want to place on the schematic, just
type its name in the edit line which is located right at the bottom of the
SC Symbols window (Figure 2-11 ). As you type the symbol name, the
list is scrolled and Highlite Cursor points to the first matching symbol.

Placing a Selected Component

To place a symbol, move the symbol attached to the mouse cursor to the
desired location and click the left mouse button.

As you move the symbol toward the outside of the window, the sche-
matic will automatically scroll under control of the auto-panning soft-
ware.

FTIP: You can rotate any component attached to the cursor by pressing
Ctrl+L (left rotation), Ctrl+R (right rotation) or Ctrl+M (mirror image).

To place another symbol on the schematic, select it in the SC Symbols
window and repeat the component placement process.

Duplicating symbols

With Symbol Toolbox icon active, clicking on any symbol will pro-
duce its copy (duplicate), which will automatically follow the mouse cur-
sor. You can place the symbol duplicate at any screen location by
clicking the mouse button. This feature is available only if the schematic
is in the Symbol (placement) mode and if no other symbol is currently at-
tached to the cursor. If a symbol is attached to the cursor, click the right
mouse button to release the existing symbol, and then click on the de-
sired symbol that you want to duplicate. Each placed symbol is automat-
ically given a new reference number.

Deleting symbols

To delete the symbols you have just placed, press the Del keyboard key.
Each time you press this key, a new symbol is being deleted. The order of
deletions is the reverse of the order in which the symbols were placed in
the schematic. This delete operation is disabled once you switch out of
the Symbol Toolbox mode. Returning back to the Symbol Toolbox
mode will not reinstate the symbol delete option.
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You can delete any symbol, terminal or wire in the Select ( ) mode.
This is the most popular way of editing a schematic. To delete an ele-
ment, select it with the click of the mouse button and then press the Del
keyboard key or select the Delete option from the Edit menu.

If you have mistakenly deleted a symbol, you can put it back by clicking
on the Undo option in the Edit menu.

Symbol Overlap

All symbol outlines are rectangular. They are displayed when the sym-
bols are selected in the Select mode. At least one grid step of free space is
required between symbols. The schematic editor allows disabling of the
symbol overlap so that the symbols may be placed closer than specified
by their rectangular outlines.

To turn the symbol overlap control on/off, select the General option
from the View/Preferences menu. Next, select the Allow symbol over-
lap option in the General Settings window.

NOTE: The ACTIVE-CAD schematic editor does not allow connections
by placing two symbols next to each other so that the pins appear con-
nected. Wires need to be drawn between pins to make a connection.

Symbol Filter
ACTIVE-CAD libraries include a large number of symbols. Each symbol
has attributes that determine its class and logical function. These attrib-
utes can be used to simplify the search for the desired symbols. In order

to filter the symbols in the symbol list, press the Filter icon in the
SC Symbols toolbox. In response, the Library Filter window is dis-
played (Figure 2-12).

FTIP: If you want to find a symbol, but you don’t know its entire name,
enter the part of the name as a Filter mask, with an asterisk (*). For ex-
ample, to find all TTL 245 devices, enter a mask *245* in the Symbol
Name field of the Library Filter window.

The Library Filter window (Figure 2-12) shows available attributes and
symbol classes. Select the desired symbol classes (technologies and IC
families) and logical functions and press the OK button. A listing of com-
ponents with the selected characteristics will appear in the SC Symbols
window.
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Since all information about each device resides in its simulation model,
you need to load the model library to effectively use this option.

Selecting resistors, capacitors and inductors
To speed drawing of resistors, ca-
pacitors and inductors, use one of
the three icons serving these compo-
nents in the SC Symbols toolbox
(Figure 2-11). For example, by acti-
vating the RES icon, a special win-
dow for quick selection of the
desired resistor appears (Figure 2-
13). First, select the resistor type
from the available menu (fixed, po-
tentiometer, variable, etc.). Next, se-
lect its Value, Tolerance and
Wattage from the appropriate
fields. The selected resistor will fol-
low the cursor. Clicking at the de-
sired screen location will place the
symbol.

The capacitors and inductors are selected in a similar manner, using the
CAP and IND icons, respectively. The selected component value, toler-
ance and wattage can be viewed in the Query mode.

Figure 2-12. Library Filter Window.

Figure 2-13. Selecting
Resistors.
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The resistor, capacitor and inductor symbols are built-in to the schematic
editor and do not require selecting any library. Additional passive sym-
bols, like resistor packs, switches, etc. can be found in the PASSIVE and
DEVICE1 libraries. You need to attach these libraries to the current pro-
ject to use their components.

To draw Spice analog circuits, select to the project the Spice analog li-
brary in the Project Libraries (File menu).

Connector
To put a single connector pin on the
schematic, click the CONN icon in
the SC Symbols toolbox. Select the
connector type, reference name and
pin number from Figure 2-14. The
connector pin is placed as any other
symbol on the schematic, with the
exception that all pins of the connec-
tor with the same reference name
are exported as the same connector
symbol in the netlist.

To place a connector as one symbol
instead of multiple separate pins,
use the symbols from the DEVICE1
library.

Symbol Numbering
All symbols are automatically named when placed on the schematic. The
symbol name is composed of a text string and a numerical suffix, which
is incremented every time you place a symbol. Examples are U1, U2, U3,
etc. You can choose several symbol name options by selecting the Anno-
tate option in the Options menu. In response, the Annotation window
(Figure 2-15) appears and allows renaming parts.

Figure 2-14. Selecting
Connector Pins.
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Following is a description of the Annotation window:

r Annotate field: you can annotate parts on the current sheet, in the
entire project, or on a selected schematic sheet.

r Sheets field: checking the Hierarchy Descent box, will force compo-
nents in the hierarchical schematics to have unique names. For exam-
ple, if you have two schematic devices in your design, both of which
contain symbols called U1 and U2, ACTIVE-CAD will rename the U1
and U2 symbols in the hierarchical schematics to unique names. The
Increment field can be used to specify the increment between hierar-
chical schematics of the renamed symbol names. For example, if you
select an Increment of 100, then the U1 and U2 symbols will be renamed
U100 & U101 in one schematic and U200 & U201 in the other one.

r References field: You can specify the reference prefix, (e.g. U for U1,
U2) in the edit field. The First # setting defines the lowest reference
number, (e.g. First # = 5 will start numbering components from U5, U6,
etc.) Selecting the Selected option and the Renamee box option allows
renaming existing components. Enter the prefix of the existing compo-
nents into the prefix field (e.g. U) or select All to rename all compo-
nents. Next, enter the new prefix in the Rename field and press the
Annotate button.

r Clicking on the Annotate button will annotate schematic sheets ac-
cording to the selected settings.

ACTIVE-CAD automatically tracks the device numbering. For example, if
you add a new sheet to the current project, all devices on this sheet will
be automatically renumbered in the sequential project order.

Figure 2-15. Symbol Naming Options.
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Displaying Component Attributes
After placing a component, you can specify its attributes. Switch to the
Select mode, click on the symbol to which you need to assign parame-

ters, and then click on the Properties ( ) icon. When the Edit Symbol
window appears, click on the Attributes button. In response, the Symbol
Attributes dialog box (Figure 2-16) will appear..

The component attributes include:

r Rotation and mirror
r Enable or disable the pin names, pin numbers, and symbol name

appearance on the screen
r Auto Reference and Auto Section numbering control
r Manual section selection
r De Morgan and other symbol representations

Rotating a symbol

To rotate a single symbol counter-clock-wise (CCW), press the {Ctrl+L}
keyboard keys while the symbol is attached to the cursor. Each {Ctrl+L}
activation will rotate the symbol additional 90 degrees. To rotate symbol
in the clock-wise direction (cw), click on the (Ctrl+R) keyboard keys.
Pressing (Ctrl+M) keyboard keys will create a mirror image of the sym-
bol.

If the symbol has already been placed on the schematic, highlight it in
the Select mode and then click on the Properties icon. This will invoke
the Edit Symbol window. From the Edit Symbol window select the At-
tribute option, and when the Symbol Attributes menu appears (Figure 2-

Figure 2-16. Selecting Symbol Attributes.
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16), select the desired component rotation. To complete this operation
click on the OK, Update and Close buttons.

Drawing connections
To enter the drawing connection mode, click on the Draw wires icon

( ) or press the F3 key. The wire connectivity cursor, which displays a
pencil and a wiring node, appears automatically. Clicking with the wir-
ing cursor at pins or wire connections will start a new connection. Click-
ing on another pin or wire, will end the wire connection. The Draw
wires icon activates drawing of single wires. In addition, there are sev-
eral other modes of symbol connectivity:

Draw buses icon activates the bus drawing mode1.

Add Net or Bus Name icon allows placing a label on wires and
buses.

Draw bus taps icon allows drawing bus taps and add bus tap
names to existing wires.

I/O Terminal icon is used to place I/O terminals on schematic
sheets. They can be directly connected to wires and buses.

Power Symbol icon is used for connecting wires to power and
ground.

Undo icon is used to undo the last wiring operation.

Cancel icon is used to cancel currently drawn wires and buses.

End icon is used to complete the drawing of a bus or wire at its cur-
rent cursor location. Wires are terminated with crossed circles or squares.
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Placing Wires

The schematic editor allows drawing a wire only if it is electrically cor-
rect and represents a physical connection between component pins or
I/O terminals. To temporarily end a wire at any place on the screen, click

on the right mouse button, followed by clicking on the End ( ) icon.
This places wire-end symbol, which is a crossed red circle and allows
continuation of the wire from the selected screen location.

To start drawing a wire, click on the component pin or in its proximity.
The cursor will snap to the pin, and a wire will be drawn as you move
the mouse. To approve a corner or a wire segment, click the left mouse
button. The approved wire section will change its color. To temporarily
exit this mode, click the right mouse button. In response, the currently
drawn wire will freeze in its last position. If you click on the End icon,
the wire will terminate with the wire-end symbol, which is a blue filled
circle. If you do not click on the End icon, then clicking anywhere on the
schematic screen will automatically connect the present cursor position
to the last wire position.

Selecting the wiring mode puts the editor is in the auto-panning mode.
Every time you move the mouse cursor closer to the window border, it
will automatically scroll to allow instant access to other parts of the sche-
matic without using the scroll bars.

Adding I/O Terminals

I/O terminals represent hierarchical macro I/O pins. These are logical
connectivity symbols only, and they do not represent any physical con-
nections. Only I/O terminals on the top level schematic are automat-
ically converted into device I/O pins and will be added to the layout
netlist as connector pins.

NOTE: If you intend to place a physical connector, use the connector
symbols instead of the I/O terminal symbols.

To activate the I/O Terminal icon, select either the Draw wires ( )
icon or draw a bus line. To place an I/O terminal, click on the I/O Termi-
nal icon. In response, I/O Terminal window appears (Figure 2-17) and al-
lows entering the terminal name and its type (input, output,
bi-directional or unspecified).

Enter the terminal name into the Terminal Name field and then select
the terminal type from the Terminal Type list. Click on the OK button. A
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box follows the cursor until you click to place the terminal on the sche-
matic .

You can place a terminal on the schematic before you draw a connection
or while you draw a connection. To end a wire with an I/O terminal,
start drawing the wire and when you get to the location where the termi-
nal should be placed, click the right mouse button to disconnect the wire
from the mouse cursor, and click on the I/O terminal icon. In response,
I/O Terminal window will appear. After selecting the terminal name
and I/O type, press the OK button. The terminal will be placed at the lo-
cation where the wire was previously terminated.

You can place a sequence of similar I/O terminals using the Repeat but-
ton displayed within the I/O Terminal window. Activating the Repeat
button sets ACTIVE-CAD into the repeat mode and each mouse click
will produce a new terminal on the schematic. The terminals are num-
bered sequentially, e.g. IN1, IN2, IN3,.... To exit this mode, click the right
mouse button. For more details, please refer to the Repeat Option section.

The Repeat has two modes of operation:

r Terminal symbol; duplicates terminals with names incremented by ‘1’.
r Terminal connection: draws identical wire connections which start at

symbol pins and end with I/O Terminals. The terminal names are in-
cremented by one (1).

NOTE: The terminal name must always be the same as the net name.
You can use multiple I/O terminals in the same node (e.g. input and out-
put) but they must have the same name.

Figure 2-17. Entering I/O Terminals.
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Naming Nets
The net names are used to name the wires (nodes) on the schematic.
These names can also be used to connect multiple schematic sheets. All
nets using the same name are connected together. Initially, wires are as-
signed hidden numbers. These numbers are used internally by ACTIVE-
CAD to track wiring nets. However, for clarification and documentation,
you can assign a name to any wire on the schematic. This name can, for
example, describe the function of the signal in the design (e.g. Clock, En-
able, Reset, etc.).

Adding A Net Name

To add a net name to an existing wire use the following procedure:

1. Click on the Add Net or Bus Name ( ) icon.

2. When the Net Name window in Figure 2-18 appears, enter the desired
name and click on the OK button.

3. A red rectangle appears attached to the cursor. Move it to the location
where the net name should be placed and click the mouse button.
The net name should be placed close to the wire itself. Otherwise, it
will be displayed in a different (green) color than the net name (blue)
and will not be attached to the wire. Changing the wire color in the
Preferences menu, will change the above listed colors.

NOTE: Each node can have only one name. If you attempt to join two
nets that have different names, the schematic will display a warning. You
have to change or delete one of the net names before you can join the
two nets.

If you try to assign a new net name to a wire that has a name already as-
signed, a warning will be displayed and the operation will be aborted.
You can assign a new net name only after deleting the original net name.

Figure 2-18. Entering Net Names.
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Editing a Net Name

To change a net name, double click on the net name and when the Net
Name window appears, edit the name. If you double click on the wire in-
stead of the net name itself, the Net Attributes window will appear. To
change the net name from that window, click on the Net Name button
which will display the Net Name window (Figure 2-18).

Deleting Net Name

To delete a net name, click on the name and press the Delete button.

Moving a Net Name

To move a net name to another location, switch to the Select mode, click
on the net name and drag it to the desired location next to the wire.

Repeat Option

Because the Repeat option automatically updates the net names index,
you can quickly draw nets and terminals connected to symbol pins. This
is particularly useful when drawing buses with a large number of similar
nets. The Repeat option helps you to place multiple net names, I/O ter-
minals, and PWR symbols.

The net name and I/O terminal name consist of a name followed by an
index (e.g. DATA1 or ADDR[14]). If you do not enter an index as part of
the net name, ACTIVE-CAD will append to the name an index whose
starting value defaults to one. Each time you place the name on the sche-
matic, the index value is incremented by one.

The Repeat option for PWR symbols does not add any index to the PWR
symbol. Instead, each click of the mouse button places the same power
symbol in all schematic locations.

NOTE: To start numbering of nets and terminals from numeral ‘0’, you
must enter the full name, including the suffix 0, e.g. DATA0, ADDRESS0.

To stop the Repeat mode, click on the Cancel or END buttons, or click
the right mouse button.

Drawing Buses
The Draw buses icon activates editing of buses. Buses can start and end
at any screen location. They may also terminate at bus terminals and bus
pins. A detailed bus description of the bus editor is provided in Buses,
the 3rd chapter of this Guide.
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Drawing Taps
The Draw bus taps icon activates a mode for automatic wiring of pins to
buses (bus taps). Clicking on the selected bus starts automatic number-
ing of bus taps. Clicking on device pins automatically wires them to the
selected bus and names in sequence. For more details refer to the 3rd
chapter of this Guide.

END Icon Operations

The END ( ) icon puts dummy terminals, also called wire-end termi-
nals, on unfinished wires. To place a wire-end terminal, disconnect the
wire from the mouse cursor by clicking the right mouse button. Once the
cursor is free, move it over the END icon and click. The wire-end termi-
nal instantly appears at the last mouse cursor location. You can connect
the dumb terminals at a later date by clicking and dragging them to pins
or terminals.

Assigning PWR Points
To assign a power signal to a selected pin or wire on the schematic, acti-

vate the PWR ( ) icon. In response, ACTIVE-CAD displays a PWR
window for selecting the power signal and its graphical representation.
Make your choice and click on the OK button. A little square will follow
the cursor. Place it at the desired pin or wire and click the mouse button.
It will instantly produce a power connection. If you click on the Repeat
button instead of the OK button, then each click at a pin or wire will
connect them to a power symbol.

You can reverse the above process by drawing a wire first. Clicking the
right mouse button will disconnect the wire from the cursor. Activating
the PWR icon will display the PWR window which will allow the de-
sired power signal selection. Clicking on the OK button will place the se-
lected power symbol at the end of the wire.

Making Automatic Connections
You can automatically connect device pins without manually drawing
any wires. To activate the automatic wiring, select the View|Prefer-
ences|Wires&Buses option. When the Wire & Bus Settings window ap-
pears (Figure 2-19), select the Autorouting box. Each time you click at
the end point, ACTIVE-CAD will automatically complete the wiring.
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In the same menu, you can also limit the time that it takes for the auto-
matic routing algorithm to search for the best wiring connectivity.

Note: The autorouting is set active by default (on power on), unless you
deselect it and save on exit from the schematic.

The Wire & Bus Settings window applies to the entire project and offers
several wiring options:

r Wire Line Style; allows to choose between solid, thick, dotted, etc.
r Wire Line Width; allows to select the width of the wires. The new width

applies to all wires in the entire project (all schematic sheets).
r Junction Size; allows to select the junction size for the entire sheet.
r Junction Type; allows to choose the junction’s shape (Circle or Square)
r Orthogonal Wires; allows only horizontal and vertical lines/wires.

Disabling this feature allows drawing lines at any angle. This option
should generally be set on.

r Bus Line Width; is used for setting bus thickness
r Bus Tap Type; offers several shapes of taps
r Default Bus Range; specifies if buses are drawn from the lowest order

lines to the highest order lines, or vice versa.
r Autorouting; enables automatic routing of wires between symbols.
r Autorouting timeout; specifies the maximum time for wiring calcula-

tions (tryouts).

Disabling the auto-connecting feature

To disable the auto routing (wiring) feature select the View|Prefer-
ences|Wires & Buses option. When the Wire & Bus Settings window ap-
pears deselect the Autorouting option.

Figure 2-19. Wire And Bus Wiring Options.
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NOTE: If the autorouting feature is disabled, then the wiring needs to be
manually anchored at each corner.

Manual wire connections

You can draw wires manually even in the auto routing mode by clicking
the mouse button at each wire corner. This anchors the wire at the se-
lected point. You can manually draw some wire segments and then com-
plete the connection in the fully automatic mode by clicking at the end
point, such as pin or net.

Automatic Table-Driven Connections

ACTIVE-CAD allows automatic connections between symbol pins se-
lected from a table. The table for autorouting is activated by clicking on
the Autorouting Table option in the Edit menu. In response, ACTIVE-
CAD displays the Connections window that allows for selecting the start
and end points for wiring.

To select a starting point, click on the symbol in the Connect From|Sym-
bols field. The pins for the selected device will appear in the For field. Se-
lect from that field the pin which will start the wire connectivity.

Next, choose the end pin for the wire by selecting the symbol and its pin
from the Connect To field. Clicking on the Connect button will start the
autorouting process. Pins that are already connected are shown in gray
and you cannot automatically connect wires to these pins.

The autorouting is controlled by the setups in the Options and Auto
Connections fields. Detailed description of these items is provided be-
low:

r Ortho connection allows drawing only vertical and horizontal lines.
Disabling this feature allows drawing lines at any angle.

r Check pin type feature automatically verifies the compatibility of
connected pins; e.g. connecting two totem pole outputs will produces
an on-line warning.

r Auto correction helps to select any pin by pointing with the cursor in
its neighborhood.

r Cross chip allows drawing wires through component symbols.
r Auto connection automatically draws wires between selected end

points. The wiring editor will draw a wire that does not overlap with
other wires and avoids going through components.

r Optimization gives the drawing algorithm more time for calculation
and provides a higher percentage of automated connections.
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r Precise option will use the smallest grid available for drawing con-
nections in a highly populated area.

Auto connection option allows for fast and efficient wire connections.
You can modify the automatically drawn wires by selecting the Select
mode and manually dragging the wires.

Drawing graphics
The graphics editor is selected with
the Graphics toolbox icon or the F6
keyboard key. The elements drawn
with this editor have no electrical
parameters, and therefore they are
not checked for electrical rules.

The Graphics Toolbox (Figure 2-20) has the following options:

Line - draws a single line.

Polyline - draws multiple-segment lines.

Ortho Line - draws vertical and horizontal lines exclusively.

Rectangle - draws a rectangle by selecting diagonal corners.

Circle - draws a circle by selecting the center and then stretching its
outline.

Arc - draws a part of a circle by selecting the two endpoints of the
arc, and then stretching its outline.

Text - allows creating and placing text strings on schematics.

Text Style - used for setting the text size, appearance (font) and
color (Figure 2-21).

Figure 2-20. Graphics Toolbox
Options.

Drawing graphics 2-33



Line Style - allows setting line shape, color and thickness (Figure 2-
22).

Each graphics editing operation is started and ended by clicking the left
mouse button. You can discontinue the current operational mode by

clicking the right mouse button, followed by selecting the End icon
in the SC Graphics toolbox (Figure 2-20).

Figure 2-21. Text Setting.

Figure 2-22. Line Setting.
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Note: The text and graphics drawn in graphics mode represent supple-
mental schematic descriptions. They do not represent any electrical data
and cannot be searched for or displayed selectively. For this reason, the
graphical entries should be used seldom.

Examples of some graphical elements are shown in Figure 2-23

Editing A Schematic

The Select and Drag mode, activated by the Select icon, allows
changes to the existing schematic designs. Operations like deleting, mov-
ing, rotating components, dragging wires or buses can all be performed
in this mode. To enter the schematic editor mode, press the F4 key or

click on the Select and Drag icon.

Selecting Objects
An object is selected for editing by placing the cursor over its body and
clicking with the left mouse button. The selected items are highlighted
with an outline box. Selected wires and buses are highlighted by a
change in color. Clicking outside the selected item deselects it. To select
multiple items, press the Shift key and then continue clicking on addi-
tional components.

You can select the following items for modification:

r Component
r Wire

Circle

Rectangle

Arcus

Line

Multiline

Ortho Line

TEXT

Figure 2-23. Examples Of Graphics Elements.
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r Bus
r I/O Terminal
r Graphics and Text

Dragging Symbols And Wires
To drag or move a component or a group of components, position the
cursor over one of the selected items and press the left mouse button.
Next, move the cursor, keeping the left mouse button pressed down. The
group of selected components will follow the cursor to the desired loca-
tion. Releasing the mouse button will place the selected items at the new
location. The auto-panning software allows moving items outside the
visible schematic area, without using the scroll bars.

Both the components and their wires move with the cursor. The Drag
mode causes the dragged symbols to bounce back if the Allow symbol
overlap option is not selected (in View|Preferences|General Settings)
and the symbols overlap at the new location with other symbols.

NOTE: You can force overlap of symbols and wires if you drag them with
the Alt key depressed.

NOTE: You can disable automatic rewiring of the moved components by
performing the move operation with the Alt key depressed.

To edit a wire, click on the section of the wire that you want to move,
and drag it with the cursor, keeping the left mouse button pressed down.
Releasing the mouse button will place the wire at its new location.

Overlapping symbol outlines

ACTIVE-CAD continuously checks if the symbols hidden (rectangular)
outline does not interfere with another symbol’s outline. If it does,
ACTIVE-CAD will prevent you from placing the component at the new
location. For this reason, you may observe that after dragging a compo-
nent to the new location, it jumps back to its previous location. To allow
for symbol outlines to overlap, drag the symbols with the Alt key de-
pressed or select the Allow symbol overlap option (in View|Prefer-
ences|General Settings) .

Moving and shaping buses

To shape a bus line, click on the item and holding the mouse button de-
pressed, move the mouse device. Notice that the bus may move in seg-
ments, and moving the entire bus may require several drag operations.
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This extra flexibility allows bending buses into desired shapes, and to po-
sition them more precisely on schematic sheets.

NOTE: The bus shaping mode does not move the bus taps.

Dragging buses with bus taps

To drag a bus with its wire taps, you need to select the wire tap dragging
mode by clicking next to the bus and dragging a small dotted square
around any bus segment and one or more taps. Releasing the mouse but-
ton will turn the bus red and will select the wire tap dragging mode.

Clicking on the bus will move its entire structure, including the bus taps.
To effectively move buses with taps, you need to shape the bus before at-
taching taps, because after the taps have been drawn, the bus structure
will remain rigid.

Rotating Components
There are three (3) modes of component rotation:

1. New component rotation - You can rotate the component attached to the
symbol placement cursor by clicking on the Ctrl+L keyboard keys.
Each click will rotate the component 90 degrees in the counter clock-
wise (CCW) direction. Clicking on the CTRL+R keyboard keys will
rotate the component in the clock-wise (CW) direction. The Ctrl+M
keyboard keys will create a mirror image of the symbol.

2. Direct schematic component rotation - To rotate a schematic component,
enter the Select mode and click on the desired component. Once the
red rectangle appears around the symbol, click on the Ctrl+L key-
board keys to rotate the component in the counter clock wise (CCW)
direction. Each keyboard key activation will rotate the component by
90 degrees in the CCW direction. To rotate the component in the
clock wise (CW) direction, click on the Ctrl+R keyboard keys. To
generate a mirror symbol image, activate the Ctrl+M keyboard keys.

3. Rotation by symbol editing - Any symbol can be rotated through the edit-
ing process. First, select the symbol in the Select mode and then click

on the Properties icon. When the Edit Symbol window appears,
click on the Attributes button which will display the Symbol Attrib-
utes window. Select the desired symbol rotation from that window.
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Deleting objects without moving wires
You can delete an object or a group of objects on the schematic without
deleting wires that have been connected to these objects. First, select the

objects and then click on the Disconnect symbol icon, as described
in the Replacing Symbols section, below.

Copy, Cut and Paste
The Select mode allows copying objects from the schematic to the clip-
board and then inserting the copied schematic section on the same or an-
other schematic using the Paste operation.

To copy a section of the schematic, select the object you want to copy and
then select the Copy option in the Edit menu. The selected objects will re-
main unchanged on the schematic sheet, and their copy will be placed in
the schematic clipboard.

NOTE: All wires that are connecting selected symbols to other symbols,
which have not been selected for the Copy operation, will not be copied
to the clipboard.

Cut and Paste
The Cut option (Edit menu) copies the selected objects to the clipboard
and deletes them from the schematic. It also deletes the wires between
the deleted section and the rest of the schematic design. To avoid delet-
ing of these wires, use the disconnect function described in the Replacing
Symbols section.

To paste the contents of the clipboard on the schematic sheet, select the
Paste option in the Edit menu. A rectangle representing the schematic
section will be displayed. Move it over to the desired schematic sheet lo-
cation and click the mouse button to place the clipboard contents on the
schematic. Pressing the right mouse button cancels the operation.

Copying a schematic to other Windows programs
The Copy and Cut operations use the schematic clipboard that cannot be
accessed by other Windows programs. You cannot directly paste the AC-
TIVE-CAD’s clipboard contents in other programs. To copy a schematic
section to another Windows program follow this procedure:
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1. Arrange the schematic window so that you see the entire section of the
schematic you want to paste into another program.

2. Press the Alt+PrintScreen keyboard keys. This copies the selected win-
dow to the Windows clipboard as a bitmap.

3. Open the Windows Paintbrush program and select the Paste option
from its Edit menu. This will paste the schematic window bitmap to
the Paintbrush window.

4. In the Paintbrush window, select the rectangle area that you want to
copy to your program and select the Copy option from the Paint-
brush Edit menu.

5. Go to the program in which you want to place the schematic bitmap
(e.g. Microsoft Word) and paste the current Windows clipboard that
contains the desired area of the schematic window.

Replacing symbols
To replace a symbol on the schematic, you have to first delete the exist-
ing one and place the new one. To do so, you need to be able to delete a
symbol without removing the wires.

Removing a symbol without deleting wires

Select on the symbol to be removed and click on the Disconnect symbol

icon. This operation disconnects the wires from the symbol, so that
they become hanging wires ended with crossed circles or squares, which
are called wire-ends. After the wires have been disconnected from the
symbol, the symbol can be deleted from the schematic.

Connecting a symbol to hanging wires

To connect a symbol to hanging wires, place it so that its pins are placed
directly over the wire-ends (red crossed circles or squares ), which mark
the end of the hanging wires. Next, with the new symbol in place and se-

lected, click on the Connect symbol icon. All wires that overlap the
symbol’s pins will be connected and the wire-ends will disappear.

All wires that did not overlap the symbol pins will remain disconnected.
These wires can be connected to symbol pins by dragging their wire-
ends and dropping them at unconnected pins. A message confirming the
wire connection is displayed before a connection is completed by releas-
ing the mouse button.
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Editing Symbol Properties
You can change symbol attributes
(reference name, part name, used
section, etc.), by first selecting an ob-
ject and then clicking on the Proper-

ties icon. In response, the
Symbol Properties window will be
displayed (Figure 2-24). The same
Symbol Properties window can be
activated by double clicking on the
desired symbol.

PCB Footprint
To add the device packaging information to a schematic symbol switch
to the Select mode. Next, double-click on the selected component. When
the Symbol Properties window (Figure 2-24) is displayed, enter any foot-
print name information into the Footprint field. This information will be
stored in the design database, displayed in the inquiry mode and added
to the netlist. When you assign a footprint name to a symbol for the first
time, ACTIVE-CAD saves the information in the library. Every time this
symbol is placed on schematic, its footprint name will be used by default.

Symbol attributes
You can add special attributes to each schematic component, such as
power dissipation, voltage, current load, etc. To add these attributes to a
schematic device, switch to the Select mode and double-click on the se-
lected component. when the Symbol Properties window (Figure 2-24) is
displayed, enter the attribute information into the Parameters field. This
information will be stored in the design database and will be available
for the Query window, Bill of Material report and any exported netlist.

Figure 2-24. Symbol Properties Window.
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Pin Parameters
You can define pin parameters for cell, macro and device pins. These pa-
rameters can contain information for the PCB layout program, FPGA
routing system or simply for documentation. To define pin parameters,
click on the Pin Parameters button in the Edit Symbol window (Figure 2-
24). The Pin Parameters window (Figure 2-25) lists all device pins. Click
on the desired pin and enter the name of the desired parameter in the
Name field (e.g. Width) , and its value in the Description field (e.g.
0.25"), and click the Add button. The new parameter will be added to the
parameter list. Note that each pin has its own list of parameters. The pin
parameters are included in the Bill of Material report and in the ex-
ported netlist files. They can also be viewed in the Query window.

Query

The Query mode is selected by pressing the Query window icon.
This mode allows you to inquire about any component or connection on
the schematic. To switch to the Query mode, press the F7 key or click on

the Query window icon. A window similar to Figure 2-26 will dis-
play all pertinent information about the selected component or connec-
tion.

To select a component or connection for the SC Query/Find window, po-
sition the cursor over its body and click the left mouse button. To select
more than one item for the SC Query/Find window, press the Shift key
while selecting additional components or wires.

Figure 2-25. Pin Parameters Window.
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You can inquire about connections by clicking directly on the schematic
wire. To inquire about the components, you need to click on the sche-
matic symbols. If the listing in Figure 2-25 displays a list of pins in the se-
lected connection, you can instantly find the symbol associated with a
selected pin by double clicking on the listed pin. If the SC Query win-
dow displays component information, clicking on any of its pins dis-
plays all wire connections for this pin.

Back Annotation
All back- and forward-annotation in ACTIVE-CAD is based on the ECO
(Engineering Change Order) standard. By using the ECO commands,
you can automatically update the design database used for a project with
the changes that you have made in any of the applications.

For example, if you have a schematic that has been used to lay out a PCB
board, and the board designer makes some changes in the layout, you
will need to update your schematic with these changes.

Manual schematic updates are labor-intensive and error-prone. Instead,
you can modify the schematic by a PCB program that generates a list of
ECO commands. This process is called back annotation. The ECO com-
mands can be passed in a text file format or by using IPC (Inter Program
Communication that uses Windows Dynamic Data Exchange) protocol.
The ECO commands can be used to perform operations such as swap-

Figure 2-26. Query Windows For Symbols
& Wires.
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ping gates and renaming components. They also allow you some more
advanced operations such as changing connections, adding and remov-
ing components, etc.

To import a back annotation file, click on the PCB |Back Annotation op-
tion in the Options menu. When the Back Annotation window appears,
select the ECO file from the File Type field and select the file name from
the File Name field and click on the OK button. ACTIVE-CAD reads the
ECO file and updates the schematic. A detailed report about the per-
formed changes is displayed in the Messages window, at the bottom of
the computer screen. At the end of processing ACTIVE-CAD will ask if a
report is needed. The report will be saved as a file with the same name as
the back annotation file but with the *.BER extension.

The level of ECO commands depends on the specific application used in
the design process. Forward-annotation takes place when a schematic is
modified after creating a PCB layout, and these changes are used to up-
date the PCB layout.

ACTIVE-CAD implements all ECO commands for both back- and for-
ward-annotation. ACTIVE-CAD has a built-in IPC interface, so that other
applications using the IPC protocol can exchange the design information
with ACTIVE-CAD. These protocols can also perform other useful opera-
tions like cross-probing.

Working with the Simulator

Creating a netlist
A binary netlist is used to link the ACTIVE-CAD Schematic Editor with
its background Simulator when the simulator is activated for the first
time. The binary netlist, also called a connectivity database, can be gener-
ated manually using the Create Netlist option in the Options menu. The
netlist is automatically stored with the project files by Project Manager.
However, when you are not using the simulator, the netlist is not auto-
matically updated until you select the Create netlist option again or start
the simulator.

Each time you start the ACTIVE-CAD Simulator, the Schematic Editor
automatically generates a new binary netlist to make sure that you are
simulating the latest schematic changes. This new netlist is then loaded
into the simulator. Once the simulator is started, every schematic change
is instantly fed into the simulator and you do not have to generate an-
other netlist to account for the schematic changes.
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To create a netlist in the ASCII text format, select the Export Netlist op-
tion in the Options menu. This option is described in detail in the Menu
Reference chapter.

Hidden pins in the netlist
The power pins are typically not displayed with the schematic symbols.
They are defined as hidden pins and have the appropriate pin numbers
assigned. You can inquire about the device power pins by selecting them
in the Query mode.

Manual wiring of power pins

If you want to display the power pins on the schematic, you have to edit
the symbol with the Symbol Editor. You can change the attributes of the
power pins from PWR to PAS and place them in the symbol body. This
allows you to make power pin connections like any other pins on the
schematic.

Automatic wiring of power pins

If the power pins are hidden, ACTIVE-CAD can automatically connect
all pins of the same type. When you use the Create Netlist option,
ACTIVE-CAD prompts you in the Create Netlist window(Figure 2-27)
about inclusion of the power signals in the netlist. ACTIVE-CAD checks
all symbols for pins that are not displayed on the schematic, and allows
you to connect pins with the same names. For example, you can connect
all GND pins together. If the list has some pins that should not be con-
nected, you need to manually exclude them from the netlist.

Figure 2-27. Power Pin Selection.
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The same rules apply to other hidden pins. For example, Xilinx macro li-
brary symbols have hidden reset pins (GR or GSR) which can be con-
nected together in the netlist to allow resetting of the design in the
simulator.

Linking with the simulator
The schematic editor can operate on-line with the simulator. This hap-
pens when both applications are active at the same time. In the on-line
mode, any changes to the schematic are automatically passed to the simu-
lator. You can experiment in real-time with schematic changes. Each and
every design change can be instantly simulated without any compilation
or new netlist generation.

If you activate the schematic first, the simulator can be started either

from the Program Manger or by clicking on the Simulator icon. This
will start the simulator and load the previously generated netlist. From
this point on, all schematic changes will automatically be fed into the
simulator so that the schematic and the simulators design database al-
ways match.

If the simulator is started before the schematic editor, all test points
(probes) selected within the simulator will be placed on the schematic
once it is loaded. Also if you make any design changes in the simulator
(e.g. Change Technology), the schematic will be automatically updated.

Similarly, you can select test points in schematic even if the simulator is
inactive. The selected test points will be displayed in the simulator once
it is opened. If the simulator is on-line and operating in background
mode, you can simulate single steps from the schematic by pressing the
Step or the Next event button in the SC Probes toolbox (Figure 2-29),

which is activated by pressing the Simulation toolbox icon. The
background simulator shows logical states at schematic test points after
every clock cycle, and allows for on-line design corrections.

Working with the Simulator 2-45



Simulating a Schematic

Since the schematic editor has a background simulator, it behaves like a
real hardware breadboard. You can freely select schematic test points
and feed them with test vectors. The simulation results are displayed
right at the selected IC pins (Figure 2-28) both as alpha numerical charac-
ters (0,1, X, and z) and with different colors (red=1, green=0, blue=X, yel-
low=z). You can monitor logic states of selected test points by clicking on

either the Step or Next event icon in the SC Probes toolbox

which is activated by pressing the Simulation toolbox icon.

The Step icon is similar in operation to the Short step button in the simu-
lator. However, its simulation step time is set with the General |View-
Preferences menu in the schematic editor. This setting can be different
from the simulation steps set in the simulator.

The SC Probes toolbox (Figure 2-29) contains two icons, Next event

for simulation and Previous event icon for returning to previous
simulation events. A simulation event is a change of logical state on any
of the monitored test points (probes). Next event will go to the next
event and update the probes on the schematic. Previous event will go
back to the previous event on the selected test points so you can analyze
the past design behavior. Both icons use the background simulation re-
sults. If the Next event step goes beyond the previously simulated wave-
forms, the simulation will be activated and the new results will be
displayed.

Figure 2-28. Pins With Probes.
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Selecting Simulation Test Points

To add a new test point to a schematic, select the Simulation toolbox
icon or press the F8 key. The Simulation toolbox in Figure 2-29 will be
displayed. To place test probes on the schematic, activate the Set probes

icon, located in the top left corner of the Simulation toolbox. Next,
place the cursor at the tip of the device pin and click the mouse button. A
gray square appears at the cursor location. This square will be filled with
color corresponding to the pin’s logical state that is produced by the
simulation process. To delete a selected test point, click on it with the
mouse again.

To select multiple pins of the same
device, click on the device body in-
stead of its pin. If you select an IC,
all its pins will be displayed in the
Probe window (Figure 2-30). To se-
lect an IC pin for test point display,
double click on it, or highlight it
and then press the Add button. The
selected pins are displayed on the
schematic after you press the OK
button.

You can also click directly on the desired test point on the schematic to
place a probe.

Device Pin Event Tracking
Since ACTIVE-CAD is a closely integrated schematic editor and simula-
tor, whatever you do to the design from the simulator affects the sche-
matic display and vice versa. For example, the two schematic-based

Figure 2-29. Simulation Toolbox.

Figure 2-30. Probe Window.
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Event icons in the SC Probes toolbox allow searching for events to the
left and right of the current simulator (waveform) cursor location.

Clicking on a selected signal name (it will become blue) in the simulator
window, and then clicking on any one of the SC Probes toolbox double-
arrow icons, will move the simulator cursor to a new simulation event on
that selected signal line and at the same time will update the schematic
LVIs (Logic Value Indicators) display, which perform the function of
LED lamps on hardware breadboards. Similarly, you can select multiple
signal lines in simulator and and perform concurrent event searches on
these lines in the schematic editor.

Displaying logical states
The logical states are displayed on all probes in the form of one or two
characters on a colored background square (Figure 2-28). The characters
are not displayed when the font is too small, but the background color
will always be visible, allowing you to easily determine the pin’s logical
state. The colors and symbols displayed on the probes are shown in Ta-
ble 2-1.

Table 2-1. Probe symbols on the schematic

Symbol Color Description

1 red high

0 green low

X dark blue unknown or don’t care

Z yellow high impedance or not connected

R cyan reference voltage (ECL)

V cyan high voltage (e.g. 12V, -5V)

? green unknown activity low

? red unknown activity high

gray state not defined

2-48 Displaying logical states



Component libraries
The component libraries of the ACTIVE-CAD system are stored inter-
nally by the Library Manager software program and the associated data-
base. Schematic symbols and corresponding IC (simulation) models,
packages, etc., are all linked together within the Library Manager data-
base.

To review the directories and contents of these libraries, select the Li-
brary Manager program from the Project Manager. You can also invoke
the Library Manager by clicking on the Lib Manager button in the Li-
braries window, which is activated by clicking on the File|Project Li-
braries option.

For details, please refer to the Library Manager chapter of this Guide.
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Chapter 3

Buses

A bus is used to represent multiple wire connections by a single graphi-
cal line. Instead of drawing separate wires, you can create a single bus
line that contains all of the wires. Traditionally buses represent the signal
lines of the same type, e.g. all address lines or all data lines. However,
the bus line can be used to connect any types of signals, not necessarily
related to one another. The bus lines are designed to make schematics
more readable, and their utilization depends on specific applications.

Because bus connections depend on how you name the bus members
and not how they appear on the schematic, it is easier to make a mistake
using the bus connections instead of single wire connections. Be sure to
check all bus connections with the Query option.

Bus Definition

Bus name
A generic bus name should consist of the array name (e.g. DATA) and
the definition of upper and lower signal indexes (e.g. [0:15]). A typical
bus name is a combination of name and index:

NAME[X:Y]
where X, Y are integer numbers greater or equal 0.

The number of signals N in a bus is calculated from the this formula:

N=absolute of (X-Y) +1.
Note that it is possible to have X=Y, i.e. a bus that has only one signal,
e.g. DATA[3:3].



Each bus signal line NAME[X:Y] has multiple single wires with their
own names defined as NAMEA , where A is the number within the
range of X, Y (including both limits). For example, bus DATA[0:3] con-
tains signals DATA0, DATA1, DATA2, DATA3.

FThe bus name should not end with a digit. It can lead to unexpected
connections. For example, buses DATA1[0:7] and DATA[0:10] will
have a connection on signal DATA10 that is a member of both buses.

Bus signal order

Buses NAME[X:Y] and NAME[Y:X] contain the same sets of signals, but
they define a different order of signals in the bus. The signal definition
order is important when a bus is connected with a bus pin, as it is ex-
plained later in this chapter. The significance of the bus members is im-
plied by software for which Schematic Editor produces data. In XILINX
designs buses should be defined with the most significant bit (the one
with higher index) as the first and the least significant bit as the last. For
example, four-member DATA[3:0] bus has the most significant DATA3
bit defined as the first and the laest significant bit DATA0 defined as the
last.

NOTE: Using the same signal definition order (i.e. either from MSB to
LSB or from LSB to MSB) in the whole design is strongly recommended.
Mixing the definition orders can be a source of errors.

Bus pin order

When connecting a bus to a bus pin, the connections between signals con-
tained in these two objects will be established in the signal definition or-
der, i.e. from the bit defined firs to the bit defined last. If the number of
signals in the bus signal line and the bus pin are different, the signals
with indexes exceeding the signals count on the smaller bus will not be
connected at all.
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For example, connecting a symbol bus pin A[3:7] to the bus line D[11:2]
(Figure 3-1), will create the following connections:

pin A3= signal D11, pin A4=signal D10, pin A5= signal D9, pin A6= signal
D8, pin A7= signal D7. Signals D6, D5, D4, D3 and D2 will not be con-
nected to the bus pin A[3:7].

NOTE: The names of buses and bus pins are irrelevant for making
physical connections. For example, connecting the bus pin A[0:3] to bus
A[3:15] will produce the following connections: pin A0=signal A3, pin A1
= signal A4, pin A2 = signal A5, pin A3 = signal A6.

Bus terminal
Bus terminals that represent bus pins in hierarchical designs, are sub-
jected to the same rules of connectivity as buses and bus pins. The bus
pins are used to connect a bus line directly to symbol pins. Bus terminals
save space on the schematic and make it more clear .

The bus pin A[3:7]
connected to the bus
D[11:2]

The equivalent connections
made using the regular pins
and bus taps.

Figure 3-1. Example of bus connection with bus pin.
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NOTE: Unless you assign to a bus line a specific name, the bus terminal
name will automatically be assigned to the connected bus signal line.

Unnamed Bus
Bus pins can be connected by unnamed bus lines. In this case, the bus sig-
nals are connected via unnamed bus members, and the connections or-
der is governed by the bus pin definition order. For example, connecting
the bus pin A[0:8] to bus pin D[3:0] via an unnamed bus line will pro-
duce the following connections: pin A0 = pin D3, pin A1 = pin D2, pin A2
= pin D1, pin A3 = pin D0. Pins A4 though. A8 will not be connected.

This bus terminal substitutes
seven regular I/O terminals

Figure 3-3. Bus terminal on the schematic.

The connection
between bus pins
made via unnamed
bus.

The equivalent
connections made
with single wires

Figure 3-2. Connecting bus pins with an unnamed bus.
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Generic buses
To connect a bus to a bus pin or bus terminal you must use a generic bus
that consists of the bus name and indexes (NAME[X:Y]). You cannot di-
rectly connect a bus with disparate signal names (complex bus) to a bus
pin or bus terminal. The Editing Complex Buses section explains how to
connect such buses to pins and terminals.

Complex buses
A bus line may be comprised of several generic buses and individual sig-
nal lines. For example you can combine buses ADDR[0:15] and bus
ADDR[16:31] into one bus. The complex bus is a set of generic buses
which contains all signals from these buses. The complex bus can also
contain non-indexed signals, e.g. CLOCK, RESET, etc. Such buses are
often called the control signal buses.

NOTE: You cannot directly connect non-indexed bus signals to bus pins
or bus terminals. Instead, single I/O terminals and single symbol pins
must be used to connect these non-indexed signals.

When connecting a generic bus to a complex bus, the name of the generic
bus has to be explicitly listed on the appropriate generic bus sections. For
example, Figure 3-4 shows a complex bus comprised of generic buses
CTRL[0:3] and STS[0:4]. The bus stubs connected to the input terminals
(CTRL[0:3] and STS[0:4]) do not need to be named. However, the bus
stubs connected to the symbol bus pins need to be named explicitly, as
shown on input to symbols H6 and H7, below.
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Bus Connection Rules
Buses can be connected to single pins and bus pins. The single pins are
connected to buses via bus taps. The bus taps have to be named with con-
crete signal names, so that it is clear which bus member is connected to
each single pin. If you draw a bus tap wire and do not assign any name,
the schematic editor will not know which bus member has been con-
nected..

Connecting wires (taps) to a bus

In order to connect a single wire to a bus, you need to draw a wire that
starts or ends at the bus line. This connection is called the bus tap. The
shape of the tap symbol is defined in the Edit Bus window (Figure 3-5),
which is invoked by double clicking on a bus in the Select mode.

Connecting a bus tap to the bus does not guarantee any connection. For
example, connecting a signal to a bus and naming it A1 will produce a
valid connection only if there is another signal line with the A1 name.

The bus tap name is the same as the associated net name. The bus tap
symbol is only a graphical confirmation that the net name is part of the
bus. However, it does not have any other significance.

You have to put the bus name
labels on the bus next to the
bus pin to specify which bus
signals should be connected

You have to use separate bus
terminals for each part of the
complex bus.

Figure 3-4. Example of a complex bus.
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Bus pins

Symbols that have bus pins can be directly connected to bus lines. If the
bus ADR[0:3] is connected to the bus pin D[2:4], ACTIVE-CAD will auto-
matically generate the following connections:

ADR0=D2, ADR1=D3, ADR3=D4. The pin ADR4 will not be connected.

Connecting buses in a multi-sheet design

If you draw buses on schematics in a multi- sheet design, then the bus
signals with the same name will automatically be connected.

FDo not use bus terminals to connect the same bus signal on different
sheets of the multi-sheet schematic design. Bus names will automat-
ically connect signals between schematic sheets.

NOTE: Terminals should be used in the multi-sheet design only if the sig-
nal I/O type (input, output, bi-directional) needs to be defined.

Connecting buses in a hierarchical design

All hierarchical macros (schematic sheets) interface with other macros
through their I/O terminals. If a hierarchical macro has a bus, it can be
connected to other sheets only if it is assigned an I/O terminal. Such an
I/O terminal will be represented at a higher hierarchical level as a single
symbol bus pin, which can be connected to other symbols at the higher
hierarchical level.

Drawing a bus
To draw a bus, follow this procedure:

1. Click on the Draw buses icon.

2. Click on the schematic where you want to start a new bus line.

3. Move the cursor and click the mouse button on every corner of the bus.
A thick, red bus line confirms the last section of the bus line.

4. To assign a terminal to the bus, press the right mouse button to discon-

nect the bus from the cursor. Next, click on the I/O Terminal
icon. When the Edit Bus window appears, enter the bus name, select
the lower and upper range and choose the I/O type.
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5. To have an unnamed bus , press the right mouse button and then click

on the OK icon.

6. To entirely delete the newly drawn bus, click the right mouse button,

and then click on the Cancel icon or press the Esc keyboard key.

Adding a bus name

To assign a name to an unnamed bus line:

1. Activate the Draw Buses mode.

2. Click on the Add Net or Bus Name icon.

3. When the Add Terminal/Label window appears (Figure 3-5), enter the
bus name, low and high index ranges, and click the OK button.

4. Move the cursor with the attached rectangle to the desired bus location
and click the mouse button.

5. The new name should be displayed on the selected bus.

Moving a bus name

If the bus name has been assigned while the bus was drawn, it will be
permanently attached at one of its ends, and you will not be able to move
it to a new location. However, if the bus name has been added after the
bus has been completed, it will be placed somewhere along the bus line.

Figure 3-5. Defining a bus name.
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Such a bus names can be moved by entering the Select mode, clicking on
the bus name and dragging it to a new location on the same bus.

Using bus terminals
Bus terminals are generally used for two purposes:

r To define bus pins in the hierarchical macro schematic
r To define the bus signals direction, e.g. input, output, bi-directional

The bus terminal defines the direction, name and index of the bus pin of
a hierarchical macro. A bus terminal on a single schematic sheet or hierar-
chical schematic, defines the direction of the signal. However, an I/O ter-
minal on the FPGA top level schematics sheet defines in addition an
external port of the FPGA device.

NOTE: You cannot assign parameters to the bus terminals. You can as-
sign them only to the individual bus wires.

F If you need to assign parameters to a bus, use the single wire termi-
nals, or assign the parameters to the individual bus taps.

Drawing bus terminals

To draw a bus terminal at the end of the bus line:

1. Drag the bus wire to the location, where you want to place the bus ter-
minal and click the right mouse button to free the cursor.

Figure 3-6. Defining a bus terminal.
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3. Click on the I/O Terminal icon, which will invoke the Edit Bus
window.

4. In the Edit Bus window, enter the bus terminal name, indexes and di-
rection. Click on the OK button to completes the operation.

Manual bus taps

Single wires can be connected to a bus with the bus taps. To draw a bus

tap, select the Draw bus taps icon. Start the bus tap wire by clicking
at a pin, I/O terminal or a net. A black line will follow the cursor. Click-
ing at the bus will create a new bus tap.

The schematic editor draws a bus tap on the same side of the bus where
the wire came from.

Automatic bus taps

If the symbol is placed in such a way that its pins can be connect with
straight lines to the bus, you can use the automated bus tap option.

Drawing bus taps with names:

r Click on the Draw bus tap icon and then on the bus signal line. The
name of the bus tap is displayed in the status line at the bottom of the
schematic screen, e.g. A0.

r Use the Up and Down arrow keyboard keys to select the desired bus
signal index . The signal name in the status line changes according to
the bus definition, e.g. for the bus A[3:7], the signal name can change
anywhere from A3 to A7.

r Clicking on a symbol pin will automatically draw a wire from the pin
to the bus, and will assign to it the selected bus tap name. The bus tap
name listed in the status line is automatically advanced by one (1) or
decremented by one, depending whether the Up or Down key was
used for setting the current bus tap index.

r Clicking on the remaining symbol pins will connect them to the bus
and assign to them sequential bus tap names.

r To end the bus tap drawing, press the Esc keyboard key or click on the

OK icon.

NOTE: The automatic bus tap feature works only if the bus is found in a
straight line from the symbol pin, independent of the horizontal or vertical
orientation. Also, the symbol pin cannot be connected to any wire.
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Drawing bus taps without names:

r Select the Draw bus tap icon.
r Click on the symbol pin.
r Wire is automatically drawn from the pin to the nearby bus.
r Keep clicking on other symbol pins that you want to connect to the bus.

r To end this procedure press the Esc keyboard key or the OK
icon.

NOTE: The bus taps without names will not be connected in the netlist.
You have to name them before generating a netlist.

Adding bus tap names
If the wire connected to a bus is unnamed, you need to assign it a bus tap
name.

1. Click on the Draw bus tap icon.

2. Click on the bus line. The first bus member name will appear in the
status line and a small rectangle will follows each cursor movement.

3. Use the arrow keyboard keys to select the desired bus member name
(index) in the status line.

4. Click on the desired bus tap line. The selected name will be assigned to
that wire. If the wire was already named, the new name will over-
ride the old one, and the tap name will be advanced by ‘1’ in prepara-
tion for a new tap naming operation.

5. Press the Esc keyboard key or click on the OK icon to end the tap
naming operation.

Renaming bus taps
To rename bus taps, follow the procedure described in the Adding bus
taps section, right above.

Changing bus tap type
You can select the type of bus tap symbol that will be used on your sche-
matics. To select the bus tap type, go to the Wires & Buses option in the
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View/Preferences menu and select the Bus tap type option. Choose one
of the four allowed values:

Normal, Left, Right and Double.

You can also change the bus tap type by entering the Select mode and
double clicking on a bus. When the Edit Bus window appears, select the
appropriate bus tap. Select one of the four bus tap settings shown in Fig-
ure 3-7

.

NOTE: All bus tap settings apply only to the bus taps drawn after the
new setting has been made. To change existing bus taps you have to re-
draw them with the new settings.

Editing a bus
To edit a bus, activate the Select mode. The Select mode supports the fol-
lowing bus editing operations:

Stretching
You can extend or shrink existing bus by clicking and dragging one of its
ends.

Dragging a bus independent of taps
You can move and drag bus segments. Click on the bus segment you
wish to move and drag it. The wires attached to the selected bus section
are NOT moved along with the bus. You can manually move the bus
taps to the new bus location.

Figure 3-7. Bus tap types.
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Dragging a bus with its taps
To automatically drag the bus taps, select the bus tap dragging mode. This
mode is selected by clicking in proximity of the bus and dragging a small
dotted-line rectangle that includes a section of bus bus and at least one
tap. Upon release of the mouse button, the bus will turn red. Dragging
bus will pull all bus taps with the bus.

To exit the bus tap dragging mode, click outside the bus.

F In the bus tap dragging mode, the entire bus structure is moved as one
piece. Use the bus dragging mode for routing of the bus segments , and
select the bus tap dragging mode for automatic dragging of taps.

Deleting a bus
To delete a bus, click on the bus to be deleted and then press the Del key-
board key. All bus taps and bus terminals will also be deleted.

Renaming a bus
To rename a bus, double-click on the bus name. When the Edit Bus win-
dow (Figure 3-6) is displayed, edit the bus name and its lower and upper
range indexes.

Querying a bus
Bus connections with bus pins are not automatically verified by the AC-
TIVE-CAD software, the way it is done with single wires. The single
wires are physically connected to pins and their connections are easily
verifiable. Buses on the other hand are connected through signal names
and there may be some unconnected pins that look connected. You
should always verify the bus connections in the SC Query/List window

(Figure 3-8), which is activated by clicking on the Query window
icon. This window lists all the bus members and bus pins connected to-
gether.
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NOTE: Because bus connections highly depend its signal names, it is
recommended to always verify the bus connections in the Query window.

Bus probes
The logical state of bus signals can be displayed directly on the sche-

matic. Clicking on the Simulation toolbox icon displays the SC

Probes toolbox. Selecting the Probe icon from that toolbox and click-
ing on the bus pin or bus names will place a gray rectangle next to the se-
lected pin or bus name, and will display the current logical state of the
bus signals, if the simulator was active.

The bus probe displays the logical states provided by the on-line logic
simulator. The simulator can be activated either from the simulator win-
dow, or from the SC Probes toolbox in the schematic.

Schematic design inputs are stimulated by signals called test vectors. If
the bus probe is placed on an input bus terminal (Figure 3-9), the test vec-
tors have to be defined in the simulator window before running the simu-
lation. If the bus probe has been placed on an output bus terminal, then it
will display the logical states generated by the design itself.

Figure 3-8. Example Of Bus Display In The
Query Window

Figure 3-9. Bus Probes Display On The Schematic.
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The bus probes can display the values in binary, hexadecimal, decimal
and octal format. To select the display format, choose the desired setting
from the View/Bus Display menu (Figure 3-10).

The displayed values include only high and low logical states. If the bus
signals have other logical states, such as Z, X, Resistive, etc., the * charac-
ter will be displayed. For example, if the DATA[3:0] bus has signals
D0=z, D1=1, D2=0 and D3=0, the hexadecimal format will display * (as-
terisk), but the binary format will display 001*. Note, that the order of the
signals in the bus determines how the bit values are displayed. If the
same bus was defined as DATA[0:3], the binary display would be *100.

Buses in the netlist
The ACTIVE-CAD binary netlist format provides a full support for bus
constructs. This means that the bus name and its members are defined as
such in the netlist created by the schematic editor. The netlist with buses
is used by the associated simulator to simplify signal selection, i.e. you
do not have to redefine buses in the simulator. When you export the
netlist to other formats, the bus definition is not supported and the buses
are converted into single signal lines.

Using buses with the on-line simulator
Schematic editor buses which are fed into the simulator via the schematic
netlist are represented in the simulator by single bus lines. If a new bus is
added to the schematic and transferred into simulator through the incre-
mental design process, it will be listed in the simulator as a set of discrete
wires. To have the newly created bus shown as a single bus line in the

Figure 3-10. Bus Probes Display Type Selection.
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simulator, you need to reload the simulator with a netlist by clicking on
the Options|Update Simulation option.

The buses can be viewed and selected from the Signal Selection field in
the simulator’s Component Selection for Waveform Viewer window,
shown in Figure 3-11.

The bus signals drawn in the incremental mode will not be displayed in
the simulator’s Waveform Viewer as a single bus due to the lack of sup-
port for the buses in the IPC cross-probing protocol. These buses can be
manually recreated in the simulator (see Simulator User’s Guide).

If you are editing the schematic while the simulator is active you may be
informed by the simulator that a design netlist must be regenerated to ac-
count for the latest bus changes. Upon your acknowledgment, the simula-
tion will reload the new netlist and automatically restore the test vectors.
If you do not update the simulation, the bus changes on the schematic
will not be reflected in the current simulation database.

Editing Complex Buses
ACTIVE-CAD has powerful editing capabilities for creating designs with
complex bus connections. Many FPGA cell or macro symbols utilize bus
pins to enhance the drawing clarity, and they typically group from 8 to
16 I/O pins into one bus pin. These symbol bus pins can be connected to
other bus pins by bus lines.

However, in some cases the bus pins can be inconvenient to use, particu-
larly if you want to mix signals from different buses or reorder the signal
lines within the buses. This section shows how to use the advanced bus
editing features to achieve any desired connections.

Bus DATA[0:3]
displayed in the
simulator.

Figure 3-11. Bus Display In The Simulator.
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Let us consider the schematic in Figure 3-12. The symbols U15, U16 and
U24 need to be connected in the following way:

Table 3-1.

Source pin Destination pin

U24.O U15.B7

U16.O6 U15.B6

U16.O5 U15.B5

U16.O4 U15.B4

U16.O3 U15.B3

U16.O2 U15.B2

U16.O0 U15.B1

U16.O1 U15.B0

Notice that the output of the OR gate (U24.O) connects to the most sig-
nificant bit of U15 (pin B7) and that the lowest two bits U15.B0 and
U15.B1 are swapped and connect to U16.O1 and U16.O0, respectively.

Figure 3-12. A Schematic For Complex Bus Editing.
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To connect the U15 pins with discrete wires would be cumbersome and
time consuming. The ACTIVE-CAD schematic editor allows you to make
these connection through the bus editing process:

1. Draw a bus line from U16.O[7:0] to U15.B[7:0]. The pin connection or-
der is displayed next to the bus pin to clearly list what is actually
connected.

2. Add the bus name AD[7:0]

3. Click on the Draw bus taps icon and connect the U24.O pin to the
bus and name it M7; the bus will now have has 9 members: AD0
through AD7 and M7

4. You should end up with the schematic similar to Figure 3-13

5. Activate the Select mode and double-click at the end of the bus line
where it connects to the U15.B[7:0] pin. The window in Figure 3-14
lists all bus members that are connected to U15 through that bus pin.

Figure 3-13. Simple Bus With Connects Bus Pins.
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6. To rearrange the order of signals connected to the U15 bus pin edit the
signals listed in Figure 3-14. Since the M7 signal should be con-
nected to B7, enter it first into the window as shown in Figure 3-14.
Next, put the comma (,) and list the six signals that are connected in
the proper order (AD[6:2]). Because the last two signals of that bus
are swapped, you must list them explicitly (AD0 and AD1).

7. Click on the OK button to exit Figure 3-14. In response ACTIVE-CAD
displays Figure 3-17 which lists the new bus members directly at the
U15-B input pin.

Note that if the B bus pin had a different signal order, for example B[0:7])
instead of B[7:0], then you would have to list the signals in the reverse
order to provide the connections listed in Table 3-1. In such a case the
proper definition for the bus pin would be: AD1, AD0, AD[2:6], M7.

Figure 3-14. Editing Bus Pin Connections.
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You should always double check the complex bus connections. The best
way to check bus connections is to start the simulator and use its View
Connections option to verify the critical bus connections.

6. Start the simulator and select the Add Signals option from the simula-
tor Signal menu. The Chip selection window in Figure 3-16 will list
all devices, cells and macros. Double click on U15. In response, AC-
TIVE-CAD displays explicitly all pins of U15 in the Pins For window.

7. Select the pin U15.B7 and press the right mouse button to invoke the lo-
cal menu shown in Figure 3-16.

Figure 3-15. Completed Schematic With Complex Bus.
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8. Select the View Connections option in Figure 3-16 and notice that the
new window shows a direct connection between U15(ADD8).B7 and
U24(OR2).O (Figure 3-17).

9. Similarly, you can verify that the two lower bits (U15.B1 and U15.B0)
are properly connected. Figure 3-18 shows the connectivity for
U15.B1.

Figure 3-16. Selecting View Connections Option.

Figure 3-17. List Of Connections To The M7
Signal.
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Figure 3-18. Connections to the U15.B1 pin
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Chapter 4

Managing Schematic Designs

Design Structure
You can create in ACTIVE-CAD the following design structures:

r single sheet design
r multi-sheet design
r hierarchical design

Choosing a specific design structure depends on the particular design
size (number of symbols and connections), purpose (board or chip de-
sign), and company standards. The following sections describe each of
these design types and their utilization.

Single sheet schematic
Single page designs are typically used for small designs. The largest page
size is 44"x34" (size E). The major advantage of a single sheet schematic is
that you can use physical connections for the entire design. This makes
tracking of the connections easier when a board is made.

The disadvantages of using large pages are:

r Slow redraws. A schematic with large number of symbols takes longer
time to scroll than a schematic with fewer parts.

r Difficulties to print on laser printer. Large schematic sheets need to
be printed on plotters. Laser printers can usually handle pages of
size B (11"x17"). The four-page tile printing option allows printing a



single schematic page on four sheets of paper. This eliminates the
need to use plotters for medium-size drawings.

Multi-page flat schematic
When a design becomes too large to print on a single page, you can use a
multi-page design structure. When you create a new sheet, it automat-
ically becomes a part of the current project. Whatever you draw on that
page belongs to the same board or chip design as the first page. To make
connections between schematic pages, you have to make logical connec-
tions by using the same net names, I/O terminals or bus taps on all sche-
matic sheets. For example, entering the CLOCK I/O terminal on sheet 1
and CLOCK net name on sheet 2, will automatically connect both items.
These connections can be confirmed by using the Query option.

The following are advantages of using the multi-sheet design structure:

r You can use small sheet sizes which are easier to print on laser printers
and easier to handle in manufacturing, test and other departments.

r You can handle unlimited design sizes without condensing the sche-
matics.

The following are the disadvantages of using multi-sheet schematics:

r Connectivity errors between sheets are detected only when the netlist
is created. The Query window helps to trace all connections.

r All net names are global. This means that you can accidentally connect
two nets by assigning the same name.

r Symbols with multiple sections, e.g. NAND gates of the 7400 TTL de-
vice, can fully be utilized only within a single page. This can later be
corrected by manually selecting section (gate) reference numbers.

NOTE: All reference designators for symbols in the multi-sheet schemat-
ics have to be unique and ACTIVE-CAD automatically assigns these
unique numbers. If you manually assign the same reference to two differ-
ent devices, an error will be reported when you create a netlist.

Hierarchical schematic
Because of the large number of symbols used in ASIC designs (typically
thousands), it is very difficult to handle such designs using the simple
multi-sheet design structures. These designs typically require thousands
of simple primitives like gates and flip-flops to be used for PLD, FPGA
or ASIC. To simplify the schematics, designers prefer to use high level
components that have clear functionality, e.g. TTL-equivalent devices.

4-2 Multi-page flat schematic



The solution for this problem is the concept of the hierarchical macro.
Such a macro is a device in the library, which appears as a standard com-
ponent, but is internally implemented as a netlist or schematic. For exam-
ple, you can create an equivalent of the 74161 TTL counter by drawing a
macro schematic with only gates and flip-flops. This macro can then be
saved in the library and used several times in your designs. Several
FPGA libraries already come with a number of hierarchical macros so
that you don’t have to create them yourself.

Hierarchical designs are very effective with IC designs (PLD, FPGA,
ASIC, etc.). In hierarchical macro schematics all net names and reference
names are local to these schematics. This means that you can use the
same signal names several times in different macros and they will not be
automatically connected.

The connections between hierarchical schematics and the rest of the de-
sign are made via I/O terminals. These terminals are converted into hier-
archical symbol pins, and after the symbol is placed on the schematic
sheet, wire connections can be made to these pins. This allows showing
explicitly all connections in hierarchical schematic. Since only signals
shown as symbol pins need to be connected, fewer wires need to be
placed, which simplifies designs.

The following are the advantages of using hierarchical designs:

I/O terminal becomes
a macro pin

Hierarchical schematic is converted into a library symbol and can be placed on any schematic.

Figure 4-1. Hierarchical Design Structure.
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r The symbols in libraries can represent large functional blocks imple-
mented in detail on lower hierarchical levels. By viewing the high
level schematic, you can see the general design structure without be-
ing overwhelmed by the implementation details.

r Top-down or bottom-up methodology available in hierarchical de-
sign tools allows team effort. Each design section can be given to dif-
ferent designer. All conflicts between design sections are eliminated
because all interfaces are through explicitly defined symbol pins.

r You can use multiple instance of the same macro. If you were to use
the same schematic sheet in a flat design, you would have to dupli-
cate it for each instance. Any correction to the schematic macro,
would have editing of all its instances. The hierarchical macro needs
to be modified only once because all its instances will be automat-
ically updated by the hierarchical design editor.

r Macros can be used in multiple projects. You can develop a set of re-
usable modules that can be stored as hierarchical macros and used in
several designs.

The disadvantages of using hierarchical designs are the following:

r Net names can become very long. Many IC design tools do not ac-
cept hierarchical netlists. This requires producing a flat netlist out of
a hierarchical design. The method used to create unique reference
identifiers adds the hierarchy reference name to each symbol refer-
ence. For example, a symbol U58 in a macro called H8 will be called
H8/U58. In the multilevel hierarchical designs these names can be-
come very long, depending on the number of hierarchy levels.

r Design back-annotation is difficult to implement, particularly for
PCB designs. Also, there are no PCB design programs that accept hi-
erarchical netlists. For that reason, all the net names and reference
names have to be converted into unique identifiers. The default
method of doing this is to add the hierarchy prefix for each hierarchi-
cal name (e.g. H50/H2/U30). The Annotate option allows you to
produce the unique references without the hierarchy designator,
however, there is no provision for renaming net names. The back-an-
notation changes in the macros are also not supported.

r It is impossible to split IC sections of the same device between mac-
ros. The sections can be manually packed into one device in the PCB
layout program, but they cannot be back annotated to the hierarchi-
cal schematic.
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r Updating macros often requires changing their symbols. For exam-
ple, if you want to add or remove some signals from a hierarchical
macro, the symbol for that macro will be changed. This may require
corrections of wiring on all schematic sheets which use that macro.

Multi-sheet Design Management
Most of the operations in multi-page designs are performed from the Hi-
erarchy Browser, which is located within the Project Manager (Figure 4-
2). Additional schematic related operations can be invoked by clicking
on the icons in Figure 4-2.

Adding new sheets
To create a new empty sheet select the New Sheet option in the File

menu, or click on the New Schematic icon in the schematic editor.
The new sheet receives the name of the project, with the sequential sheet
number assigned to it automatically. This sheet can be saved under a dif-
ferent name using the Save As option from the File menu. Each new
sheet is automatically added to the current project contents. To open a
sheet that does not belong to the project use the Scratchpad option in the
File menu. The scratchpad schematic can be used to draw some tempo-
rary schematics that are then copied to another schematic or deleted
without changing the project schematics. To add a scratchpad to the pro-
ject use the File|Save As option and enter the schematic name.

Figure 4-2. Multi-sheet Project Contents.
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Addingexistingsheets to the project
To add to the current project a schematic from another project, click on
the Add Sheets To Project option in the Hierarchy menu.

Select in the Add to Project window
the schematic file(s) you want to
add and click on the Add button.
The schematic editor loads each
added sheet and verifies if the sym-
bols used in these schematics are
available and if there are no dupli-
cate reference numbers. To select
files from other drives and directo-
ries, click on the Browse button. Ad-
ditional window, displayed in the
lower part of Figure 4-3, will allow
selecting schematic sheets from
other locations. To end adding
sheets to the project, click on the
OK button. The list of project sheets
will be instantly updated and dis-
played in the Hierarchy Browser.

NOTE: The schematic editor automatically adds to the current project
the libraries used by newly added schematic sheets.

Opening non-project sheets

When you click on the Open a Schematic icon or on the File|Open
option, only the sheets that belong to the current project are shown. If
you want to open a sheet that does not belong to the current project, use
the Browse button, which allows searching disks and directories for addi-
tional schematic files.

The newly opened schematics can be edited. However, they do not be-
long to the project till the Add Current Sheet to Project option in the Hi-
erarchy menu is activated.

NOTE: As a schematic sheet is from another project is opened, it is cop-
ied to the current project directory, and any schematic changes will not
affect the projects from which it was copied.

Figure 4-3. Adding sheets to
project.
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The reference names of components on the added schematic sheets are
verified for possible conflicts with reference names on other project
sheets. If duplicate reference numbers are detected on the new sheet,
they will be changed.

Removing sheets from the project
To remove a sheet from the current project, select the schematic sheet in
the Hierarchy Browser (Project Manager), and click the Del keyboard
key. Another way to delete a sheet from the project is to activate it and
then select the Delete Sheet from Project option from the Hierarchy
menu. The deleted schematic will no longer be a part of the project and
will disappear from the Hierarchy Browser listing..

NOTE: The delete option deletes the sheet from the project contents, but
it does not delete the schematic file from the disk. To delete these files
permanently, use the Windows File Manager .

FThe deleted files are readily available for a review and adding back to
the project by clicking on the Hierarchy|Add Sheets to Project option.

Figure 4-4. Open window.
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Opening project sheets
To open schematic sheets that belong to the current project, click on the

Open a Schematic icon, or select the File|Open option. In response,
the Open window (Figure 4-4) appears and lists all project sheets . The
project sheets can also be invoked by double clicking on their names in
the Hierarchy Browser.

Renumbering Symbol References
The symbol reference numbers are assigned sequentially in the order in
which they are placed on schematic sheets. As a result, the symbol refer-
ence numbers in a multi-sheet schematic design can be random. To order
symbol numbers by page, use the Options|Annotate option. It will al-
low you to force the desired reference designations on each sheet.

For example, symbols on the first sheet may start with U100. On the sec-
ond sheet they may start with U200, etc. This naming convention simpli-
fies tracking of symbols on schematic sheets.

To renumber project sheets and the associated symbol reference num-
bers, perform the following procedure:

1. Select the Annotate option in the Options menu.

2. In the new Annotate window select the Whole project option.

3. In the Sheet field, enter the sheet increment, e.g. 100 (Increment box).

4. Press the Annotate button.

5. Press the Close button.

Figure 4-5. Annotation window.
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To renumber sheets in the hierarchical descent order, select the Hierar-
chy Descent box and enter the sheet increment number into the Incre-
ment field. All subsequently drawn lower hierarchical levels will have
their reference numbers increased by the selected number.

Creating a netlist for a multi-sheet design
A netlist generated from a multi-sheet design always carries the project’s
name and has the .ALB file name extension. This file is a binary netlist
that can be used by the simulator and can be exported to other netlist for-
mats. Since the design is contained in one file, the exported netlist is also
contained in one file.

If you need to divide a project into two or more separate netlists, you can
use the following procedure:

1. Using the Hierarchy Browser , select the sheets to be included in the
first netlist. All other sheets should be deleted from the project.

2. Select the Options|Export Netlist option to export the current netlist.

3. Using Windows File Manager, rename the generated output netlist file.

4. To add to the project the previously deleted schematic sheets, select the
Hierarchy|Add Sheets to Project option. Select the desired schemat-
ics from the new Add to Project window.

5. Export the second netlist. Its name will be the same as the project’s
name, but it will contain only the currently selected sheets.

NOTE: If you do not rename netlists generated for the preceding design
sections, they will be overwritten by the last created netlist.

Troubleshooting project contents
r The project contents is stored in the *.PRJ binary file. The file name is

the same as the current project’s name, and it is located in the project
directory. If the project contents file is corrupted, you can delete it
and recreate it by adding all sheets to the project again.

r If a netlist creation error is reported, try removing sheets from the
project until the netlist can be successfully created. Then analyze the
last-removed sheet for any possible errors.
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Multi-sheet schematic connectivity rules
All nets with identical names are automatically connected by the editor.
This rule applies both to single-sheet schematic designs and to multi-
sheet designs. Because of that, you do not need to connect circuits on dif-
ferent sheets with connector or terminal pins.

All wire nets with identical names are connected together. Buses with
identical names are connected only through its member wire names.

Hierarchical Design Management
The design has a hierarchical structure if any of the symbols contains a
netlist or a schematic. The hierarchical symbol is called a macro because
it is built of other symbols internally. The hierarchical macros can be cre-
ated by the user or may already exist in the library. Some libraries con-
tain symbols that are hierarchical macros. If you use one of these
symbols, your design becomes hierarchical.

NOTE: Only FPGA system libraries contain hierarchical macros. Librar-
ies such as TTL, ECL, CMOS, PLD, DSP, etc. do not contain macros.

Recognizing hierarchical macros
The symbols that are hierarchical macros can be recognized by their
color. By default, all schematic-based macros are dark blue. The netlist-
based macros are purple. These default colors can be changed in the
View/Preferences menu.

Netlist-based macros
Importing a netlist file into a schematic automatically creates a macro
which is stored with its own symbol in the project library. The saved
macro can then be placed on the schematic as any other symbol. The
netlist-based macro cannot be edited in schematic editor1.

The applications for the netlist based macros are the following:

4-10 Multi-sheet schematic connectivity rules
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r To reuse netlist files created in other schematic editors. This elimi-
nates a need for reentering the schematics again.

r To download netlist files generated by logic synthesis tools. A netlist
from VHDL or state machine editor can be converted into a macro
and placed on the schematic together with other parts of the design.

r FPGA post-layout netlists can be simulated with board-level compo-
nents. For example, XILINX routed netlist can be imported and
placed as a macro at the board-level schematic. This macro can then
be interconnected and simulated together with other devices such as
memories, PLDs, MPUs, DSPs and other components.

Creating Netlist-based Macros
A hierarchical macro can be created from any netlist file, having one of
the supported netlist formats. Additionally, a schematic can be generated
from such a netlist if the symbols for all the used components are readily
available in the project library.

To create a macro symbol from a netlist, follow this procedure:

1. Select the Import Netlist option from the Hierarchy menu.

2. Select from the Import Netlist window, the netlist format (from the
From Format list) and the netlist file (Input Netlist) to be imported.

3. Click the OK button. This starts the conversion of the selected netlist
format to the ACTIVE-CAD binary format.

4. A new symbol is automatically added to the project library and to the
list of symbols in the SC Symbols toolbox.

5. You can place the newly created symbol on the schematic.

6. If you are not satisfied with the automatically generated symbol shape,
use the Symbol Editor program to make changes.

7. To edit pin names or the internal macro design, t import the netlist as a
schematic (see Generating schematics from the netlist section, below).

ACTIVE-CAD automatically creates a symbol that is based on input
and output terminals listed in the netlist.

F Some netlist formats do not contain information about input and out-
put terminals. In such a case, the symbol will have no pins and is not
usable. Some netlist formats do not define the direction of the I/O ter-
minals and thus all pins are defined as bi-directional. This results in
generating a symbol that has all pins on the right-hand side.
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Importing a hierarchical netlist
Some netlist formats can contain hierarchy information. In such a case
the imported netlist is converted into multiple macros in the project li-
brary. Each macro corresponds to the original hierarchical netlist block in
the source file and has its own symbol in the project library after the
netlist import.

Generating schematics from the netlist
ACTIVE-CAD can generate schematics from netlist files being imported
as macros. To create a schematic sheet from a netlist, select the Import
Netlist option in the Hierarchy menu. In the Import Netlist window, se-
lect the Schematic option and then click on the OK button. The sche-
matic generation process requires that all symbols must be found in the
currently selected libraries. The generated schematic is built on a single
sheet and contains only logical connections (net names).

Schematics generated from imported netlists are saved in the project li-
brary, and they can be viewed and edited the same way as any other hier-
archical schematic macros.

Updating netlist macros
A library macro that has been generated from imported netlist will in-
clude in the comment field a reference to the original netlist location on
disk and its netlist file format. When you create a netlist of the design
that contains netlist-based macros, the version of the macros is compared
with the file on the disk. If the netlist on the disk is newer than the
macro, a message is displayed asking if you want to update the macro.
Answering Yes, will automatically update macro with the new netlist.

You can update macros at any time by importing their netlists and over-
writing the old macros.

Assigning a Netlist to a Symbol
To add an FPGA netlist to a board-level design for the purpose of simula-
tion, use the Assign Netlist option in the Hierarchy menu. This option al-
lows assigning a netlist to an existing symbol. The Assign Netlist option
creates a new object in the project library that contains the imported
netlist and the symbol from the schematic. The new object receives the
name that is a combination of the original symbol name and the im-
ported netlist name. For example, when you assign a netlist TEST.NET to
a symbol PGA175, The new symbol will be called PGA175@TEST.NET.
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To assign a netlist to a symbol on the schematic, select the Assign Netlist
option from the Hierarchy menu, and click on the symbol that should be
loaded with the imported netlist. In response, the Netlist Conversion
window is displayed. Select the desired netlist format (from the From
Format list), select the file name from Input Netlist field and click the
OK button. The netlist will be imported and the schematic symbol will
be saved along with its netlist, under the new symbol name.

NOTE: You cannot assign a netlist to a symbol that has a simulation
model. You can assign it only to a symbol without its own model.

Creating Schematic Macros
To create a hierarchical macro that can be placed as a symbol on a higher
level schematic, follow this procedure:

1. Open a new sheet and enter a schematic design.

2. Use I/O terminals for the schematic inputs and outputs. These signals
will be used as symbol pins for the macro symbol.

3. Choose the Create Macro Symbol From Current Sheet option in the
Hierarchy menu.

4. In the Create Symbol window (fig. 4-6) do the following:

r Enter Symbol Name (up to 8 characters).
r Enter a Comment (optional).
r Verify the Input and Output pins.
r Make sure that the Netlist option is selected.
r Select the symbol shape (Dual in line or Square).

5. Click the OK button. The schematic is instantly converted into a macro
with the name selected in step 4 and saved in the project library.

6. A confirmation message will be displayed upon successful macro gen-
eration and will ask if you want to continue editing of this macro.
Answering No ends conversion of the schematic sheet into a macro.

7. To use the new macro, select it from in the SC Symbols window and
place on the schematic as any other symbol.

8. To modify the automatically created symbol (change its shape or move
pins around), use the Symbol Editor option in the Options menu.
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Creating a hierarchical schematic
Before drawing a schematic, make sure that all necessary libraries have
been assigned to the project (schematic). First, select the Project Libraries
option from the schematic File men, or click on the Project Libraries

icon in the Project Manager. When the Libraries window appears,
select the appropriate libraries and then press the Add button. This trans-
fers the selected libraries from the Attached libraries field to the Project
libraries field and makes them available to the schematics editor.

Next, enter the schematic design, just like any other flat design but re-
member the following constraints:

r Each schematic macro is a self-enclosed entity; any connection to the
other sheets can only be made through the I/O pins.

r Specify the I/O pins explicitly as either Input, Output or Bi-direc-
tional. This is very important because ACTIVE-CAD automatically
generates a rectangular DIP symbol and the location of the pins on
the symbol outline depends upon the pin’s I/O type (only Input pins

Default reference prefix

Define the name for the macro symbol

The netlist option
enables hierarchical
symbols.

Specify the
symbol type to
be generated

Browse option
can select
different
schematic for
the current
macro

This comment will be displayed in SC

Verify the I/O pin names definition. These pins correspond to I/O terminals on the
schematic. You can add some additional empty pins for future use.

Figure 4-6. Create Hierarchical Macro option.
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are placed on the left-hand side of the symbol outline). If needed, the
symbol can be edited in the Symbol Editor.

Bus pins in a macro symbol
Use the bus I/O terminals to add bus pins to a hierarchical symbol. Each
bus I/O terminal is automatically converted into one bus pin of the hier-
archical symbol. This is making the symbol smaller because buses substi-
tute for multiple discrete wires.

To convert individual terminals into a bus pin, edit them directly in the
Create Symbol window:

If I/O terminals have the same name but different indexes (e.g. A1, A2,
A3 ... A15), you can delete them from the pin listing in Figure 4-7 and re-
place with a single bus pin name, preceded and followed by the double
equal signs. For example, ==A[1:15]== will create a bus pin with the A
name and [0:15] index.

Bus pins are
designated by
the double
equation
character.

Figure 4-7. Creating a macro with bus pins.

You can connect buses
directly to bus pins

Figure 4-8. New B-AND4 macro symbol with bus pins.
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Using macros in the schematic
Hierarchical macros are used in schematics the same way as other sym-
bols. The symbol color (dark-blue) indicates that a schematic macro is as-
sociated with the symbol. It can be opened with the Hierarchy Push/Pop
option. Use the Query mode to find out the location of the macro in pro-
ject libraries. You can place multiple copies of the same macro on a sche-
matic sheet.

Remember that only signals defined as macro I/O pins can be used for
direct connection with other devices and macros on the schematic sheet.

Opening a hierarchical macro schematic
You can open a hierarchical macro schematic window in two ways:

r Double-click on the macro’s name in the Hierarchy Browser section of
the Project Manager. This opens the macro’s schematic. To save Win-
dows resources, close the schematic sheet as soon as it is not needed.

r Invoke the H cursor (Ctrl+H) and click it on the macro symbol. This
opens the macro’s schematic temporarily. The schematic is automat-
ically closed upon the H cursor exit from the hierarchical level.

Navigating a hierarchy
Double-clicking the H cursor on a hierarchical symbol displays the inter-
nal schematic of that symbol. The H cursor is invoked either by pressing
the Ctrl+H key or by clicking on the H icon in the vertical toolbar.

While the H cursor is active, you can open as many macros as desired.
To go back to a higher hierarchical level, double-click on an empty space
in the macro schematic. If you click on a symbol that does not have any
schematic, ACTIVE-CAD displays a message Symbol is a Primitive Cell. If
the H cursor is at the top hierarchical level, clicking the mouse button
outside schematic symbols, displays the message: Already at the Top
Level.

To exit the H cursor mode, click the right mouse button or press the Esc
keyboard key. You can also view and navigate the hierarchical structure
of the design from the Hierarchy Browser in Project Manager (Figure 1-
22). Please refer to the Hierarchy Tree Operations section in Chapter 1 of
this manual.

NOTE: Double-clicking on the schematic name in Hierarchy Tree loads
that schematic to the screen for detailed viewing and editing.
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Opening too many schematics in the Hierarchical Browser may strain the
Windows resources. Delete the unused schematic sheets from the Win-
dow menu.

Modifying Macros
If you want to make some changes to an existing macro schematic, use
the following procedure:

1. Bring up the schematic of the macro using any of the three (3) methods
described above. ACTIVE-CAD displays header: Hierarchy Level - Hn

2. Select the Edit Hierarchical Symbol option from the Hierarchy menu.

3. In response, ACTIVE-CAD displays header: Hierarchical Symbol - . This
indicates that the selected schematic is enabled for editing.

4. Make necessary changes to the schematic.

5. Select the Save option in the File menu. This updates the macro.

When you change and save a hierarchical symbol, you change all the in-
stances of this macro in the entire design. If the modified macro sche-
matic has different I/O pins, its symbol will change and the pins may
not match their previous locations on the schematics. If this happens,
ACTIVE-CAD will automatically disconnect the wrong wires and mark
them with crossed circles. These wires will have to be manually recon-
nected by switching to the Select and drag mode, dragging the crossed
circles over the target pins and releasing the left mouse button.

If you edit a macro from the system library that comes with the product,
you will not be allowed to save it in the system library. You can only
save it in the project library. For clarity, use a different name (use the
Save As... option) for the modified macro so that you can always be sure
which symbols are currently used on the schematics.

NOTE: All macros created by modifying the ACTIVE-CAD (system) mac-
ros can only be used with the keylock with which they were saved. For
this reason, network keylocks are strongly recommended because they
allow designers to share their custom-made macros.

The difference between a macro and a schematic
The following example explains what happens with the hierarchical
macro schematic when you create a macro. Assume that the project TEST
contains schematic sheets TEST1 and TEST2. Lets create a macro out of
the schematic sheet TEST2.
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1. Using the Create Macro Symbol option, convert the TEST2 schematic
into a macro called MACRO1 in the TEST project library.

2. The old schematic sheet TEST2 is instantly removed from the project
contents, but the file TEST2.SCH still exists in the project directory
(e.g. in C:\ACTIVE\PROJECTS\TEST). You can open this schematic
file only with the Browse option (available from the File|Open
menu), but there is no longer any relationship between the
TEST2.SCH schematic file and the TEST project or MACRO1.

3. You can directly modify macros schematics. They are automatically up-
dated when you activate the File|Save option.

4. The schematics from which the macros were generated are stored in
the projects library, e.g. C:\ACTIVE\PROJECTS\TEST. Using the
Windows File Manager , you can delete the file TEST2.SCH from
this directory because it is now stored as the MACRO1 schematic.

What happens when the hierarchy symbol changes?
When a hierarchical macro is updated, its symbol is not modified unless
there is a different number of I/O pins. In such a case a new symbol is
generated based on the new I/O pins. This may result in incorrect con-
nections on the schematics that have previously used that symbol.

Clicking on the File|Save option will automatically update all opened
schematics with the new symbol. Other schematics will be updated
when you open them in the schematic editor.

r When the symbols do not match the previous connections, the wires
will be disconnected from that symbol, and a crossed circle or large
dots will be displayed at the end of these wires. To correct these con-
nections, you can drag the circles in the Changes mode and drop
them at the appropriate pins.

r You can edit the newly created symbol in the Symbol Editor pro-
gram so that it matches the old pin locations.

Editing system (ACTIVE-CAD) macros
An edited system macro (from the system library), cannot be saved back
into the system library because of built-in protections against such modi-
fications. They will be automatically stored in the current project library
with the Save and Save As... operations from the File menu.

4-18 What happens when the hierarchy symbol changes?



Exporting a hierarchical netlist
Use the Export Netlist option in the Options menu to export a netlist. A
hierarchical design netlist, can be exported as either hierarchical or flat.

If you choose the Flat option in the Export Netlist window, the netlist
will be exported as one netlist file. To avoid duplication of reference
numbers and net names, the schematic editor adds the hierarchy designa-
tor name in front of each hierarchical symbol reference and net name. For
example, if the macro H2 that contains the U45 symbol, the exported
netlist will list it as H2/U45.

NOTE: If you do not select the Flat option, all hierarchical macros will be
exported as a set of separate netlist files located in the project directory.

Hierarchical Annotation
The Options|Annotation option allows exporting hierarchical designs
as single (flat) netlists with unique reference names for every symbol in-
stance. This eliminates the hierarchical prefixes in symbol names, and
makes for shorter netlists.

To renumber the entire design select the Annotate option in the Options
menu. In the new Annotation window(Figure 4-10) select the Whole Pro-
ject, Hierarchy Descent and All (References) options.

Creating a library of user macros
Each newly created macro it is saved by default in the current project di-
rectory (e.g. C:\ACTIVE\PROJECTS\TEST\LIB). However, you can cre-
ate a special library that contains all your macros for future use on
different projects:

Figure 4-9. Hierarchical design annotation.
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r Select the Create option from the Library menu of the Library Manager
r Enter the desired USER MACROS library name and its directory.
r Draw the macros schematic, and select Create Macro Symbol From

Current Sheet in the Hierarchy menu; use the Browse option to select
the USER MACROS (destination) library directory.

r Click on the OK button.
r Select Project Libraries in the File menu and attach the USER MAC-

ROS library to the project. Otherwise, the newly created macro will
not be seen by the current project.

You can protect the proprietary macros library against accidental dam-
age, by changing its access mode from the R/W (read and write) to R/A
or R/O in the Library Manager. You can also copy macros from different
project libraries to a desired library using the Library Manager (LM)
(see Library Manager Chapter). Such library can contain all user macros.

Deleting macros
To delete a macro from the library, select the Library Manager (see Li-
brary Manager Chapter) window and double-click on the project library
that contains the macro. Click on the desired macro in the listing of ob-
jects, and without closing that window, select the Delete option from
the Object (LM) main menu.

Renaming macros
There are two (2) ways to rename a macro:

r Open the selected macro in schematic editor, and then using the
File|Save As option save it under a different name

r Change the macro name in the Library Manager.

If you have decided to change the macro name in the Library Manager,
invoke this application by selecting File|Project Libraries option, and
then click on the Lib Manager button. This opens the Library Manager
window. Next, double click on the project library that contains the
macro, highlight the macro in the Logic Name window, and without clos-
ing that window, select the Rename option in the Object main menu. En-
ter the new name in the Rename window and confirm the change.

4-20 Deleting macros



Top down methodology
To implement a top-down design, first create empty symbols for hierar-
chical macros. These empty symbols will then be implemented as sche-
matic macros.

To create an empty symbol, select the Hierarchy |New Symbol Wizard
option and then:

r click on Next> button in the Design Wizard welcome screen.

r In the Contents window shown in figure 4-10 enter symbol name and
select Schematic as the contents of the macro. ( State Diagram or HDL
Code can also be chosen; selecting Empty means that macro contents
type will be picked later).

r Click on the Next> button
r In the Ports window (figure 4-11) add ports to the symbol by clicking

on the New button, entering port name in the Name field and selecting
port Direction. Selecting clock input type and combinatorial/regis-
tered output type can be performed after clicking on the Advanced
button.

Figure 4-10. Design Wizard - Contents.
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r Click on the Next> button.

Figure 4-11. Design Wizard - Ports.

Figure 4-12. Design Wizard - Attributes.
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r In the Attributes window shown on figure 4-12 enter required symbol
reference letter and symbol comments.

r Click on the Next> button.
r Click on the Finish button in the final Design Wizard window.
r A new window opens, and displays the previously entered symbol pins

at the left and right edge of the schematic sheet. Enter the schematic
design and connect to the I/O pins.

r Click on the Save option in the File menu. This updates the macro
for future use on schematic sheets. However, the existing symbols
will not be updated by the save operation.

Instead of drawing a schematic inside an empty symbol, you can assign
to an empty symbol a ready-made design netlist by selecting the Assign
Netlist option from the Hierarchy menu and clicking on the empty sym-
bol. The Netlist Conversion window (Figure 4-13) allows selecting the
desired netlist. The imported netlist will be automatically converted into
a schematic if the Schematic check-box in the Netlist Conversion win-
dow has been selected.

Hierarchy Errors
The hierarchical designs are checked for hierarchy errors such as circular
macros. The circular hierarchy structure means that one of the macros in
the design uses some hierarchical symbols that include itself. When the
hierarchy error is reported, you have to analyze your design in the Hier-
archy Browser and make the necessary corrections.

Figure 4-13. Netlist Conversion Options.
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Hierarchy Menu Options Summary

r Add Sheets to Project - Opens a window for adding schematic files to
the current project

r Add Current Sheet to Project - Adds a sheet to the current project
r Create Macro Symbol From Current Sheet - Converts schematic sheet

into macro symbol.
r New Symbol Wizard - creates a schematic or an empty macro symbol
r Hierarchy Push - selects the Push mode (activates the H cursor) for

navigating hierarchical schematics.
r Hierarchy Pop - allows exit from the current hierarchical level.
r Import Netlist - Creates a macro from any netlist file
r Assign Netlist - Downloads a netlist into an existing symbol and cre-

ates a macro from the existing schematic symbol

Example of Hierarchical Design
The following is a step-by-step process which explains how to create and
use the hierarchical designs in ACTIVE-CAD. To better explain hierarchi-
cal designs, a simple design will be created and simulated interactively.
For simplicity, only TTL components will be used for the schematic.

Step 1. Create a new project called MACROS.

Click on the New Project icon in the Project Manager. When the
New Project window appears, type MACROS in the Name field, select
ALDEC project Type, and click the OK button or press Enter.

Figure 4-14. Hierarchy menu.
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Step 2. Select the TTL library for the project.

Select the Project Libraries option in the schematic File menu. In the Li-
braries window select the TTL library from the Attached libraries list
and click on the Add button. The TTL library will be added to the Project
Libraries list. Activate the Close button to exit the Libraries window.

Step 3. Create the MACROS1 schematic.

Click the Symbols toolbox icon. When the SC Symbols toolbox ap-
pears, select the 7400 symbol. Next, draw the schematic in Figure 4-15, in-
cluding input terminals INA, INB, INC and output OUT. Save the
schematic using the Save option in the File menu. The schematic will
automatically be named by ACTIVE-CAD as MACROS1.

Step 4. Create the MACROS1 Symbol.

Select the Create Macro Symbol From Current Sheet option within the
Hierarchy menu. The Create Symbol window in Figure 4-7 should dis-
play the symbol name MACROS. Click on that name and change it to
ONE. This will be the name of the hierarchical macro symbol. In the In-
put pins section there should be a list of pins: INA, INB and INC. The
output pin name should be OUT. Note that only I/O terminals are recog-
nized as pins for the symbol. Click on the OK button. The netlist and the
MACROS1 schematic will be saved in the project library and a graphical
symbol will be created automatically.

Note that the newly created symbol can be named differently from the
schematic itself. For example, the schematic in Figure 4-15 is called MAC-
ROS1, but the new symbol created from that schematic is called ONE.
Upon successful macro generation, a message window will be displayed
and you will be asked if you want to continue editing the macro sche-
matic. If you answer No, the schematic will be closed.

Figure 4-15. MACROS1 schematic.
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Step 5. Create the second schematic (MACROS2).

Click on the New Schematic icon or select the New sheet option from the
File menu. A new schematic MACROS2 will automatically be opened.
Draw the schematic shown in Figure 4-16. Remember to use as input ter-
minals D, CLK and RST and call the output terminal OUT. Save the sche-
matic using the Save option.

Step 6. Create symbol MACROS2.

Select the Create Macro Symbol From Current Sheet option within the
Hierarchy menu and in the Create Symbol window change the Symbol
Name from MACROS to TWO. Then click on the OK button. The new
symbol TWO will be created and placed along with the schematic in the
MACROS library.

Step 7. Create new sheet for top level.

Click on the New Schematic icon or select the New sheet option from the
File menu. A new schematic MACROS3 will be opened. Draw the sche-
matic shown in Figure 4-17. Typing ONE in the bottom line of the SC
Symbols toolbox, will highlight the item for selection. Place two copies
of that symbol, which are automatically called H1 and H2, on the sche-
matic. Similarly, place two copies of the TWO symbol on the schematic.
They will automatically be called H3 and H4 (Figure 4-14). Interconnect
the symbols as shown in Figure 4-17.

Figure 4-16. MACROS2 schematic.
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Step 8. Use Push/Pop option to view schematics.

Select Hierarchy Push option within the Hierarchy menu or press
Ctrl+H. A cursor with the letter H will appear. Point the cursor at the
symbol H1 and double-click the mouse button. The schematic ONE will
open, showing internal design of the symbol H1.

Step 9. View the Project Contents.

Switch to the Hierarchy Browser (in Project Manager). Notice that the list
of sheets is now showing the top level schematic and four sub-levels
(H1..H4). Double-clicking on any of these schematic names will open the
desired sheet.

Step 10. Edit the hierarchical levels

The schematics displayed in the Step 8. and 9. can be directly edited. Use
the File|Save option to save the changed macro and update all schemat-
ics.

Figure 4-17. Top level schematic.
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Chapter 5

Schematic Menu Reference

This chapter describes the menu options and commands in detail.

File Menu

New sheet
The New sheet command creates a
new sheet for editing. The new
sheet name consists of the project
name and sequential page number,
which is automatically added to the
project name. To create a schematic
sheet that does not belong to the
project, use the Scratchpad option
in the File menu in Figure 5-1.

Figure 5-1. File Menu.



Open Sheet

The Open option in the File menu allows loading any schematic sheet in
the current project for viewing and editing. Clicking on the Browse but-
ton in the Open window displays Figure 5-2, which allows loading sche-
matics from another projects. The loaded schematic is in the viewing
mode and cannot be edited till it is added to the current project. To do so,
click on the Add Current Sheet to Project option in the Hierarchy menu.

NOTE: Opening a schematic file or browsing a schematic does not ap-
pend it to the current project. To append it to the project, you must click
on the Add Current Sheet to Project option in the Hierarchy menu.

Scratchpad
The Scratchpad option allows creating a schematic that are outside the
current project. A scratchpad schematic cannot be simulated until it is
added to the project resources.

To add a scratchpad schematic to the project, select the Add Current
Sheet to Project option from the Hierarchy menu. When a prompt win-
dow appears, enter the sheet name and exit.

Close
The Close option closes the currently active schematic window. If the
schematic sheet in this window has been modified you will be prompted

Figure 5-2. Open Sheet Allows Loading A Schematic.
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to save the changes before the schematic window is closed. The Close op-
tion does not affect the project contents, and if the schematic was a part
of the current project it will still be included in the netlist when it is gen-
erated. To delete a sheet from the project, use the Delete Sheet From Pro-
ject option in the Hierarchy menu.

Close All
The Close All option closes all active schematic windows. If the sche-
matic sheets in any of these windows have been modified, you will be
prompted to save the changes before the schematic windows are closed.

Save
The Save option saves only the active sheet. If the Save button is gray,
the active sheet has either been saved (no new changes) or is not a part of
the current project. If a name has not been specified for this sheet, you
will be prompted to select the sheet name.

Save As
The Save As option allows making an extra copy of the active sheet and
saving it under a new name. This option allows for having different ver-
sions of similar sheets.

Save All
The Save All option saves all opened schematic sheets and the Schematic
Editor settings. The settings are also automatically saved upon exit.

Project Manager
This option displays the Project Manager window and allows opening
new projects, etc. (see Project Manager Section in Chapter 1).

Project Libraries
This option is used (ACTIVE-CAD requires that all schematic wires be
electrically correct at all times). for selecting libraries for the current pro-
ject (see Library Manager Chapter).
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Update Libraries
If a symbol is modified while a schematic sheet is open, the changes will
be stored in the schematic database when the Update Libraries option
is selected, or the schematic is closed and then opened again.

Go to Simulator
This option passes control to the Simulator window. If the Simulator is
not running, it is launched and loaded with the current design.

Import
This menu allows importing symbols and schematics from other EDA
tools, after which the imported schematic designs will look like the origi-
nal designs. You will be able to mix the original vendor symbols with the
ACTIVE-CAD symbols in the same schematic. In addition, they will op-
erate with the on-line background simulator in real-time mode.

Import OrCAD symbols

This option allows importing symbols saved in the OrCAD ASCII for-
mat. To import an OrCAD library from OrCAD, you need to decompile
it with the DECOMP program from OrCAD. The resulting text file can
then be imported into ACTIVE-CAD using the Import/OrCAD Symbols
option in the File menu ( Figure 5-3).

Click on the Select OrCAD (ASCII) library button to browse disks and
select library files. ACTIVE-CAD will display a list of symbols found in
the library file. If the library is very large, you can use the Filter button to
specify a mask for the listed symbols (e.g. *574). To view the symbols be-
fore importing them into ACTIVE-CAD, use the View Symbol and View
Next buttons.

To import all symbols, press the Put All button, or select the desired sym-
bols from the list in Figure 5-3 and press the Put Selected button. The se-
lected symbols will be placed in the current project library. You can then
use the Library Manager to copy them to other libraries and the Symbol
Editor to edit these symbols.

The appropriate ACTIVE-CAD libraries must be selected to the current
project before importing symbols. This will attach the appropriate models
to imported symbols. Otherwise, the imported schematics will have
empty symbols and will not simulate.
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Import PADS Symbols

The Import/PADS Symbols option in the File menu imports graphical
symbols from the PADS Logic schematic editor. Before you can import
PADS symbols you need to convert them to ASCII format using the AS-
CII OUT option in PADS Logic. The files with the *.PT and .*PD exten-
sions need to be converted to *.PTA and *.PDA, respectively.

Import EDIF Symbols

This option imports schematic symbol libraries from other schematic cap-
ture programs that have EDIF 2.0.0 export capabilities. Using the Import/
EDIF Symbols option in the File menu, you can import EDIF symbol
files. The imported symbols will be added to the current project directory.

Import ViewLogic Symbols

This option imports symbol libraries from the ViewLogic schematic edi-
tors. The imported symbols will be added to the current project directory.

Import OrCAD ® Schematics
After the OrCAD symbols have been imported, you can convert OrCAD
schematics into ACTIVE-CADdatabase. This option converts OrCAD
passive schematics into ACTIVE-CAD active schematics for direct inter-
active design analysis in conjunction with the on-line logic simulator.

Figure 5-3. Import OrCAD Symbols.
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NOTE: Import OrCAD Schematic is an add-on option. A keylock is
needed to enable this option in the Schematic Editor.

The Import OrCAD Schematic option allows importing OrCAD sche-
matics in their native format (binary schematic files).

F Before you import an OrCAD schematic, you need to import all its
symbols using the Import/OrCAD Symbols option.

To import an OrCAD schematic, do the following:

1. Determine which libraries are used in your OrCAD schematic. These li-
braries have to be imported into ACTIVE-CAD, so that the graphical
symbols will look the same as in OrCAD. Convert all the libraries, which
have been used in the OrCAD schematics, with the DECOMP program
that comes with OrCAD schematic tools. For example, to convert the
TTL library use the following command:

DECOMP TTL.LIB TTL.F
This creates an ASCII TTL.F file, which contains all symbols from the Or-
CAD TTL library. Use a similar command for other OrCAD component
libraries.

2. Create a new project in ACTIVE-CAD. To allow the imported symbols
to be assigned to ACTIVE-CAD models, select all libraries in ACTIVE-
CAD that contain models used in your OrCAD schematics. These librar-
ies will be used to assign simulation models to the symbols used in your
OrCAD schematics (during the import process). For example, if you use
the TTL symbols in OrCAD, add the ACTIVE-CAD TTL library to the
current project, using the Project Libraries option within the File menu.

3. Invoke the Import/OrCAD Symbols option in the ACTIVE-CAD sche-
matic File menu and import all OrCAD decompiled library files that will
be used in the current project. This option allows importing all symbols
from the OrCAD library or just selected symbols. Make sure that you im-
port all of the symbols that are used in your OrCAD schematics. During
this conversion, ACTIVE-CAD will restore the graphical symbols from
the decompiled OrCAD library, and assign to them the simulation mod-
els from the ACTIVE-CAD library.

4. Import the schematic using the Import OrCAD schematic option.
ACTIVE-CAD restores all electrical connections based on the graphical
wires in the OrCAD schematic. If some of the wires are not electrically
connected to device pins or labels, they will be converted into non-electri-
cal graphics and shown as light blue lines. You can then manually cor-
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rect these wires into ACTIVE-CAD electrical wires and complete the
schematic.

NOTE: If you are importing a 32-bit OrCAD schematic into ACTIVE-
CAD, you first need to convert these files into the 16-bit format, using the
conversion software provided by OrCAD.

Import EDIF schematic

You can import a schematic drawings from other schematic capture pro-
grams like Mentor Graphics, Cadence, Viewdraw, which can output a
schematic drawing file in the EDIF 2.0.0 format. The EDIF file must con-
tain not only the netlist information but also the symbols and wires
graphics. The Import/EDIF Schematic option loads and converts the
EDIF file into ACTIVE-CAD schematic. After the conversion, you can
save the schematic using the Save As option in the File menu.

Import ViewLogic schematic

You can import schematic drawings from ViewLogic schematic capture
programs like PowerView and Pro Series. The Import/ViewLogic Sche-
matic option loads and converts the ViewLogic ASCII files directly into
ACTIVE-CAD schematic. After the conversion, you can save the sche-
matic using the Save As option in the File menu.

Export
This option allows exporting ACTIVE-CAD schematic designs to other
popular standards, such as EDIF and DXF (Autodesk). This option is
used for storing designs in the company standard format and for further
processing by other EDA tools.

NOTE: You must generate the design netlist file before using the Export
options.

Export Schematic to EDIF

To export schematics into other schematic capture programs, that have
EDIF import capability, use the Export/EDIF schematic option in the File
menu. Clicking on this option, opens a special window for selecting the
design source file. The resultant EDIF file is stored by default in the PRO-
JECTS directory.

Export Schematic to DXF

Clicking on the Export/DXF option, opens special window for selecting
the design netlist file to be exported. The resultant DXF file is stored by
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default in the PROJECTS directory. The DXF format has no provision for
storing complete electrical information. Once you export the design in
the DXF format, it cannot be used to recover the electrical design proper-
ties. You must keep a duplicate design file in the ACTIVE-CAD or EDIF
format for the backup purpose. The DXF format is used by some compa-
nies for archival purposes.

Print
The Print option (Figure 5-4) allows making hard copies of the schematic
sheets on the selected Windows output device (printer or plotter). Note
that the output device has to be installed in the Windows system with an
appropriate device driver. For information on installing printers or plot-
ters in the Windows, refer to the Windows Users Guide.

The Print window activates printing of the Current Sheet or All Project
Sheets. It allows printing multiple copies of the schematic by changing
the number in the Copies: field. The 4 Page Tile option prints a sche-
matic sheet on four pages for greater detail. The Fit to Page option will
scale the schematic sheet to a single page. If you have multiple printers
or plotters installed, specify the output device in the Printer Setup op-
tion, which can be activated from either the File menu or the Setup but-
ton in the Print window in Figure 5-4.

Figure 5-4. Print Dialog Box.
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Printer Setup
The Printer Setup option (Figure 5-5) allows select ing a printer or plot-
ter as the current output device, and setting the device specific options,
such as Landscape or Portrait.

Page Setup
ACTIVE-CAD has a default page setup, including Frame, Ruler and
Sheet Format. You can change this setup using the Page Setup option
(Figure 5-7), which allows to specify:

r Frame on - If checked, a border is placed around the schematic when
it is printed.

r Vertical Numbers - If checked, the vertical zones are 1,2,3 and the
horizontal zones are A,B,C. The number of zones can be set using the
Horizontal and Vertical Zones fields. These options are active only if
References is selected as the Ruler type.

r Sheet Format - selects the sheet size(A-E) and orientation (Portrait
or Landscape)

Ruler - allows specifying the coordinate system of the cursor coordi-
nates that are displayed in the upper left corner of the main Schematic
Editor window. Ruler Metric will display millimeters, Ruler English
will display inches, References will display the zone numbers as speci-
fied in the Horizontal and Vertical Zone fields. The Y Axis Up option
controls the direction of vertical zone numbers.

Figure 5-5. Printer Setup Window.
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Table Setup
The Table Setup option is used for
configuration of the the design table
(also called title block by some) that
is displayed and printed in the bot-
tom-right hand corner of each sche-
matic sheet. You can select the
desired logo graphics file to be dis-
played in the design table.

Figure 5-7. Page Setup Window.

Figure 5-6. Table Setup Window.
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NOTE: The logo file has to be in the Windows Metafile format without
the header . A Windows Metafile can be created with programs like
CorelDraw.

Exit
The Exit option exits the Schematic Editor. You will be prompted to save
all modified and un-saved schematic sheets. If the simulator is active, ex-
iting the schematic editor will automatically disconnect the simulator-
schematic link. After closing the Schematic Editor, the simulator will
continue to operate as a stand-alone application.

Edit Menu

Undo and Redo
All editing operations are recorded so that you can undo the last
changes, in case you made a mistake. The Undo option will undo all op-
erations since the last change of editor mode. The Redo option restores
the Undo changes (it undoes the Undo option).

Cut
The Changes mode allows selecting a group of items for editing. The Cut
option deletes the selected group from the schematic and places it in the
clipboard. If the selected items are connected to other components on the
schematic, the connecting wires will also be deleted. However, the wires

Figure 5-8. Edit Menu.
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within the group will stay intact. The items in the clipboard can be
placed in another part of the same schematic or on another sheet using
the Paste command. You can view the items in the clipboard using the
Show clipboard option.

Copy
The Copy option is similar to the Cut option, but it does not delete any-
thing. Copy places the selected group of items in the clipboard but does
not delete them from the schematic.

Paste
The Paste command places the items from the clipboard into the current
schematic.

Delete
The Delete option removes the selected group of items from the sche-
matic. This function can also be performed by pressing the Del key. The
deleted items are not placed in the clipboard and can be restored only by
using the Undo operation.

Deselect All
The Deselect All option deselects all items previously selected for edit-
ing. You can also deselect all items by clicking with the left mouse button
on any blank schematic area.

Show Clipboard
The Show Clipboard option is used to display the clipboard, which will
contain the last cut or copied item. You can edit the clipboard schematic
the same way as a regular schematic after you add it to the current pro-
ject (Hierarchy|Add Sheets To Project option) or after you paste it on
the current schematic sheet.

To add the clipboard schematic to a schematic sheet, select the
Edit/Paste option.
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Export Clipboard
The Export Clipboard option saves the contents of the clipboard as a
schematic file. This file can later be loaded for editing as a regular sche-
matic file.

Import to Clipboard
The Import to Clipboard option loads the selected schematic file to the
clipboard. This schematic can then be added to any other schematic us-
ing the Paste command.

Clicking on the Import To Clipboard option displays the Import To
Clipboard window. Double-clicking on the Projects directory in the Di-
rectory field displays all schematic sheets in the File Name field. Double-
clicking on any of these schematic sheets will automatically transfer it to
the clipboard.

Redraw Wires
The Redraw Wires option redraws every wire connected to the selected
symbol. Using this option (or Ctrl+W keyboard shortcut) is suggested
when wires look untidy after moving the symbol.

Autorouting Table
This option is described in the Automatic Table Driven Connections section
of the ACTIVE-CAD Schematic Editor chapter.

Mode Menu
The Mode menu directly corre-
sponds to the schematic tool bar.
You can use either one to switch to
the appropriate mode.

Figure 5-9. Mode Menu.
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Options Menu

Create Netlist
The Create Netlist option generates a binary netlist file that can be con-
verted to one of the ASCII formats such as Future Net, PADS, Schema,
etc. The binary netlist is used to link the Schematic Editor with its back-
ground Simulator when the Simulator is opened for the first time.

The netlist is stored with the project file and is updated every time you
invoke the Simulator while editing a schematic. If you start the Simulator
without the Schematic Editor active, you need to make sure that the
netlist is up to date.

The Create Netlist option connects all sheets specified in the project con-
tents. If any errors are detected, you will be notified about the location
and type of error. Examples of netlist errors are: duplicated parts and ter-
minal names, and unnamed components. Most of the electrical errors are
checked while you draw the individual schematic sheets. The errors de-
tected during the netlist generation are related only to the multiple sheet
connections, which are not detected when individual sheets are drawn.

Integrity Test
The Integrity Test option performs a comprehensive analysis of the pro-
ject netlist. It does not create a netlist but shows all design errors such as
electrical violations and design inconsistencies.

Figure 5-10. Options Menu.
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Export Netlist
The Export Netlist option allows you to create an ASCII netlist in one of
the following formats:

r SUSIE ASCII (SUSIE 6)
r CALAY
r CUPL
r EDIF 2.0.0
r FUTURENET
r INTUSOFT SPICE
r LATTICE
r MASSTECK ASCII
r MENTOR
r PADS
r P-CAD[*.NDE]
r P-CAD[*.ALT]
r QUICKLOGIC
r RACAL-REDAC
r SCICARDS
r SPICE
r TANGO
r XILINX

Clicking on the Options|Export Netlist option opens the Export Netlists
window. Select the netlist file to be exported from Input Netlist field,
and the format of the exported netlist from the To Format field. All pro-
ject netlist files have the .ALB extension. The exported netlist will be writ-
ten to a file with the same base name as the project netlist and with an
extension name that corresponds to the selected export format. It will be
placed in the same directory as the project netlist. The Flat option allows
you to flatten the hierarchical designs. Otherwise, a separate netlist is cre-
ated for each hierarchical macro, and the project hierarchical netlist will
be comprised of top level netlist having the projects name and individual
netlists for each hierarchical macro.

Update Simulation
After the Schematic Editor and the background Simulator have been run-
ning for a while, and numerous changes have been made, the system can
start to slow down and memory allocation can become less efficient,
since changes are saved incrementally. The Update Simulation option
optimizes the interactive design changes by performing the following op-
erations:
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1. Saving Test Vectors and simulation results.
2. Saving the current schematic.
3. Creating a new netlist and loading it to the simulator.
4. Loading test vectors and previous simulation results.
5. Restoring and updating schematic probes.

After this procedure is performed, ACTIVE-CAD will operate faster and
more memory will be available in the system.

Annotate
Clicking on this option displays the Annotation window allows sequen-
tial renumbering of all project components. All schematic sheets are af-
fected, including the closed ones but included in the project contents. For
more details refer to the Annotation in the Placing Symbols section of
Chapter 2.

Symbol Editor
This option loads the Symbol Editor program which is described in more
detail in the Symbol Editor Chapter 6.

PCB / Export Parts and Nets
The Export Parts and Nets option is used to load schematic designs into
PCB layout programs, using the IPC protocol (DDE). The PCB program
receives on-line all components and net information and therefore no file
transfer is necessary. If the PCB layout program is not active, the informa-
tion is exported to an audit file which can then be loaded into it off-line.

PCB / Import Back Annotation
The Import Back Annotation option is used to receive on-line ECO
changes from the PCB layout programs, via the IPC protocol (DDE).

PCB / Back Annotation
The Back Annotation option reads the back annotation files from the
PCB layout programs and updates the schematic. You can use the back
annotation files from Massteck, Racal-Redac, Schema, PADS, Tango and
PCAD. When you select a back annotation file, ACTIVE-CAD will up-
date changes such as pin swaps, section swaps, package, name and type
changes.
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PCB / Import from Audit File
The Import From Audit File option is used to load the changes recorded
by the PCB program to a file. The Audit files are used when the on-line
IPC interface is not efficient because of memory limitations or if the PCB
program runs on a different computer from the one with the schematic.

Bill of Material
The Bill of Material option generates reports about the components used
in your design. This report can be used for ordering parts for production,
cost calculations, etc. You can generate either an Engineering or Manu-
facturing Summary. The Engineering Summary produces a detailed de-
scription of the devices used, their location on the schematic, etc. The
Manufacturing Summary displays device stock numbers and other infor-
mation that is needed for procuring the parts.

Figure 5-11. Back Annotation Window.
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To create the report press the Create button in Figure 5-13. After the re-
port is created it can be printed or edited by pressing the Edit button.
This loads the report to the Windows Notepad, shown in Figure 5-12.

Figure 5-13. Bill of Material Window.

Figure 5-12. Editing Bill of Material Report.
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Report
The Report option allows exporting design information in the ASCII for-
mat. This file can then be used with any database or spreadsheet pro-
gram to create a customized Bill of Material report. For example, you can
create a bill of material using the Microsoft Access software. You can se-
lect the attributes that you want to export and their order, as shown in
detail in Figure 5-15 .

List Connectors
The connectors from the SC Symbols toolbox are placed separately on
the schematic. To generate a summary of all connector pins, use the List
Connectors option (Figure 5-15).

Figure 5-15. Creating Report File.

Figure 5-14. List Connectors Window.
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Hierarchy

The Hierarchy menu is described in detail in the Managing Schematic De-
signs chapter.

View Menu

The View menu enables and disables the following items:

r Status Line with the current cursor position and messages
r Ruler display along the top and left side of the window

Figure 5-17. Hierarchy Menu.

Figure 5-16. View Menu.
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r Table with the design information table, at the schematic bottom
r Graphics (circles, lines, comments, etc.)
r Symbol Text (pin names and numbers)
r Probes on/off control (logical states display)
r Beep for illegal editing operations
r Cross-Hair Cursor (very large cross-hair cursor)
r Grid (grid display on the schematic background)
r Bus Display for selecting the bus display format (hex, binary, etc.)

Preferences
The Preferences menu options allows you to customize the look of the
schematic editor windows. You can select any window element and set
the font, line style, color, or enable / disable options. Some users refer to
these options as the Edit Library.

Colors
The Color Settings window (Figure 5-18) allows selection of colors for
different schematic objects. Each schematic element is listed in that win-
dow. Clicking on any of these items displays its current color setup in the
bottom right-hand corner. To change this color, click on the appropriate
button in the Color field. The fields Red, Green and Blue allow for pre-
cise tweaking of the colors by regulating the amount of these basic colors
in the selected (by the Color button activation) color.

Figure 5-18. Color Preferences window.
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Upon completing the color setup of the schematic element, click on the
Apply button. You can save the current settings to a file using the Save
Scheme button. To restore the proprietary color setups, click on the Load
Scheme button. Exit the color setups by clicking on the Close button. If
you click on the Cancel button, ACTIVE-CAD will ignore your current
setups and will return back to the previous color setups.

Screen background color

The Background Color field in Figure 5-19 allows you to select some ba-
sic background colors used in the industry. Always start your color selec-
tions with the background color because it affects the readability of all
other colors on the schematic sheet.

Symbol colors

ACTIVE-CAD has some default colors for various symbols:

r a black symbol indicates that it has a built-in (C) model
r blue denotes a symbol that has a simulation (VHDL) model
r a brown symbol outline indicates an empty symbol

To restore the default colors set at the factory, click on the Default button.

Text
You can assign different font sizes and attributes to selected text items
with the help of the Text Settings window. Figure 5-19 shows the avail-
able settings.

Figure 5-19. Text Preferences window.
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Customizing the font size

ACTIVE-CAD has three (3) font sizes: small, medium and large. You can
assign any of these fonts to pins, symbol names and reference numbers.
The height of the small, medium and large fonts (expressed in pixels) for
the entire schematic is set in the Define Font Sizes window (Figure 5-23)
invoked with the Define Font Sizes button in the Text Preferences op-
tion.

Minimal visible font size

As you rescale the schematic drawing, the fonts change in height and at
some point they may become unreadable and obstruct the drawing. To
avoid this, you can set the minimal visible font size by selecting the Mini-
mal Visible Font Size option in the Define Font Sizes window.

NOTE: Set the Minimal Visible Font Size to a lower value when your
display does not show the text in small zoom scales. The typical setting
is between 5 and 11, and depends upon your display card resolution.

Display
The Display Configuration window (Figure 5-21 ) allows controlling the
appearance of the Status Window and Ruler marker.

Figure 5-20. Setting the schematic font
sizes.
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Grid

The schematic grid can be helpful when you draw wires and place sym-
bols. It allows you to align the schematic elements with the horizontal
and vertical lines displayed in the background.

The Grid Configuration (Figure 5-23) window allows you to turn the
grid on and off, and set the spacing and style. To activate or de-activate
the grid, use the Grid Active check box. The snapping of the drawn ele-
ments to the grid will take place independent of whether the grid has
been selected for display.

Figure 5-21. Display Configuration Window.

Figure 5-22. Schematic Grid.
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To choose the grid resolution, select the appropriate grid Step by editing
the Step field or using the up and down arrows. The resolution in inches
is determined by multiplying the number of grid steps by 0.025". So a
Step of 3 will result in a resolution of 0.075". Since the smallest Step you
can enter is 1, the smallest grid resolution is 0.025 inches.

The Grid Style allows you to select either Points (dots), Cross or Grid.
Choose the grid that is most suitable for the work you do. The Grid Con-
figuration can be used to enable and set the minimum distance between
the wires. By default, the minimum distance between wires is 1/8" and
can be increased by the user.

Wires & Buses
The Wires & Bus Settings window allows you to set the preferred op-
tions for drawing wires and buses on the schematic.

Wire Line Style

This option allows you to select either Thick, Solid, Dash, Dot, Dash
Dot or DashDotDot line style for single wire connections. Since the most
popular setup is Solid for individual wires, this is the default ACTIVE-
CAD setup. However, you can use any other wire style.

Wire Line Width

You can set the width of single wires on the schematic to suit the com-
pany policy and/or your preferences.

Junction Size

It is used for determining how big will be the wire junctions.

Figure 5-23. Grid Configuration
Window.
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Junction Type

It allows to select either square or circle wire junctions.

Bus setups

Use the Bus Line (line thickness) and Bus Tap Type (geometry) options
to set the specification for all buses. You can dynamically change the tap
geometry on the schematic but the bus line thickness can be changed
only from this window.

Orthogonal Wires

This option forces all lines to be drawn at right angles, which is a stand-
ard with electrical schematics. The Orthogonal Wires option should be
turned on ( checked) for all schematics, unless special conditions prevail.

Autorouting

ACTIVE-CAD is an advanced schematic editor which has an autorouting
feature. This feature may save you in excess of 50% of time when draw-
ing complex drawings with extensive wiring. Since the autowiring algo-
rithm may take a long time in a cramped schematic area, you may wish
to terminate it and complete some wire segments manually.

The Autorouting Timeout option allows you to set the time for the
autorouting algorithm to terminate. Typical user setups are between 6
seconds to 10 seconds.

General
The General Settings window in Figure 5-26 is used for controlling some
of the basic operational modes of the schematic editor and simulator.

Figure 5-24. Wires and Buses Preferences.
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Allow symbol Overlap

ACTIVE-CAD by default allows overlapping of symbol outlines. By
unchecking the Allow symbol overlap option, you will not be able to
place new symbol if its outline overlaps with the other outline.

Interactive simulation mode

ACTIVE-CAD operates by default in the interactive schematic-simulator
mode, which means that you do not need to generate a netlist each time
you modify the schematic because the simulator database is updated in-
crementally with each design entry. If you disable the interactive simula-
tion mode, you need to activate the Update Simulation option in the
Options menu before again invoking the simulation process.

Defer to Audit File

This option saves all schematic changes to an audit file with the AUD ex-
tension in the project directory. These changes are in the ECO format and
they include operations like add symbol, delete symbol, add connection,
add net name, etc. These changes can be used for automatic forward an-
notation of PCB designs and for documentation purposes.

NOTE: Select the Defer To Audit File option if you need to keep track of
all new design changes that need to be added to the current p.c.b. layout.

Automatic Backup

By default, all edited schematics are saved to a backup file every 5 min-
utes. The backup files have the .BSC extensions. You can change the set-
ting for automatic backup from 0 seconds (no backups) to saving designs
every 60 minutes.

Figure 5-25. General Preferences
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Simulation step

The ACTIVE-CAD schematic editor has a patented on-line background
simulator. The operation of this simulator can be controlled from the
Probes toolbox, which has a Step button for controlling the duration of
the simulation process. The Simulation step option allows to set the du-
ration of the simulation step from 1 nanosecond to 999 nanoseconds.

Controlling schematic graphics

The General Settings option has five (5) parameters that control the sche-
matic graphics, including symbol outline thickness and type:

r Symbol Line Style controls the thickness of the symbol outline and its
pins. It can be set and reset at any time during schematic editing and it
has instant effect on all schematic symbols.

r Graphics line Style controls the line style in the graphics mode, acti-
vated by the button 14 in Figure 2-1.

r Symbol Autobox Width sets the thickness of the hierarchical blocks
outline. It does affect the symbols from the system library or made in
the symbol editor.

r Thick line width is used for controlling the width of the lines drawn
in the graphics mode, activated by pressing the button 14 in Figure 2-1.

Save Settings Now
The Save Settings Now option saves all schematic settings and window
sizes to the SUSIE.INI file.

Save Settings on Exit
The Save Settings on Exit updates the schematic parameters and settings
when exiting the program. When this option is on, the current window
sizes and preferences are saved in the SUSIE.INI file.

Status line
The Status line displays the current position of the cursor and schematic
editor messages. This line can be disabled to allow more space for the
schematic sheet.

The Status Line aids you in understanding what the schematic editor is
doing or will do. You need to have this line enabled when adding bus
taps, performing autorouting and similar time consuming operations.
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Ruler
The Ruler can be disabled to allow more space for the schematic sheet.
The ruler settings are available in the Page Setup window, which is acti-
vated by clicking on the Page Setup option in the File menu. You can set
the ruler to English, Metric, References and None. If the Ruler option in
the View menu does not display any ruler or displays the wrong ruler,
check the Page Setup window for the actual ruler setups.

The ruler marker is selectable from the View/Preferences/Display op-
tion. When selected, this option displays the Display Configuration win-
dow which allows you to set the ruler marker to either Diamond, Stroke
or None.

Table
The design table is enabled by default because it is required by most cor-
porations. The table, which is located in the bottom-right hand corner of
the schematic sheet, typically contains the company information and
logo, the project or design name and sheet number. If the table is not re-
quired, you can disable its display. The design table contents is specified
in the Table Setup window of the File menu.

Graphics
You can disable the graphics and text display to speed redraw of a sche-
matic. All existing graphics or text items will show up on the screen only
if you enable this option again.

The Graphics option in the View menu enables the buttons of the Graph-
ics toolbox, activated by pressing the button 14 in Figure 2-1. If the
Graphics option in the View menu is inactive, you will not be able to
draw any graphics elements on the schematic, except for the text.

Symbol Text
Symbol Text, such as part names and types, and pin names and num-
bers, are displayed as long as the zoom is large enough to clearly display
the fonts. By using the Symbol Text option, you can disable the text dis-
play, and thus save time when redrawing a design.

The size of the text is set in the View|Preferences|Text option, which ac-
tivates the Text Setting window. You can assign to each text type a spe-
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cific font category (small, medium and large) and exactly control its size
with font adjusting buttons.

You can control the minimum visible font size by adjusting the font size
in the Minimum Visible Font Size field, located in the Define Fonts
Sizes window. This window is activated by clicking on the Define Font
Sizes button in the Text Setting window (activated by the View|Prefer-
ences|Text option).

NOTE: Do not set the minimum visible font too large because symbols
may loose their text. The recommended minimum font size is 5.

Probes
When the simulator is active, all selected simulator probes and stimula-
tors are displayed next to the pins and I/O terminals. By selecting the
Probes option, you can toggle on/off the display of these probes.

Scanner

The Scanner option allows you to simultaneously view the entire sche-
matic in a smaller window superimposed over the original schematic.
The Scanner window, shown in Figure 5-26, has an extra scroll bar at the
top that can be used to set the scaling factor for this secondary display
window. This bar allows you to minimize and enlarge the schematic
view. This is very useful while editing large schematic sheets because

Figure 5-26. The Scanner Window.
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you can view the entire sheet in the Scanner window and edit details in
the primary schematic window.

The scanner can also be used to magnify the schematic areas. The scan-
ner is only for viewing the schematic designs and you cannot edit the
scanner schematics.

Move Scanner
The Move Scanner option allows select the scanner display area . When
you select Move Scanner, a rectangle representing the scanned area is fol-
lowing the cursor. Click the mouse to select the section to be moved into
the Scanner window. You can set the scanner window to enlarge or re-
duce the schematic scale.

If needed, the Scanner window can be moved outside of the main sche-
matic editor window.

Figure 5-27. Example of Magnifying Scanner Window.
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Display Menu
The Display menu (Figure 5-28) al-
lows you to display a schematic at a
desired scale and screen position.
Note that in addition to the menu
commands, you can use the dy-
namic zoom to select the block dis-
played in the window (described in
the section Viewing a Schematic in
Chapter 2). You can also use the
scroll bars to scroll the schematic
horizontally and vertically.

Zoom In and Zoom Out
The Schematic Editor allows continuous scaling of the edited schematic
sheet, so that you can view it at any desired scale. However, for faster op-
eration you can use the Zoom In and Zoom Out options, which are
equivalent to the Zoom buttons in the schematic toolbar.

Full Page
Displays the entire schematic in the active window.

Previous Zoom
Returns to the previous zoom level.

Zoom Select
Quickly switches to one of the predefined zoom settings from 1:5 to 5:1.

Center
The Center option or the F9 key is used to select the central point of the
schematic window. When you select this option, a special cursor will ap-
pear. Pointing this cursor at a schematic location will move that location
into the center of the window. Note that the selected location will remain
in the center of the window, even if you change the scale using the Zoom
In or Zoom Out commands.

Figure 5-28. Display Menu.
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Redraw
The editor does not redraw the screen after every operation because it
would slow down such operations as editing, moving and dragging.
Parts of the screen can sometimes become unclear, so you need to peri-
odically redraw the screen to keep it free of spurious elements. To re-
draw the screen use the Redraw option or press the F10 key.

Window Menu

The Window menu allows you to arrange the schematic windows within
the main Editor window.

Cascade
The Cascade option arranges the windows so that they overlap, but you
can see all of the Window titles. The active window is on top. This allows
you to quickly select the desired schematic sheets.

Tile
The Tile option arranges the windows so that they do not overlap, and
they are approximately the same size. This arrangement of windows is
useful when several sheets need to be viewed at the same time.

Arrange Icons
The Arrange icons option allows arranging the minimized windows
icons in the main Schematic Editor window. This option arranges only
the minimized schematic windows and not the open or maximized ones.

Figure 5-29. Window Menu.
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Close All
The Close All option closes all schematic windows. You will be notified
about all modified but not saved sheets. Proceed with caution when us-
ing this option.
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Chapter 6

Symbol Editor

The Symbol Editor allows you to create new symbols and modify the ex-
isting ones. To invoke the Symbol Editor, double-click on the Symbol

Editor icon in the Project Manager toolbar or select the Symbol Edi-
tor option from the schematic Options menu.

Creating a new symbol
Select the Symbol Editor option from its icon or the schematic Options
menu. In response, the window in Figure 6-1 will appear. Selecting the
New option in the File menu, will display the New Symbol window
(Figure 6-2). This window lists all user libraries which can store the user
generated symbols.

NOTE: The user generated symbols cannot be stored in the system li-
braries provided on installation diskettes or CD ROM.

Figure 6-1. Symbol Editor First Screen.



The user designed symbols can be stored within projects and user librar-
ies, which can be created with the help of the Library Manager (Chapter 7).

To create a new symbol, enter the new symbol name in the Symbol field.
Clicking on a library name in the Libraries field will selects the new sym-
bol library name.

Next, click the OK button. In response, ACTIVE-CAD displays the Sym-
bol Editor window. The Symbol Editor window operations are de-
scribed in detail in the Editing an existing symbol Section, below. The
operations for editing an existing symbol and creating a new one are
similar.

Editing an existing symbol

Editing library symbols

Select the Symbol Editor option from the Options menu. When ACTIVE-
CAD displays the screen in Figure 6-1, select the Open option in the File
menu and the Edit Symbol window in Figure 6-3 will be displayed. This
window allows you to select for editing the desired part from any library
listed in that window.

Double-clicking on the library name in the Libraries field will list all li-
brary symbols in the Symbols field of Figure 6-3.

Figure 6-2. New Symbol Window.
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Double- clicking on the desired symbol in the Symbols field will acti-
vate the Symbol Editor window in Figure 6-4 and will display the se-
lected symbol. You can select a symbol for display in the Symbol Editor
window by clicking on the desired symbol in the Symbols field and then
clicking on the OK button.

Editing of schematic symbols

You can select any schematic symbol for editing in the Symbol Editor
window. First, select the Select mode and click on the symbol to be ed-
ited. The selected symbol will be highlighted by a red rectangular frame.
Next, select the Symbol Editor option from the Options menu. In re-
sponse, ACTIVE-CAD instantly displays the Symbol Editor screen in
Figure 6-4.

NOTE: You can edit any schematic or library symbol but you can store it
after editing only in the user library.

Figure 6-3. Open Symbol Window.

Figure 6-4. Symbol Editing Screen.
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Description of Symbol Editor Window
The following is a description of the Symbol Editor fields in Figure 6-4:

r Symbol - symbol name under which the graphical symbol is stored; it
can start with any character and can be up to 8 characters long.

r Library - name of the library in which the original symbol resides.
r PCB Footprint - name of the p.c.b. layout footprint that is used as the

default parameter when exporting a netlist to a p.c.b. program (e.g.
PADS, TANGO, P-CAD, Massteck).

r Ref. Prefix - default reference prefix, used for numbering parts placed
on a schematic, e.g. U, R, C, L, D, Q, etc.

r Sections - indicates how many sections the symbol contains. For exam-
ple, 7400 has four 2-input NAND gates,shown as separate sections.

r Description - describes the part function, e.g. 4Kx8 RAM, 2-input AND
gate, counter, J-K flip-flop, etc.

r Spice Model Info - analog simulation parameters.
r Pins - list of symbol pin numbers and the associated names.
r Graphical symbol display - the graphical display of the symbol in a

blue rectangular outline.
r Pin parameters - there are four fields above the graphical symbol dis-

play (Number, Name, signal type and graphical representation)
which display the key parameters of the selected pin.

Symbol Text Editing
Changing pin location

To change the pin location within the symbol, click on the desired pin in
the graphical symbol display, and holding down the left mouse button,
drag the desired pin to its new location. The edited pin is displayed in
red.

Changing pin numbering

To change the pin number, click on the desired pin in the graphical sym-
bol display area, and when the pin turns red, its number will appear in
the Number window. Place the cursor in the Number window and enter
the new pin number. The new pin number will instantly be shown on the
graphical symbol outline. Double-clicking anywhere in the graphical
screen area will make this change permanent.

Changing a pin name

To change the pin name, click on the desired pin in the graphical symbol
display area, and when the pin turns red, its name will appear in the
Name window. Place the cursor in the Name window and enter the new
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pin name. The new pin name will instantly be shown on the graphical
symbol outline. Double-clicking anywhere in the graphical screen area
will make this change permanent.

Changing the pin’s I/O designation

To change the pin’s I/O designation, click on the desired pin and when
the pin turns red, its current I/O designation will appear in the I/O field,
located to the right of the Name field. Click on this window to display
the I/O options like IN, OUT, OC, OE, etc. Select the desired I/O type
and double-click the mouse button anywhere in the graphical symbol dis-
play. The pin’s I/O type will be instantly updated in the pin list.

Changing pin graphics

To change the graphical pin display, click on the desired pin and when
the pin turns red, its current graphical name will appear in the window
to the right of the I/O field. Click on this field to display the graphical op-
tions like LINE (a straight line), CLK (a triangular clock marker), DOT (a
line with a circle), etc. Select the appropriate graphical pin repre-
sentation. Double-clicking anywhere in the graphical screen area will
make this change permanent.

Adding symbol pins

To add a new pin, either select the Add Pin option from the Body menu
or click on the Pin button in the Symbol Editor toolbox. This displays the
Add Pin window (Figure 6-5). Enter the pin name, pin number pin type
and pin shape in the corresponding fields in Figure 6-5. Pressing the En-
ter key or clicking on the OK button. completes the pin description entry.

Notice that following the pin data entry, the cursor is automatically
placed in the symbol outline and a red line is attached to the cursor.

Figure 6-5. Add Pin Window.
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Place the cursor at the desired pin location and click the mouse button.
The new pin is instantly anchored at the selected location.

If the symbol outline needs to be modified, place the cursor over the blue
symbol outline and when the double arrow cursor appears, press the
mouse button and drag the symbol outline in the desired direction.

NOTE: You can save the edited symbol only in the USER libraries. You
cannot save the edited symbol in the ACTIVE-CAD system (R/S) or
Read Only (R/O) libraries. If you attempt to save an edited symbol in
these libraries, ACTIVE-CAD will automatically issue the Save as prompt.

Pin editing options

ACTIVE-CAD allows typical Windows operations that make editing
pins an easier task. These options are available in the Edit and Body
menus of the Symbol Editor.

Undo - (Edit menu) cancels the last operation.
Cut - (Edit menu) deletes the pin and saves it to the clipboard.
Copy - (Edit menu) copies the pin to the clipboard without deleting it.
Paste - (Edit menu) places a pin from the clipboard.
Delete - (Edit menu) deletes the pin without saving to the clipboard.
Add - (Body menu) allows you to add a pin (Figure 6-5).

Editing Symbol Graphics
The Symbol Editor toolbox ( Figure
6-6) allows you to select between
various graphical elements such as
lines, arcs, circles and squares. In-
stead of the toolbox, you can also
use the Body menu to select the
graphics element such as lines, arcs,
circles and rectangles.

Figure 6-6. Symbol Editor
Toolbox.
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Before you start editing a symbol, you must set its size. Otherwise, if you
run out of space, you will be forced into extensive changes of the symbol.

The buttons of the Symbol Editor toolbox are described below. The corre-
sponding Body options are listed in Figure 6-7.

Entering pins

The PIN button activates pin editing window. You can enter the pin
name, pin number, pin type and pin shape. If you select the Repeat op-
tion, you will be able to place pins that have the same name but different
indexes. Also, the pin number will increment automatically.

Orthogonal lines

When you activate the Orthogonal Lines button button, all lines
will be drawn at the right angle. By clicking the mouse button at each cor-
ner, you will be able to draw more complex items.

You can edit only the area marked by the blue rectangle box. You must
adjust this area to suite your needs.

Circles

The Circles button activates drawing of circles. To draw a circle
click the mouse button inside the blue rectangle and drag the mouse cur-
sor. A red circle appears and grows as you move the mouse cursor away

Figure 6-7. The Body Editing
Options.
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from its initial position. Release the mouse button when the circle
reaches the desired size.

Arcs

The Arcs button activates drawing of arcs. Since arcs are based on
two reference points, click at the first spot and then at the second spot
and drag the mouse cursor. An arc based on the two spots will follow the
mouse. Adjust the arc size and shape by dragging the mouse. When the
desired shape has been created, release the mouse button.

Unrestricted lines

The Polyline button allows drawing lines at any angle. Click the
mouse button at each corner to anchor the line. Click the right mouse but-
ton to end the line editing.

Rectangles

The Rectangles button allows drawing rectangles. Click at one of
the corners of the rectangle and drag the mouse button to the opposite
corner of the rectangle. When the rectangle reaches the desired shape
and size, release the mouse button.

Graphical text

If there is a need for a non-electrical or graphical text, click on the
Graphical Text button. The text entered in this mode will have no bear-
ing on the electrical symbol features and will not be included in any sym-
bol data base, except for the graphics alone.

Do not use this text mode for naming pins, part numbers, etc., because
this information must be entered as electrical data. Text that you enter
with the other Symbol Editor options is automatically fed into the electri-
cal data base and can be used for electrical circuit analysis and documen-
tation.

Deleting graphics

To delete graphics items, select the Edit button, click on the selected
elements and when they turn red, press the Delete keyboard key.

Note: You can choose one of the three text sizes but you cannot change
the thickness of the lines, circles and arcs. These are controlled by the
ACTIVE-CAD schematic Preferences option.
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Symbol parameters
With today’s complexity of electronic designs, you must be able to assign
multiple electrical parameters to pins, devices, wires, etc. To assign pa-
rameters to symbols, select the Parameters option in the Parameters
menu.

In response, the Symbol Editor displays the Figure 6-8, which lists the
previously defined symbol parameters in the left-hand window. To edit
any of these parameters, select it with the mouse cursor and click the
Edit button. ACTIVE-CAD will display an editing window (Figure 6-8)
which will allow you to edit the current parameter name and its value. In
addition, you can change the parameter display conditions:

r Display All - displays both the parameter name and description
r Display Name - displays only the name of the selected parameter
r Display Description - displays the parameter description alone.

To add a new symbol parameter, click on the Add button. When the win-
dow in Figure 6-9 appears, enter the parameter name, its value and de-
fine the display conditions.

Figure 6-8. Editing Symbol Parameters
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The symbol pin parameters are entered directly in the schematic editor.
See Pin Parameters in the Editing Schematic Section (Chapter 2)

Testing symbols
The symbols can be as simple as a gate diode or as complex as 302 pin
grid ASIC. Since there can be many errors created in the process of sym-
bol editing, ACTIVE-CAD provides for quick verification of the symbol
integrity.

To check symbol integrity, click on the Test Symbol option in the File
menu or activate the Ctrl-T keyboard keys. The Symbol Editor will auto-
matically check for duplicate pin name and numbers, and similar items,
and will provide a list of errors. Always use this option before attempt-
ing to save a symbol.

Effective symbol editing
r Since editing graphics is the most difficult part of the symbol editing,

start with the graphics and draw the arcs and circles. No pins should
be added till the symbol graphics is perfect.

r Make the blue symbol outline as big as the screen. It will give you a
great freedom in moving pins around. You can always reduce the
symbol outline after the pins have been entered.

r Next, add the pins and their locations on the symbol body.
r Enter the symbol parameters. Decide their display modes carefully

so that they will not cramp the schematic display, but at the same
time they will provide all vital design information.

Figure 6-9. Adding New Symbol Parameter.
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r Plan the user library structure well in advance so that you will remem-
ber where to find the symbols.

r Always delete the wrong symbols or copy them to the junk library
for reference. Do not keep the current and outdated symbols to-
gether.

To save time on unnecessary editing, always start with a larger symbol
(blue rectangle) than expected because increasing the symbol size incre-
mentally is tedious and requires extra editing operations.

Symbol access priority
Sometimes you may have a hard time pulling a symbol to the schematic
screen. It may be listed in the library, yet it may not show on the screen.
The reason for that is that ACTIVE-CAD searches its symbol libraries in
the order in which they are listed in the Library window. If you want a
specific symbol to take priority over other symbols with the same name,
place its library in front of other libraries in the Libraries window. The
top-most libraries are scanned first. The library listed at the bottom is
scanned the last. Use the following procedure to reorder the libraries:

1. Select Project Libraries from the schematic File menu.

2. When the ACTIVE-CAD Libraries window appears (Figure 1-7), select
in the Project libraries list the library that you want to reorder.

3. Press the Reorder button.

4. Place the cursor at the desired location in the Project libraries list and
click the mouse button. The selected library is moved to the new loca-
tion, and thus it will have a new search priority.

View
This set of options allows you to zoom in and out, redraw, and enable
and disable viewing the display grid, the PWR pin, the pin name and the
pin number.

Window
This set of options allows you to select a window, and cascade or tile all
active windows. It is similar to the standard Window menu in other Win-
dows applications.
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Chapter 7

Library Manager

The Library Manager helps you to review, sort, print and display system
libraries. It also allows you to find synonyms, create libraries of your
own components, list projects, edit the existing IC models, create new
models from existing models, etc. As you get involved with the ACTIVE-
CAD product, you will discover that the Library Manager is the most
useful tool for housekeeping of all symbol and model libraries.

Figure 7-1. Library Manager Window.



To provide for quick access, theLibrary Manager option can be selected by
clicking on theLibrary Manager icon in the Project Manager. It can also be in-
voked by selecting theFile|Project Libraries option within the schematic or the
simulator and then clicking on the Lib Manager button in theProject Libraries
window. The mainLibrary Manager window is shown in Figure 7-1.

The Library Manager displays six menus: File, Library, Object, Project,
View and Help. Each of these menus is described in a separate section.
The main display area in Figure 7-1 is used for listing the libraries.

File Menu

The File options include:

r Print Setup - invokes the standard Windows printer setup window
r Rebuild - allows to rebuild the ACTIVE-CADlibrary catalog

Rebuild

ACTIVE-CAD displays and allows to use only these libraries which are
‘attached’ to to the program. The information about attached libraries is
stored in the binary file LIB_DIR. If this file gets corrupted or removed,
ACTIVE-CAD cannot operate normally and the Rebuild option has to be
activated to restore the LIB_DIR. file.

To rebuild ACTIVE-CADlibrary, select the drives where the libraries are
installed and click the Rebuild button. ACTIVE-CAD will automatically
attach and list all libraries installed on these drives.

Figure 7-2. Rebuild Window.
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Library Menu

The Library menu allows for operations on libraries such as copy, move,
delete, attach, detach, create new libraries, list library components, etc.

List Objects

Clicking on a library name in the Library Manager window (Figure 7-1)
and selecting the List Objects option displays the contents of the selected
library (Figure 7-3). You can also double click on the selected library in
Figure 7-3 to list its contents. You can scroll up and down the listing to
view the components.

Figure 7-3. List Objects Window.

Figure 7-4. Filter Window For Selecting Objects.
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To selectively display the library objects, click on the Filter button. The
new Filter window (Figure 7-4) allows selecting the desired model attrib-
utes. Clicking on the OK button starts the search for the objects with se-
lected attributes. For example, to list all H technology devices within the
CMOS library, enter 74*H*‘ into the Regular Expression field, click on
the Technology Selection box and enter CMOS in the field below. The as-
terisk (*) is used as a wild character.

Attach

Only the libraries attached to ACTIVE-CAD can be used in designs. If
you click on a library in the Library Manager window and select the At-
tach option, ACTIVE-CAD will display the Attach window (Figure 7-5)
which allows you to attach the desired library from the selected disk
and directory location. If you select a directory, ACTIVE-CAD displays
in the Libraries Found window all libraries that were found in that direc-
tory. The libraries that are already attached to ACTIVE-CAD will not be
displayed in the Libraries found window.

Figure 7-5. Attach Library Window.
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Create
If you want to create a new empty li-
brary, click on the Create option
and select the directory in the Cre-
ate Library window (Figure 7-6).
The new library is instantly added
to the listing of the libraries in the
main window. You can then per-
form desired operations on that li-
brary, e.g. copy some components
from other libraries, etc.

Copy

The Copy option copies the selected library to a new directory and a du-
plicate of the existing library is created in the process. This option can be
used for backup purposes or to copy the library to another computer or
diskette. The location of the library in the library listing does not change

Figure 7-7. Create Library Window.

Figure 7-6. Copy Library Window.
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and ACTIVE-CAD will continue using the library in the current location.
You need to use the Copy option if you want to give a library to some-
one else or use on another computer.

Delete
To delete a library from both the list of libraries and from a hard drive,
use the Delete option in the Library menu. Be careful when using this op-
tion because it may delete valuable information from the hard disk.

Detach
To remove a library from the ACTIVE-CAD list of libraries, without de-
leting it from a hard drive, use the Detach option. The current project li-
brary cannot be detached but libraries used by the project itself can be
detached. However, this may cause a missing library error.

Move
To copy a library to another location and remove it from the current di-
rectory, use the Move option. The library will remain on the ACTIVE-
CAD library list but will be relocated to the new directory. This option is
useful if you want to move libraries to or from the network drives or be-
tween local hard drives.

Access Mode
You can define the access mode of your libraries. The access mode de-
fines if the library can be modified. There are four access modes:

r R/W - Read and Write - this mode allow you to make any modifications
to the library. To prevent library modifications by several users, the
R/W library can be attached only by one user. Other users on the
network cannot access this library unless the current user of the library
detaches it or changes the access mode, e.g. to R/O.

r R/O - Read Only - this mode allows the library access but prevents you
from any modifications. R/O libraries can be shared by multiple users
on the network.

r R/A - Read and Append - this mode allows adding new parts to the
library, but you cannot modify the existing ones. This type of library
can be shared on a network by multiple users.

r R/S - Read System - The ACTIVE-CAD system libraries are pro-
tected by keylock and they cannot be modified by the user. These li-
braries can be shared by multiple users on the network. You can
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copy objects from the system libraries to R/W libraries to make the
desired modifications of the library components or objects.

To change the access mode of a selected library, select the Access mode
option in the Library menu and select the new mode in the Access mode
window of Figure 7-8.

NOTE: You cannot set or change the R/S library access mode. All
ACTIVE-CAD libraries come factory set to the R/S mode.

Comment

This option is active only with the user libraries. It is inactive for system
libraries that come with ACTIVE-CAD. You can enter a library descrip-
tion, so that other users on the network can see what this library con-
tains. This option is active only with the user libraries and is inactive for
ACTIVE-CAD system libraries. To enter a comment, select the Comment
option within the Library menu and enter the comment text in the Li-
brary Comment window (Figure 7-9).

Figure 7-9. Setting Library Access Mode.

Figure 7-8. Setting library description.
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Optimize

After performing several operations on user library objects, the user li-
brary can become fragmented, which increases its size and access time.
To compact the library and optimize it for the best performance, select
the desired library and use the Optimize option in the Library menu.
Note that this operation can take several minutes if the library contains
large number of objects. The system libraries cannot be subject of any
modifications, editing, etc., and thus do not require optimization.

Rename

To change the name of a library, select it in the main window and select
the Rename option in the Library menu. In the Rename window enter
the new name and press the Rename button. Only the user libraries can
be renamed. The system libraries can never be renamed.

Print

To print the list of all or selected libraries used in the system (currently at-
tached), use the Print option in the Library menu. This option prints li-
brary names, comments, locations and access modes. It does not print the
contents of the libraries. To set up the printer, use the Printer Setup op-
tion in the File menu.

Report

The Report option in the Library menu allows you to create a listing of
the objects (IC models) within selected libraries. You can choose to in-
clude Chip comments, Attributes, Manufacturers and Technology (Fig-
ure 7-10). When you click on the Create button, ACTIVE-CAD opens the
Library Report window, which allows you to select the drive (Drives
field), directory (Folders field) and the name under which the file should
be stored (File Name field). Clicking on the OK button generates a report
which can be read by any text editor such as Notes. The report file can
then be used by other programs to create custom reports, listings, etc.
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Project Menu

To view all objects residing in project libraries, select the List All Objects
option within the Project menu which opens the List All Project Objects
window. This window allows you to review the list of ICs that are used
for the current project, and shows a similar information to the SC Sym-
bols toolbox in the Schematic Editor.

The List All Project Objects window in Figure 7-11 allows you to review
the Description, Type, Physical Name and Library of each object in the
project libraries. The Physical Name is used to store the custom part
name, the Type specifies if the object is a netlist, chip (simulation model),
or just a graphical symbol. This option can also be useful to detect which

Figure 7-10. The Report Window.

Figure 7-11. List All Project Objects Window.
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library has been used for a selected object, if there are several compo-
nents with the same part name.

View Menu
This menu has four options for selective display of libraries information:

r Status Bar shows advisory notes at the bottom of the window.
r Show Project Libraries-lists all libraries used by the current project.
r Show Comment lists comments assigned to libraries.
r Show Path displays the library path.

To add or remove libraries from the current project, use the Add and Re-
move buttons in the Project Libraries option that is available in the simu-
lator and schematic File menus. To show all project libraries again,
toggle the Show Project Libraries option.

Object Menu

General
Before you begin any operations on library objects, you need to select
one or more components in the List Objects window (Figure 7-3). The
Object menu is inactive until you select at least one object in this win-
dow. Only then you can select options from the Object menu.

Each library object may contain the following information:

r Logical Name
r I/O Pin names
r I/O Pin Numbers
r I/O Pin Loading (number of loads for CMOS parts)
r Description (comment about the component)
r Timing specification (Generics)
r Contents (default file e.g. JEDEC, hex)
r Technical Info (Manufacturer, Technology)
r Attributes (e.g. gate, PLD, memory)
r Graphical Symbol
r Simulation Model
r Netlist in the .ALB file format (hierarchy macro)
r Schematic for hierarchy macro
r Footprint for PCB layout
r Part Number (user defined part name)
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r Spice Model for analog simulation
r ISE window for editing internal registers in the simulator
r Model Source code for VHDL and MBC debugger

NOTE: Do not close the List Objects window with selected objects until
you perform the desired operations from the Object menu.

Not all of these parameters have to be defined for each part. Library
Manager allows you to modify these parameters with the exception of:

a. VDS (VHDL Development System) exclusively manages simulation
models, ISE windows and model source code.

b. The Symbol Editor exclusively controls graphical symbols.

c. The Schematic Editor controls schematics for hierarchy macros.

d. Only the Footprint and Part number can be edited in both the symbol
editor and the schematic editor

NOTE: You can change Footprint and Part number of the system li-
brary objects and make them available to all network users. To change
any other parameters you need to copy the selected objects to user li-
brary first and then perform the desired changes.

Copying Library Object

The Copy option within the Object menu allows you to copy selected ob-
jects to another library. It copies all information about the component, in-
cluding simulation model, netlist, etc. You can copy objects from the
system libraries to customize the standard components to your require-
ments. You can copy objects only to the libraries that have R/W and R/A
access mode. To simplify the library search, Library Manager will auto-
matically list all libraries that have these access codes.

Select in the Copy Object window (Figure 7-12) the object to be copied
and the destination library where the component should be copied, and
click on the Copy button.
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Deleting Library Objects
To delete an object from a library with the R/W access, use the Delete op-
tion within the Object menu. First, select in Figure 7-3 the object to be de-
leted. Next, select the Delete option from the Object menu, and when
the Delete Library window appears, click on the Delete button.

NOTE: The deleted objects are permanently deleted from the library and
cannot be recovered.

Renaming Library Objects
To change the name of a library object use the Rename option within the
Object menu. Only the objects in the R/W user libraries can be changed.
Other types of libraries do not allow for object name changes.

To change an object name, select in Figure 7-3 the object to be renamed.
Next, select the Rename option from the Object menu, and when the Re-
name Object window appears (Figure 7-13), enter the new object’s name
and click on the Rename button.

Figure 7-12. Copying Object to another library.
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NOTE: This option must be used very carefully because the original ob-
jects will disappear from the library and will not be found under their old
names when you load some old designs again.

Copying Functional Equivalents

To copy a group of functional equivalents to another library, select any
one of its members and click on the Copy Func. Equivalents option (Ob-
ject menu). When the Copy Functional Equivalents window(Figure 7-
14) appears, select the destination library and click on the Copy button.

Figure 7-14. Renaming Object.

Figure 7-13. Copy Functional Equivalents Window.
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Cloning New Timing Models
The ACTIVE-CAD allows loading different timing versions of the func-
tionally equivalent devices without any compilations. A functional
equivalent is a device which has the same logical function (simulation
model) but has a different timing specification.

ACTIVE-CAD allows you to create a copy of an existing functional
model, change its name and timing parameters and add to the library as
a new timing model. This process of creating new timing models from ex-
isting functional equivalents is called “cloning.”

NOTE: Only R/W library objects can be cloned into new timing models.

To create a new timing model by cloning, select a part in Figure 7-3.
Next, select the Create Functional Equivalent option from the Object
menu. When the window in Figure 7-15 appears, enter the new part
name in the New Name For Equivalent field, and click the Create button.

After creating a new component, you can use the Object/Generics menu
to define new timing parameters for the new component. For example,
the 22V10-15 PLD model can be instantly cloned into 22V10-5, which has
5 nanoseconds propagation delay between the clock inputs and the de-
vice outputs. The new part name (22V10-5) is created in the window in
Figure 7-15, and the timing parameters are edited in the Change Propa-
gation Times window (Figure 7-18), described in the Generics section.

Later on, whenever you use this part in your design you will be able to
quickly switch between different versions of the component using the
Change Technology option in the Simulator and Schematic Editor.

Note : The simulation model is not duplicated and is the same for all func-
tional equivalents.

Figure 7-15. Create Functional Equivalents Window.
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The new part will be added to the R/W library in which it was created.
You can copy this part to any user library and put it on the network for
corporate-wide use.

Attributes

Attributes allow for faster search and filtering of the library components.

To assign object attributes, select the
Attribute option within the Object
menu. In the Change Attribute win-
dow (Figure 7-16), click on the se-
lected attributes and then on the
Change button to save the setting.

Each object has a set of attributes which describe its type. Attributes are
used by the schematic editor to filter the symbols and by the simulator to
determine which objects can have a JEDEC or hex file loaded. It is impor-
tant that you always assign correct attributes to all components so that
ACTIVE-CAD can correctly identify them in different filtering options.

Comment

Each user defined object can be assigned a description. This text is dis-
played when selecting an object in the schematic and in other ACTIVE-
CAD programs. All ACTIVE-CAD library objects have factory provided
description of their logic functions. However, if you want to add a com-
ment to your custom objects, use the Comment option within the Object
menu. Enter the comment in the Chip Comment line in Figure 7-17 and
press the Modify button.

Figure 7-16. Editing Object
Attributes.
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Generics
Simulation models created with the VHDL compiler can have timing pa-
rameters assigned to the model. These parameters are usually specified
by the manufacturer of the device in the databook. ACTIVE-CAD librar-
ies keep three values for each timing parameter (Minimum, Average and
Maximum). The simulator by default takes the average timing parame-
ters of objects. However, using simulator options you can set these pa-
rameters to either the Min or Max values.

To change timing parameters of a library object, select the part in Figure
7-3 and click on the Generics option in the Object menu. When the
Change Propagation Times window appears, select the desired parame-
ter from the Propagation Times field (Figure 7-18) and then edit its val-
ues in the Propagation Time Values field. The new values are
permanently assigned to the object when you click on the Modify button.

Figure 7-17. Setting Object Description.

Figure 7-18. Editing timing parameters.
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The simulator also allows you to directly edit any parameter value, but
these changes are done locally in the simulator design tables. If you want
to permanently change timing parameters of the library objects, you
should use the Generics option within the Object menu.

NOTE: To protect the integrity of the ACTIVE-CAD system library ob-
jects, you can view their timing parameters but you cannot modify them.
To modify their timing parameters, copy them first into your own (user) li-
brary and then change their timing values.

Pin Loading
Some of the IC components change their timing specification depending
upon the loading or the number of input pins connected to their output
pins. Output pin loading specifies how many input pins can be con-
nected to the selected output. Most of the manufacturers define the maxi-
mum number of loads that can be connected to a single output pin. A
load is usually the same as a single pin. However, some input pins take
more current and are equivalent to more than one load. Also, some out-
put pins have higher driving capability than normal. Library Manager al-
lows you to modify the loading factor of such pins to account for the
extra loading capacity. .

The pin loading is used in ACTIVE-CAD to detect any errors in the de-
sign caused by connecting too many input pins to a single output. Some
models are also able to change their timing parameters according to the
manufacturers loading table.

To edit pin loading parameters, use
the Pin Loading option within the
Object menu. In the Pin Loading
window (Figure 7-19), select the de-
sired pin and change its loading
value in the Loading Value field. To
save the new loading parameters,
click on the Save Loading button.

NOTE: You can only save the loading values for the user libraries. To
protect the system libraries, the Save Loading button is automatically
disabled when a system library object is loaded into Figure 7-19.

Figure 7-19. Editing Pin Loadings.
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Pin Numbering
Each component can have numbers assigned to its pins. Pin numbers can
be assigned to any type of objects (simulation model, netlist, graphical
symbol). Each object that has pins must also have pin names. Most of the
objects that represent physical components have both pin names and pin
numbers. Pin numbers are required for all designs that are exported to a
PCB layout program. Some of the objects have only pin names (e.g.
FPGA libraries). To change pin numbers, select an object in Figure 7-3
and activate the Pin Numbering option in the Object menu.

In the Pin Numbering window (Figure 7-20), select a pin from the Pin
Name list and change its number in the Pin Number window. When all
pin numbers have been changed, click on the Save Changes button to
save the new pin numbers.

NOTE: You cannot change pin numbers for the object from system librar-
ies. In such case, the Save Changes button is not displayed.

NOTE: You cannot change the pin names in Library Manager. The pin
names can only be changed in the symbol editor and only if the objects
do not have any simulation model or netlist assigned to it.

Synonyms
In order to minimize the number of different IC names in the library,
ACTIVE-CAD uses a mechanism called synonyms. A synonym is an ex-
act equivalent of an object that already exists in the library. For example,

Figure 7-20. Editing Pin Numbers.
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the 7400 gate has several synonyms: SN7400, SN7400N, 00, etc. All of
these parts have the same pin numbers, timing parameters, loading, etc.
The synonyms are used for importing netlists from external schematic
editors because they allow ACTIVE-CAD to recognize parts that have dif-
ferent names but have their equivalents in the ACTIVE-CAD library.

Adding Synonym Parts

To add a synonym to the library, select a specific object from Figure 7-3.
Without closing that window, select the Synonym option from the Ob-
ject menu. In response, the List Object Synonyms window is displayed,
listing all synonyms of the selected object (Figure 7-21).

To add a new synonym, click on the Add button in the List Object Syno-
nyms window. The Add Synonym window will appear and will prompt
you to enter the new synonym name. Click on the Add button to add it
to the synonym list.

To delete a synonym, highlight it in the List Object Synonyms window
and then click on the Delete button.

Technical Info

Each object can have assigned the Manufacturer and Technology pa-
rameters. These parameters can be useful for searching and filtering com-
ponents in the library as well as for reports and Bill of Material options
in the Schematic Editor. To edit these parameters, use the Tech Info op-
tion within the Object menu.

Figure 7-21. Synonyms Window.
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Select the desired parameters from the Manufacturer, Technology and
Package fields in the Technical Info window (Figure 7-22), and click on
the Modify button. You can only use one entry from each list.

You cannot enter your own text into the Manufacturer , Technology , or
Package fields. You can only make a selection from the predefined lists.

Attach Netlist
The library objects can have assigned either IC models or netlists. The
netlists are used as simulation macros that use lower level components.
You can attach a netlist to the selected object. This netlist will be used by
the simulator as a model. The netlist has to be in the .ALB binary format
and can be assigned to any object that has no simulation model. The
netlist is stored with its object in the library, and if it ever changes, you
must assign the new netlist to the object again.

All netlists created by ACTIVE-CAD schematic editor are in the .ALB for-
mat. If you want to assign a netlist imported in another format, it has to
be converted first.

For example, loading a netlist to the simulator results in an automatic
conversion to the .ALB format. The converted netlist is stored by
ACTIVE-CAD in the current Project directory and can be downloaded
directly into an object.

To assign a netlist to the selected library object, use the Attach Netlist op-
tion within the Object menu and select the desired .ALB file.

Figure 7-22. Editing Technical Information.
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You can also create a netlist-based object directly in the schematic editor.
When you use the Import Netlist option in the schematic Options menu,
it converts the imported netlist to the .ALB format, creates a new object
in the library and assigns to it the converted netlist. The new object will
be listed in the SC Symbols window in Schematic Editor, can be placed
on schematic and edited in Library Manager.

Placing an FPGA symbol on the schematic sheet and invoking the As-
sign Netlist option in the Hierarchy menu (Schematic Editor), will as-
sign the selected netlist to the symbol. The selected netlist can be in any
any format .

To assign a netlist to the selected library object in the Library Manager,
use the Attach Netlist option within the Object menu and select the de-
sired .ALB file.

You can attach netlist only to empty symbols. Library Manager does not
allow you to attach a netlist to the system library symbols.

Create with Contents

One of the ways to create custom parts for simulation is by downloading
a JEDEC or Memory file into an empty object.. For example, loading a
JEDEC file for a 4- bit Johnson counter into the 22V10 object, will create a
custom model of that Johnson counter. Any time you load that 22V10-
based object to the screen, it will simulate the Johnson counter.

The best way to create such models is by copying system library parts
into user libraries and then assigning to them concrete JEDEC or hex
files. You should rename such parts with the Rename option in the Ob-
ject menu. This will allow you to clearly differentiate the new parts from
the standard 22V10 devices.

To assign a contents to the selected object, use the Create with Contents
option within the Object menu, and then select the desired file from any
disk directory.

NOTE: The Create with Contents option can be used only if the se-
lected object is either a PLD or a Memory device. JEDEC and memory
HEX files are saved in the library.
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Change Contents
If the JEDEC or hex files that have been used to create custom simulation
models ever change, you have to update the models by using the
Change Contents option.

NOTE: The Change Contents option allows overriding the existing
JEDEC and hex files with new ones and creating new simulation models.

Figure 7-23. Create PLD with Contents window.
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Chapter 8

Interface to the Intusoft SPICE Simulator

Introduction
The ACTIVE-CAD SPICE option includes full support for creating ana-
log SPICE designs and simulating them in the Intusoft IsSPICE 4 analog
simulator. The ACTIVE-CAD SPICE option includes schematic libraries
with analog symbols, a direct interface to the IsSPICE database for li-
brary model selection, and a SPICE netlist generation capability with
SPICE simulation commands.

Installation
ACTIVE-CAD and IsSPICE programs both need to be installed on the
same computer for the interface to operate properly. You can install
these two programs according to the installation instructions for each
product. The order in which you install the products is unimportant.

The interface to IsSPICE utilizes a direct access to the Intusoft library da-
tabase. This database is located in the following files:

C:\SPICE4\ICAPS.EXE

C:\SPICE4\SN\DBASE.@@@

C:\SPICE4\SN\INDEX.@@@

You need to set the PATH in your AUTOEXEC.BAT file to include the
C:\SPICE4 directory. If you installed IsSPICE in a different directory,
please verify that your AUTOEXEC.BAT file shows the correct PATH set-
ting.



If the IsSPICE database files cannot be found, you will receive an error
message when you try to create a SPICE design.

Creating a SPICE project
Schematics created for analog SPICE simulation have to be entered in a
SPICE project. To create a SPICE project you need to open the Project
Manager window and select SPICE from the Type selection list (Figure 8-
1).

After creating a SPICE design the Design Manager window shows a
SPICE flow with the SPICE icon (Figure 8-2).

Figure 8-1. Creating a new SPICE project

Figure 8-2. SPICE Design Flow
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NOTE: You cannot use other project types to interface to IsSPICE simu-
lator. Only SPICE projects are set up to generate a correct SPICE netlist
for simulation.

Libraries
When you create a SPICE project, the SPICE library is automatically as-
signed for this project. In the Project Libraries list, you should see the
two project libraries: SPICE and a working library with the same name as
the project itself (Figure 8-3). If the library is not installed you will see an
error message.

NOTE: Do not select any additional libraries for the SPICE project. Only
the symbols from the SPICE library can be accepted for simulation in the
IsSPICE simulator.

Creating an analog schematic
Because of certain features unique to SPICE, placing symbols in SPICE
projects is different from placing symbols in other projects. The symbol
toolbox contains a hierarchical database of over 5,000 symbols grouped
in several categories.

Figure 8-3. ACTIVE-CAD library window
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The SC Symbols toolbox has two SPICE buttons that allow you to
browse through the IsSPICE symbol database and select the desired sym-
bols or simulation objects (Figure 8-4).

The first SPICE button displays SPICE symbols grouped into Type, Sub-
types and Parts (Figure 8-4). The second SPICE button displays simula-
tion probes and voltage/current sources. (Figure 8-5).

Figure 8-4. SC Symbols toolbox
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Please refer to the IsSPICE manuals for a complete library guide and a de-
scription of library types.

NOTE: When you click on the DIGITAL button, the symbols list shows
the generic symbols. These symbols do not have any SPICE properties
assigned and will not load to the SPICE simulator. The properties for
these symbols are assigned when you select them from the
Type/Sybtype/Group selection.

Editing SPICE parameters
Most SPICE symbols contain specific attributes and parameters that you
can assign for simulation. To edit symbol-specific parameters, you need
to switch to the Changes mode and double-click on the desired symbol.
Then from the Edit Symbol window, click on the Spice button to display
symbol SPICE parameters.

Selecting a SPICE analysis
Before you can simulate the design, you need to select the type of SPICE
analysis you want to perform. To do so use the Spice Analysis option in

Figure 8-5. Simulation probes and voltage sources
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the schematic Options menu. This information will be included in the
generated SPICE netlist.

To simulate the SPICE design click on the SIM button in the schematic
toolbar. The ICAPS program is then started instead of the regular logic
simulator.

You can also start the SPICE simulation from the Design Manager Flow
window by pressing the SPICE button.

Running a SPICE simulation
For instructions on running the SPICE simulation, please refer to the Is-
SPICE4 User Guide.

Figure 8-6. The SPICE analysis window
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Appendix A

Library Listing

The following is an abbreviated list of SUSIE libraries. The parts can be
available in all technologies, packaging and from all manufacturers.

TTL
00
01
02
03
04
05
06
07
08
09
10
11
12
14
15
20
21
22
25
26
27
30
31
32
33
34
36
37
42
45
46
48
49
50
51
53
54
55
56
57
64
65
68
69
70
72
73
74
75
76

77
78
83
85
86
89
90
91
92
93
94
95
96
97
107
109
111
113
116
120
121
122
123
125
126
128
131
132
133
134
135
136
137
138
139
140
143
147
148
150
151
153
154
155
156
157
158
159
160
161
162
163

164
165
166
167
168
169
173
174
175
178
180
181
182
183
190
191
192
193
194
195
196
197
198
199
221
229A
225
230
231
232A
233A
234
235
236
240
241
242
243
244
245
246
248
250
251
253
256
257
258
259
260
264
265

266
269
273
276
279
280
282
283
286
292
294
295
297
298
299
348
350
352
353
354
355
356
365
366
367
368
373
374
376
377
378
379
381
382
385
386
390
393
396
398
399
410
412
422
423
432
436
440
441
442
444
455

456
465
466
467
468
490
518
519
520
521
522
526
527
528
533
534
537
538
539
540
541
543
545
547
548
56o
561
563
568
569
574
575
577
579
583
588
590
591
592
593
594
595
596
597
598
604
605
606
607
614
615
620

621
622
623
638
639
640
641
642
643
644
645
646
647
648
649
651
652
653
654
655
656
657
673
674
676
677
678
679
680
682
685
686
687
688
689
711
712
723
725
732
733
746
747
755
756
757
758
759
760
762
763
776

777
779
786
804
805
808
810
811
821
822
823
824
825
826
827
828
832
841
842
843
844
845
846
850
851
861
862
863
864
866
867
869
870
873
874
876
878
879
881
882
899
990
991
996
1000
1004
1032
1241
1242
1243
1244
1245

1604
1645
1760
1760A
1762
1779
1894
1895
1896
1897
2232
2233
3037
3038
3040
3893
5074
8003
8960
8961
30240
30244
30245
30640
50109
50728
50729

Passive
DIP314A
DIP314B
DIP316A
DIP316B
RES
RPAK10
RPAK14
RPAK16
RPAK8
SIP106A
SIP106B
SIP108A
SIP108B
SIP110A
SIP110B



List of available libraries:
r 8051(Intel 8051, 8052, 8031, 8032)
r ACTEL1, ACTEL2, ACTEL3 (Actel FPGA macro library)
r ATMEL (Atmel EPLDs)
r ALTERA (Altera MAX & FLEX)
r CMOS (TTL-CMOS & CD4000)
r ECL (10K, 100K, 10H, 10E)
r EPLD (Altera & Intel EPLD, e.g. EP300, EP1800)
r ISA (Intel ISA Simulation library)
r LATTICE (Lattice pLSI macro library)
r M6809 (Motorola MPU)
r MACH (AMD CPLD, MACH1, 2, 3 & 4)
r MEMORY (RAM, ROM, SRAM, DRAM, FIFO, Dual Port, etc.)
r PASSIVE (Resistors, Capacitors, Inductors, Switches)
r PERIPHE (Intel and Motporola Peripheral Devices)
r PLD (Classical PLD and PAL devices e.g. 10H8, 22V10)
r QUICKLOG (Quicklogic PASIC Macro library)
r TTL (LS, S, F, ALS, etc.)
r XILINX2, XILINX3, XILINX4 (Xilinx FPGA macro library)
r X2000U, X3000U, X4000U, X7000U, XBLOXU (Xilinx Unified Libraries)
r Z80 (Zilog Z80 MPU)
r AMD (symbols only, AMD devices)
r ANALOG1 (symbols only, Analog devices, amplifiers)
r DEVICE1 (symbols only, discrete components, transistors, diodes)
r DIP (symbols only, footprint symbols)
r MEM (symbols only, Additional memory devices)
r MICRO (symbols only, Microprocessors)
r PAL (symbols only, additional PAL & PLD symbols)
r SEMI (symbols only, CD4XXX symbols)

NOTE: Libraries marked as “symbols only” do not contain simulation
models.
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INDEX

A
ACTIVE-CAD

New project 1-5
Annotation 2-22 - 2-23, 4-19, 5-16
Arc 2-33, 6-8
Arrange menu 5-32 - 5-33

Center 5-32
Full page5-32
Previous zoom 5-32
Redraw 5-33
Zoom in 5-32
Zoom out 5-32
Zoom select 5-32

ASCII 1-26 - 1-27, 5-4 - 5-7, 5-14 - 5-15,
5-19
Assign Netlist 5-16
Audit file 5-27
Automatic Connections 2-30 - 2-32, 2-34
Autorouting 5-26

B
Back Annotation 2-42, 5-16
Backup, schematic 5-27
Bill of Material 5-17 - 5-18
Bus taps

Adding names 3-10
Automatic 3-9
Dragging2-37
Drawing 2-30
Manual 3-9
Names 3-10
Type 5-26
Type, changing 3-10

Buses 2-29, 3-1 - 3-3, 3-5 - 3-15, 3-17, 3-19
Complex3-4, 3-6, 3-15 - 3-20
Connection rules 3-5 - 3-6
Deleting 3-12
Dragging2-37, 3-11 - 3-12
Drawing 3-6 - 3-7, 5-25 - 5-26
Editing 3-11 - 3-13, 3-15 - 3-16, 3-18, 3-20
Generic 3-4
Label 2-25, 3-1 - 3-4, 3-7, 3-12
Name 3-1 - 3-4, 3-7, 3-12
Netlist 3-14
Pin order3-2
Pins in macro symbol 4-15

Probes 3-13
Querying3-12, 3-14
Renaming 3-12
Signal order 3-2
Simulator 3-14
Stretching 3-11
Taps, adding names 3-10
Taps, automatic 3-9
Taps, hanging type 3-10
Taps, manual 3-9
Terminals 3-3, 3-8
Unnamed 3-3

C
Capacitors 2-21
Centering

Displayed circuits 5-32
Check design integrity 5-14
Check electrical rules 2-3, 2-16
Check for duplicate references 2-23
Check symbol integrity 6-10
Circle 2-33, 6-7
Circuit

Definition 2-1
Symbols 2-2

Colors, screen 2-28, 2-46, 2-48
Comments 4-12, 4-14, 5-21, 7-7
Compile schematic 1-4
Component

attributes2-24, 2-26
Libraries 2-49
placing 2-18 - 2-21, 2-23 - 2-24, 2-26
rotation 2-24
selecting 2-18

Connection
auto 2-31 - 2-32
Drawing 2-25, 2-27 - 2-29, 2-31
Logical 2-2
manual 2-32
ortho 2-32
Physical 2-2

Connectors 2-22
Create hierarchical netlist 5-14
Cursor Coordinates 2-13
Custom libraries1-9

D
Delete

Graphics items 6-8
Objects 2-38, 5-11 - 5-12



Pins 6-6
Project 1-12
Project resources 1-25
Resources 1-28
Sheet 5-3
Symbols 2-19
Undo 2-20, 5-11 - 5-12

Design Manager
Starting 1-6

Design structure
flat 4-2, 4-4, 4-19, 5-15
Hierarchical 4-1 - 4-5, 4-10 - 4-19, 4-21,

4-24 - 4-25, 4-27, 5-15
Design Table 5-10, 5-29
Designs

Checking duplicate references 2-23
Checking electrical rules 2-3, 2-16
Hierarchical 2-23
Large 2-2
Management 4-5 - 4-11, 4-13, 4-15 - 4-21,

4-23
Reference numbers 2-19
Structure4-1, 4-3
Top-down 4-21 - 4-22
Verification 1-29, 2-3

Double-click, defined 1-4

E
EDIF

Import 5-5, 5-7
Edit

Attributes 2-24, 2-26
Labels 2-23, 6-4
Names 2-23, 6-4
Objects 2-35 - 2-41
Part orientation 2-24, 2-37
Part reference designators 2-23, 6-4
part values 6-9
Schematic 2-35, 2-37, 2-39, 5-11 - 5-13
Symbol 2-40, 6-1, 6-3 - 6-4, 6-6 - 6-10
Title block 5-10

Edit Library 5-21
Edit menu 5-11 - 5-13

Copy 5-12
Cut 5-11
Delete 5-12
Deselect all 5-12
Export clipboard 5-13
Import to clipboard 5-13

Paste 5-12
Redo 5-11
Show clipboard 5-12
Undo 5-11

Event 2-46
tracking 2-47

Export
Clipboard 5-13
Netlist 4-19, 5-15
Parts and Nets 5-16

Export Schematic
to DXF 5-7
to EDIF 5-7

F
File menu 5-1 - 5-7, 5-9, 5-11

Exit 5-11
Export 5-7
Go to simulator 5-4
Import 5-4 - 5-6
New sheet 5-1
Open sheet 5-2
Page setup 5-9
Print 5-8
Printer setup 5-9
Project libraries 5-3
Project manager 5-3
Save 5-3
Save all 5-3
Save as 5-3
Table setup 5-10
Update libraries 5-4

Flat netlists
Creating from hierarchical designs 4-4,

4-19
Creating from hierarchical designs 5-15

Formats
.ALB 7-20
ASCII 5-4, 5-14, 5-19
DXF 5-7 - 5-8
ECO 5-27
EDIF 5-7
FutureNet 5-14
OrCAD 5-4, 5-6 - 5-7
PADS 5-14
Schema 5-14
Windows Metafile 5-11

FutureNet netlist format 5-15
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G
Graphics

Deleting 6-8
Draw 2-33, 6-7
editing 6-6, 6-8
Enable/Disable 5-29

Grid
Configuration 5-24
Displaying 5-21, 5-24 - 5-25
Resolution 5-25

H
Hierarchical netlist formats 4-11 - 4-13,
5-15
Hierarchical schematic 2-1 - 2-2, 4-1 - 4-7,
4-9 - 4-14, 4-16 - 4-20, 4-23 - 4-27

Annotation 4-19
Buses, connecting3-6
Converting to flat 4-4, 4-19, 5-15
Creating 4-14
Errors 4-23
Example 4-24 - 4-27
Inter-sheet connections 2-3, 4-3, 4-14
Management 4-10 - 4-13, 4-15 - 4-21, 4-23

- 4-24
Navigating 4-16
Numbering reference designators 2-23, 4-2,

4-6, 4-8, 4-19
Push/Pop5-16
SEE ALSO Schematic

Hierarchy
Menu 4-24 - 4-26, 5-20

I
I/O Terminal 2-26
Import

Back Annotation 5-16
Clipboard 5-13
EDIF Schematic 5-7
EDIF Symbols 5-5
from Audit File 5-17
Hierarchical netlist 4-12
Netlist 5-15
OrCAD schematic 5-5 - 5-6
OrCAD symbols 5-4
Viewlogic schematic 5-7

Incremental design 2-16
Inductors 2-21
Interfaces 2-4

J
Junctions 5-25

L
Library

Access mode 7-6
Attach 1-8, 7-4
Browsing through parts 2-18, 2-20, 7-3
Changing order 6-11
Comment 7-7
Contents 7-3
Copy 7-5
Create 7-1, 7-3, 7-5
Delete 7-6
Deleting parts 7-12
Detach 7-6
Edit 5-21
Editing 5-4
Import EDIF 5-5
Import OrCad 5-4
Import PADS5-5
Interfaces, and 2-4
Macros 4-19
Move 7-6
Objects 2-2, 7-10
Optimize7-8
Print 7-8
Rename 7-8
Report 7-8
Search Order 6-11
Symbols 2-49
System-level P-xii

Library Filter 2-20
Library Manager 7-1, 7-3 - 7-7, 7-10, 7-12,
7-15, 7-17 - 7-19, 7-21 - 7-22

Access mode 7-6
Attach 7-4
Comment 7-7
Copy 7-5
Create 7-5
Delete 7-6
Detach 7-6
Library menu7-3
Library objects operations 7-10, 7-12, 7-15,

7-17 - 7-19, 7-21
List objects 7-3
Move 7-6
Optimize7-8
Print 7-8
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Rebuild 7-2
Report 7-8
System options 7-2

Library objects
Attributes 7-15
Comment 7-15
Copy 7-11
Copy functional equivalents 7-13
Create functional equivalents 7-14
Create with contents 7-21
Custom 1-9
Delete 7-12
Generics 7-16
Netlists 7-20
Pin loading 7-17
Pin numbering 7-18
Rename 7-12
Synonyms 7-18 - 7-19
Technical information 7-19

Line 2-33, 6-7 - 6-8
Line Set 2-34
List Connectors 5-19 - 5-20

M
Macros

Creating 4-13
Deleting 4-20
Hierarchical 4-10
Library 4-19
Modifying existing 4-17
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